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1 Data Analysis and Processing

Model Requirements for Importing Data
Before you can analyze and preprocess the estimation data, you must assign
the data to the model’s channels. In order to assign the data, the Simulink®

model must contains one of the following elements:

• Top-level Inport block

Note You do not need an Inport block if your model already contains a
fixed input block, such as a Step block.

• Top-level Outport block

• Logged signal. The logged signal can be a top-level signal in the model
or a signal in the model subsystem.

To enable signal logging, right-click the signal and select Signal
Properties. In the Signal Properties dialog box, select the Log signal
data check box. For more information, see “Exporting Signal Data Using
Signal Logging” in the Simulink documentation.

In the Control and Estimation Tools Manager GUI, the rows in the Input
Data tab correspond to the model’s top-level Inport blocks.

Similarly, the rows in the Output Data tab correspond to either the top-level
Outport blocks or logged signals in the model.

Adding an Inport or Outport block or marking a signal for logging creates a
new row in the corresponding Input Data or Output Data tab. You can use
the new row to import estimation data for the corresponding signal. To view
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the new row, click Update Task in the Estimation Task node of the Control
and Estimation Tools Manager GUI.

More About

“Supported Data”
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Import Data (GUI)

In this section...

“Creating an Estimation Project” on page 1-4

“Importing Time-Domain Data into the GUI” on page 1-6

“Importing Time-Series Data into the GUI” on page 1-11

“Importing Complex Data into the GUI” on page 1-11

Creating an Estimation Project
Before you begin data import, you must create and set up an estimation
project by configuring the appropriate parameters, solvers, and cost functions.
Simulink Design Optimization™ software provides a Graphical User Interface
(GUI) that makes setting up the estimation project quick and easy.

To create an estimation project:

1 Open the nonlinear idle speed model of an automotive engine by typing :

engine_idle_speed

at the MATLAB® prompt.

The model appears as shown next.
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The model contains the Inport block BPAV and Outport block Engine Speed
for importing input and output data, respectively. To learn more, see
“Model Requirements for Importing Data” on page 1-2.

2 Open the Control and Estimation Tools Manager GUI by selecting Tools
> Parameter Estimation in the Simulink model window.

1-5



1 Data Analysis and Processing

Control and Estimation Tools Manager GUI

The project tree displays the project name Project - engine_idle_speed.
Estimation tasks are organized inside the Estimation Task node.

Note The Simulink model must remain open to perform parameter
estimation tasks.

Importing Time-Domain Data into the GUI
After you create an estimation project, as described in “Creating an
Estimation Project” on page 1-4, you can import the estimation data into the
GUI. To learn more about the types of data for parameter estimation, see
“Supported Data” in the Simulink Design Optimization Getting Started Guide.

To import transient (measured) data for your dynamic system:
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1 In the Control and Estimation Tools Manager, select Transient Data
under the Estimation Task node of the Workspace tree.

2 Right-click Transient Data and select New to create a New Data node.
Alternatively, you can use the New button to create this node.

3 Select the New Data node under the Transient Data node.

The Control and Estimation Tools Manager GUI now resembles the next
figure.
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Import Data into the Control and Estimation Tools Manager

The table rows in the Input Data tab corresponds to the Inport block BPAV
in the engine_idle_speed model. Similarly, the rows in the Output Data
tab corresponds to the Outport block Engine Speed.

Note The Simulink model must contain an Inport or Outport block or
logged signals to enable importing data. For more information, see “Model
Requirements for Importing Data” on page 1-2.

The idle-speed model of an automotive engine contains the measured data
stored in the iodata array. The array contains two columns: the first for
input data, and the second for output data. You must import both the input
and the output data, as described in the following sections:

• “Importing Input Data and Time Vector” on page 1-9
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• “Importing Output Data and Time Vector” on page 1-10

Importing Input Data and Time Vector
To import the input data for the port BPAV:

1 In the New Data node, click the Input Data tab.

2 Right-click the Data cell and select Import to open the Data Import dialog
box. Alternatively, you can use the Import button to open this dialog box.

3 In the Data Import dialog box, select iodata from the list of variables.
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4 Enter 1 in the Assign the following columns to selected channel(s)
field, and then click Import.

5 In the Input Data tab, select the Time/Ts cell.

6 Select time in the Data Import dialog box.

7 Click Import to import the time vector for the input data.

8 Click Close to close the Data Import dialog box.

Importing Output Data and Time Vector
To import the output data for the port Engine Speed:

1 In the New Data node, select the Output Data tab.

2 Right-click the Data cell and select Import to open the Data Import dialog
box.

3 In the Data Import dialog box, select iodata from the list of variables.

4 Enter 2 in the Assign the following columns to selected channel(s)
field to use the second column of iodata, and then click Import.

5 In the Output Data tab, select the Time/Ts cell.
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6 Select time in the Data Import dialog box.

7 Click Import to import the time vector for the output data.

8 Click Close to close the Data Import dialog box.

Importing Time-Series Data into the GUI
Time-series data is stored in time-series objects. For more information, see
“Time Series Objects” in the MATLAB documentation.

When you import time-series data for parameter estimation, specify the data
and time vector as t.data and t.time in the Data and Time/Ts columns of the
New Data node, respectively. For more information on how to import data
into the GUI, see “Importing Time-Domain Data into the GUI” on page 1-6.

Importing Complex Data into the GUI
Complex-valued data is data whose value is a complex number. For example,
a signal with the value 1+2j is complex. You can use complex data to estimate
parameters of electrical systems, such as the magnitude and phase.

Note You must sample the real and imaginary parts of the data as a function
of the same time vector.

To use complex data for parameter estimation:

1 Split the data into two data sets that contain the real and imaginary parts.
To split the data, use the MATLAB functions real, and imag.

2 Import both data sets into the GUI, as described in “Importing
Time-Domain Data into the GUI” on page 1-6.

3 Specify both the data sets together as estimation data, as described in
“Specify Estimation Data (GUI)” on page 2-3.

4 Estimate the parameters, as described in “Estimate Parameters (GUI)”
on page 2-39.
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Plot and Analyze Data (GUI)

In this section...

“Why Plot the Data Before Parameter Estimation” on page 1-12

“How To Plot Data in the GUI” on page 1-12

Why Plot the Data Before Parameter Estimation
After you import the estimation data, as described in “Import Data (GUI)” on
page 1-4, it is useful to remove outliers, smooth, detrend, or otherwise treat
the data to make it more tractable for analysis and estimation purposes. To
view and analyze the data characteristics, you must plot the data on a time
plot.

How To Plot Data in the GUI
To plot a data set, select the Data cell that you want to plot in the Transient
Data node of the Control and Estimation Tools Manager GUI, and click
Plot Data.
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The data is plotted on a time plot, as shown in the next figure.
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Using the time plot, you can examine the data characteristics such as noise,
outliers and portions of the data to use for estimating parameters. After you
analyze the data, you preprocess the data as described in “Preprocess Data
(GUI)” on page 1-15.
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Preprocess Data (GUI)

In this section...

“Ways to Preprocess Data Using the Data Preprocessing Tool” on page 1-15

“Opening the Data Preprocessing Tool” on page 1-15

“Handling Missing Data” on page 1-17

“Handling Outliers” on page 1-19

“Detrending Data” on page 1-19

“Filtering Data” on page 1-19

“Selecting Data” on page 1-21

Ways to Preprocess Data Using the Data
Preprocessing Tool
After you import the estimation data, as described in “Import Data (GUI)” on
page 1-4, you can perform the following preprocessing operations using the
Data Preprocessing Tool in Simulink Design Optimization software:

• Exclusion — Exclude a portion of the data from the estimation process. You
can exclude data by:

- Selecting it with your mouse.

- Graphically by selecting regions on a plot.

- Using rules, such as upper or lower bounds.

• Handle missing data –– Remove missing data, or compute missing data
using interpolation.

• Handle outliers –– Remove outliers.

• Detrend — Remove mean values or a straight line trend.

• Filter — Smooth data using a first-order filter, an arbitrary transfer
function, or an ideal filter.

Opening the Data Preprocessing Tool
To open the Data Preprocessing Tool:
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1 In the Control and Estimation Tools Manager GUI, select the Transient
Data node under the Estimation Task node, and then choose the data you
want to preprocess either in the Input Data, or Output Data tab. This
enables the Pre-process button.

2 Click Pre-process to open the Data Preprocessing Tool.
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Tip When you have multiple data sets, select the data set that you want
to preprocess from the Modify data from drop-down list in the Data
Preprocessing Tool.

In this section, the sample data set imported for preprocessing is the same as
used in the engine_idle_speed Simulink model. For an overview of creating
estimation projects and importing data sets, see “Model Requirements for
Importing Data” on page 1-2, and “Creating an Estimation Project” on page
1-4.

Handling Missing Data

• “Removing Missing Data” on page 1-18
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• “Interpolating Missing Data” on page 1-18

Removing Missing Data
Rows of missing or excluded data are represented by NaNs. To remove the rows
containing missing or excluded data, select the Remove rows where check
box in theMissing Data Handling area of the Data Preprocessing Tool GUI.

When the data set contains multiple columns of data, select all to remove
rows in which all the data is excluded. Select any to remove any excluded cell.
In the case of one-column data, any and all are equivalent.

Tip You can view the modified data in the Modified data tab of the Data
Preprocessing Tool GUI.

Interpolating Missing Data
The interpolation operation computes the missing data values using known
data values. When you select the Interpolate missing values using
interpolation method check box in the Missing Data Handling area of
the Data Preprocessing Tool GUI, the software interpolates the missing
data values.

You can compute the missing data values using one of the following
interpolation methods:

• Zero-order hold (zoh) — Fills the missing data sample with the data value
immediately preceding it.

• Linear interpolation (Linear) — Fills the missing data sample with the
average of the data values immediately preceding and following it.
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By default, the interpolation method is set to zoh. You can select the
Linear interpolation method from the Interpolate missing values using
interpolation method drop-down list.

Tip You can view the results of interpolation in theModified data tab of the
Data Preprocessing Tool GUI.

Handling Outliers
Outliers are data values that deviate from the mean by more than three
standard deviations. When estimating parameters from data containing
outliers, the results may not be accurate.

To remove outliers, select the Outliers check box to activate outlier exclusion.
You can set theWindow length to any positive integer, and use confidence
limits from 0 to 100%. The window length specifies the number of data points
used when calculating outliers.

Removing outliers replaces the data samples containing outliers with NaNs,
which you can interpolate in a subsequent operation. To learn more, see
“Interpolating Missing Data” on page 1-18.

Detrending Data
To detrend, select the Detrending check box. You can choose constant or
straight line detrending. Constant detrending removes the mean of the data
to create zero-mean data. Straight line detrending finds linear trends (in the
least-squares sense) and then removes them.

Filtering Data

• “Types of Filters” on page 1-19

• “How to Filter Data” on page 1-20

Types of Filters
You have these choices for filtering your data:
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• First order — A filter of the type
1

1τs +
where τ is the time constant that you specify in the associated field.

• Transfer function — A filter of the type
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where you specify the coefficients as vectors in the associated A
coefficients and B coefficients fields.

• Ideal— An idealized (noncausal) filter, either stop or pass band. Specify
either filter as a two-element vector in the Range (Hz) field. These filters
are ideal in the sense that there is no finite rolloff or ripple; the ends of the
ranges are perfectly horizontal in the frequency domain.

How to Filter Data
To filter the data to remove noise, select the Detrend/Filtering tab in the
Data Preprocessing Tool GUI. Select the Filtering check box, and choose the
type of filter from the Select filter type drop-down list.
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Selecting Data

• “Techniques for Excluding Data in the Data Preprocessing Tool” on page
1-21

• “Graphically Selecting Data” on page 1-21

• “Using Rules to Select Data Samples” on page 1-24

• “Using the Data Table to Select Data Samples” on page 1-26

Techniques for Excluding Data in the Data Preprocessing Tool
You can use the Data Preprocessing Tool to select a portion of the data to be
excluded from the estimation process. You can choose one of the following
techniques:

• Selecting data from the Data Editing Table.

• Selecting data from a plot of the data.

• Specifying a rule.

You accomplish the first two manually, and for the last you specify a rule.
When you exclude data using manual selection, the excluded data is shown
as red. When you exclude data using a rule, the background color of the cell
becomes gray. When a portion of the data is excluded both manually and by a
rule, the data is red, and the background is gray.

Note Changes in data are visible everywhere. When you use the Data
Editing table, you can view the results in the data plot.

Graphically Selecting Data
You can exclude data graphically. Click Exclude Graphically to open the
Select Points for Preprocessing Rule window.
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The way you exclude data is similar to the way you select a region for
zooming: place your cursor in the Input Data plot and drag the mouse to
draw a region of exclusion.

This figure shows an example of resulting data exclusion in the input data.
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In the Output Data plot, the excluded input data produces a blank area by
default. This corresponds to the NaNs that now represent excluded data. If
you choose to interpolate or remove the excluded data, the output data shows
the interpolated points.

When you make changes in the Select Points for Preprocessing Rule window,
they immediately appear in the Data Editing pane, and vice versa.

Selection Pane. By default, any box that you draw with your mouse selects
data for exclusion, but you can toggle between exclusion and inclusion using
the Selection pane on the left side of the Select Points for Preprocessing
Rule window.
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Using Rules to Select Data Samples
A more precise way to exclude data is to use mathematical rules. The
Exclusion Rules pane in the Data Preprocessing Tool allows you to enter
customized rules for excluding data.

These are the rules you can use to exclude data:

• “Upper and Lower Bounds” on page 1-25

• “MATLAB Expressions” on page 1-25
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• “Flatlines” on page 1-25

Upper and Lower Bounds. Select the Bounds check box to activate upper
and lower bound exclusion. Enter numbers in the Exclude X and Exclude
Y fields for upper and lower bound exclusion. By default, the exclusion rule
is to include the boundary values, but you can use the menu to exclude the
boundaries as well.

MATLAB Expressions. Use the MATLAB expression field to enter any
mathematical expression using MATLAB code. Use x as the variable name in
your expression for the data being tested.

Flatlines. If you have areas of your data set where the data is constant,
providing no new information, then you can choose to exclude those data
points as flatlines. The Window length field sets the minimum number of
constant data points required to define the area as a flatline.
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Example of Rule Exclusion. This figure shows data with a region of the
x-axis excluded.

Using the Data Table to Select Data Samples
The Data Editing table lists both the raw data set and the modified data
that you create.
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There are two tabs in the Data Editing pane: Raw data and Modified
data. The Raw Data pane shows the working copy of the data. For example,
if you exclude rows of data in the Raw data pane, the corresponding rows
of numbers become red in this table. By default the Modified data pane
represents the rows you removed by inserting NaNs.
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In the Modified data pane, you can choose to remove the excluded data
completely or interpolate it. See “Handling Missing Data” on page 1-17 for
more information.

After you select data for exclusion, you can view it graphically by clicking
Exclude Graphically.
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As you make changes in the Data Editing pane, they immediately appear in
the Select Points for Preprocessing Rule window, and vice versa.
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Add Preprocessed Data Sets to an Estimation Project (GUI)
After you preprocess the data using the techniques described in “Ways to
Preprocess Data Using the Data Preprocessing Tool” on page 1-15, you can
add the data set to an estimation project either by overwriting an existing
data set or creating a new data set.

In this section...

“Overwriting an Existing Data Set” on page 1-30

“Creating a New Data Set” on page 1-31

Overwriting an Existing Data Set
To overwrite an existing data set with the preprocessed data:

1 In the Write results to area of the Data Preprocessing Tool GUI, select
the existing dataset option.

2 Choose the data set you want to overwrite from the drop-down list.

3 Click Add.

This action overwrites the selected data set with the modified data in the
Control and Estimation Tools Manager GUI.
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Tip You can export the preprocessed data to the MATLAB Workspace, as
described in “Export Prepared Data to the MATLAB Workspace” on page 1-33.

Creating a New Data Set
If you do not want to overwrite an existing data set with the preprocessed
data, as described in “Overwriting an Existing Data Set” on page 1-30, you
can create a new data set for the preprocessed data:

1 In the Write results to area of the Data Preprocessing Tool GUI, select
the new dataset option.

2 Specify the name of the data set in the adjacent field.
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3 Click Add.

This action adds a new data node in the Control and Estimation Tools
Manager GUI containing the modified data.

Tip You can export the preprocessed data to the MATLAB Workspace, as
described in “Export Prepared Data to the MATLAB Workspace” on page 1-33.
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Export Prepared Data to the MATLAB Workspace
After you add the preprocessed data to an estimation project, as described in
“Add Preprocessed Data Sets to an Estimation Project (GUI)” on page 1-30,
you can export the data set to the MATLAB Workspace. You can use the data
to further prepare it or estimate parameters using the data.

1 In the Transient Data node of the Control and Estimation Tools Manager
GUI, select the node containing the prepared data set.

2 Right-click the table Data cell containing the data that you want to export,
and select Export.

The Export to Workspace dialog box opens.

3 Specify the MATLAB variable names for the prepared data and the
corresponding time vector in the Data and Time fields, respectively.

4 Click OK.

The resulting MATLAB variables data and time4 appear in the MATLAB
Workspace browser.
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Parameter Estimation Workflow
When you estimate model parameters, Simulink Design Optimization
software compares the measured data with data generated by a Simulink
model. Using optimization techniques, the software estimates the parameter
and (optionally) initial conditions of states to minimize a user-selected cost
function. The cost function typically calculates a least-square error between
the empirical and model data signals.

After you import and preprocess the estimation data, as described in “Import
Data (GUI)” on page 1-4 and “Preprocess Data (GUI)” on page 1-15, follow
these steps to estimate model parameters:

1 Specify estimation data

2 Specify parameters to estimate

3 Specify known initial states or estimate the initial states

4 (Optional) Specify plots to view estimation progress

5 (Optional) Specify estimation and simulation options

6 Estimate the parameters

7 Validate the estimated parameters and states

Note The Simulink model must remain open to perform parameter
estimation tasks.

To learn how to estimate parameters at the command line, see “Estimate
Parameters (Code)” on page 2-87.
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Specify Estimation Data (GUI)

In this section...

“Creating an Estimation Task” on page 2-3

“How to Specify Data” on page 2-4

Creating an Estimation Task
After you import the transient data, as described in “Import Data (GUI)” on
page 1-4, you must create an estimation task and configure the estimation
settings. If your data contains noise or outliers, you must also preprocess the
data, as described in “Preprocess Data (GUI)” on page 1-15.

To create a container that stores the estimation settings:

1 In the Control and Estimation Tools Manager, right-click the Estimation
node in the Workspace tree and select New.

2 Select the New Estimation node.

The Control and Estimation Tools Manager now resembles the next figure.
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How to Specify Data
After you select the New Estimation node, the Data Sets tab appears. Here
you select the data set that you want to use in the estimation.

Select the Selected check box to the right of the New Data data set.
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Note If you imported multiple data sets, you can select them for estimation
by selecting the check box to the right of each desired data set. When using
several data sets, you increase the estimation precision. However, you also
increase the number of required simulations: for N parameters and M data
sets, there are M*(2N+1) simulations per iteration.

Then, specify the weight of each output from this model by setting theWeight
column in the Output data weights table.

The relative weights are used to place more or less emphasis on specific
output variables. The following are a few guidelines for specifying weights:

• Use less weight when an output is noisy.

• Use more weight when an output strongly affects parameters.
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• Use more weight when it is more important to accurately match this model
output to the data.
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Specify Parameters to Estimate (GUI)

In this section...

“Choosing Which Parameters to Estimate First” on page 2-7

“How to Specify Parameters for Estimation” on page 2-7

“Specifying Initial Guesses and Upper/Lower Bounds” on page 2-12

“Specifying Parameter Dependency” on page 2-14

“Specify Independent Parameters to Estimate (GUI)” on page 2-15

Choosing Which Parameters to Estimate First
Simulink Design Optimization software lets you estimate scalar, vector and
matrix parameters. Estimating model parameters is an iterative process.
Often, it is more practical to estimate a small group of parameters and use the
final estimated values as a starting point for further estimation of parameters
that are trickier. When you have a large number of parameters to estimate,
select the parameters that influence the output the most to be estimated
first. Making these sorts of choices involves experience, intuition, and a solid
understanding of the strengths and limitations of your Simulink model.

After you estimate a subset of parameters and validate the estimated
parameters, select the remaining parameters for estimation.

How to Specify Parameters for Estimation
To select parameters for estimation:

1 In the Control and Estimation Tools Manager, select the Variables node
in theWorkspace tree to open the Estimated Parameters pane.
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2 In the Estimated Parameters pane, click Add to open the Select
Parameters dialog box.
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The dialog box lists all the variables in the model workspace and the
MATLAB workspace that the model uses. You can use the mouse to select
the parameters to estimate.

You can also enter parameters, separated by commas, in the Specify
expression field of the Select Parameters dialog box. The parameters
can be stored in one of the following:

• Simulink software parameter object

Example: For a Simulink parameter object k, type k.value.

• Structure

Example: For a structure S, type S.fieldname (where fieldname
represents the name of the field that contains the parameter).

• Cell array

Example: Type C{1} to select the first element of the C cell array.

• MATLAB array

Example: Type a(1:2) to select the first column of a 2-by-2 array called
a.

2-9



2 Parameter Estimation

Sometimes, models have parameters that are not explicitly defined in
the model itself. For example, a gain k could be defined in the MATLAB
workspace as k=a+b, where a and b are not defined in the model but k
is used. To add these independent parameters to the Select Parameters
dialog box, see “Specifying Parameter Dependency” on page 2-14.

3 Select the last seven parameters: freq1, freq2, freq3, gain1, gain2,
gain3, and mean_speed, and then click OK.

Note You need not estimate the parameters selected here all at once. You
can first select all the parameters that you are interested in, and then later
select the ones to estimate as described in the next step.

The Control and Estimation Tools Manager now resembles the next figure.

To learn how to specify the settings in the Default settings area of the
pane, see “Specifying Initial Guesses and Upper/Lower Bounds” on page
2-12.
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4 In the New Estimation node of the Control and Estimation Tools
Manager GUI, select the Parameters tab . In this pane, you select which
parameters to estimate and the range of values for the estimation.

a Select the parameters you want to estimate by selecting the check box
in the Estimate column.

b Enter initial values for your parameters in the Initial Guess column.

The default values in theMinimum and Maximum columns are -Inf
and +Inf, respectively, but you can select any range you want. For more
information, see “Specifying Initial Guesses and Upper/Lower Bounds”
on page 2-12.

Note When you specify the Minimum and Maximum values for the
parameters here, it does not affect your settings in the Variables node.
You make these choices on a per estimation basis. You can move data to
and from the Variables node into the Estimation node.

For this example, select gain1, gain2, gain3 and mean_speed for
estimation and set gain1 to 10, gain2 to 100, gain3 to 50, and mean_speed
to 500. Alternatively, use any initial values you like.

If you have good reason to believe a parameter lies within a finite range,
it is usually best not to use the default minimum and maximum values.
Often, there are computational advantages in specifying finite bounds if
you can. It can be very important to specify lower and upper bounds. For
example, if a parameter specifies the weight of a part, be sure to specify 0
as the absolute lower bound if better knowledge is unavailable.

The Control and Estimation Tools Manager now resembles the next figure.

2-11



2 Parameter Estimation

Specifying Initial Guesses and Upper/Lower Bounds
After you select parameters for estimation in the Variables node of the
Control and Estimation Tools Manager GUI, the Estimated Parameters tab
in the Control and Estimation Tools Manager looks like the following figure.
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For each parameter, use the Default settings pane to specify the following:

• Initial guess— The value the estimation uses to start the process.

• Minimum— The smallest allowable parameter value. The default is -Inf.

• Maximum— The largest allowable parameter value. The default is +Inf.

• Typical value — The average order of magnitude. If you expect your
parameter to vary over several orders of magnitude, enter the number
that specified the average order of magnitude you expect. For example, if
your initial guess is 10, but you expect the parameter to vary between
10 and 1000, enter 100 (the average of the order of magnitudes) for the
typical value.
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You use the typical value in two ways:

• To scale parameters with radically different orders of magnitude for equal
emphasis during the estimation. For example, try to select the typical
values so that

anticipated value
typical value

≅ 1

or

initial value
typical value

≅ 1

• To put more or less emphasis on specific parameters. Use a larger typical
value to put more emphasis on a parameter during estimation.

Specifying Parameter Dependency
Sometimes parameters in your model depend on independent parameters
that do not appear in the model. The following steps give an overview of how
to specify independent parameters for estimation:

1 Add the independent parameters to the model workspace (along with
initial values).

2 Define a Simulation Start function that runs before each simulation of the
model. This Simulation Start function defines the relationship between the
dependent parameters in the model and the independent parameters in
the model workspace.

3 The independent parameters now appear in the Select Parameters dialog
box. Add these parameters to the list of parameters to be estimated.

Caution Avoid adding independent parameters together with their
corresponding dependent parameters to the lists of parameters to be
estimated. Otherwise the estimation could give incorrect results. For
example, when a parameter x depends on the parameters a and b, avoid
adding all three parameters to the list.
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For an example of how to specify independent parameters, see “Specify
Independent Parameters to Estimate (GUI)” on page 2-15.

Specify Independent Parameters to Estimate (GUI)
Assume that the parameter Kint in the model srotut1 is related to the
parameters x and y according to the relationship Kint=x+y. Also assume that
the initial values of x and y are 1 and -0.7 respectively. To estimate x and y
instead of Kint, first define these parameters in the model workspace. To
do this:

1 At the MATLAB prompt, type

srotut1

This opens the srotut1 model window.

2 Select View > Model Explorer from the srotut1 window to open the
Model Explorer window.

3 In the Model Hierarchy tree, select srotut1 > Model Workspace.
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4 Select Add > MATLAB Variable to add a new variable to the model
workspace. A new variable with a default name Var appears in the Name
column.

5 Double-click Var to make it editable and change the variable name to x.
Edit the initial Value to 1.

6 Repeat steps 4 and 5 to add a variable y with an initial value of -0.7.

The Model Explorer window resembles the following figure.

7 To add the Simulation Start function that defines the relationship between
Kint and the independent parameters x and y, select File > Model
Properties in the srotut1 model window.

8 In the Model Properties window, click the Callbacks tab.

9 To enter a Simulation start function, select StartFcn*, and type the name
of a new function. For example, srotut1_start in the Simulation start
function panel. Then, click OK.
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10 Create a MATLAB file named srotut1_start. The content of the file
defines the relationship between the parameters in the model and the
parameters in the workspace. For this example, the content resembles
the following:

wks = get_param(gcs, 'ModelWorkspace')
x = wks.evalin('x')
y = wks.evalin('y')
Kint = x+y;

Note You must first use the get_param function to get the variables x and
y from the model workspace before you can use them to define Kint.

When you select parameters for estimation in the Variables node of Control
and Estimation Tools Manager, x and y appear in the Select Parameters
dialog box.
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Specify Known Initial States (GUI)

In this section...

“When to Specify Initial States Versus Estimate Initial States” on page 2-18

“How to Specify Initial States in the GUI” on page 2-18

When to Specify Initial States Versus Estimate Initial
States
Often, sets of measured data are collected at various times and under
different initial conditions. When you estimate model parameters using one
data set and subsequently run another estimation with a second data set,
your parameter values may not match. Given that the Simulink Design
Optimization software attempts to find constant values for parameters, this
is clearly a problem.

You can estimate the initial conditions using procedures that are similar to
those you use to estimate parameters. You can then use these initial condition
estimates as a basis for estimating parameters for your Simulink model. The
Control and Estimation Tools Manager has an Estimated States pane that
lists the states available for initial condition estimation. To learn how to
estimate initial states, see “Estimate Initial States” on page 2-68.

How to Specify Initial States in the GUI
After you select parameters for estimation, as described in “Specify
Parameters to Estimate (GUI)” on page 2-7, you can specify initial conditions
of states in your model. By default, the estimation uses initial conditions
specified in the Simulink model. If you want to specify initial conditions
other than the defaults, use the State Data tab. You can select the State
Data tab in the New Data node under the Transient Data node in the
Workspace tree.
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To specify the initial condition of a state for the engine_idle_speed model:

1 Select the Data cell associated with the state.

2 Enter the initial conditions. In this example, enter -0.2 for State - 1 of
the engine_idle_speed/Transfer Fcn. For State - 2, enter 0.
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Progress Plots

In this section...

“Types of Plots” on page 2-21

“Basic Steps for Creating Plots” on page 2-21

Types of Plots
You can choose the plot type from the Plot Type drop-down list. The following
types of plots are available for viewing and evaluating the estimation:

• Cost function — Plot the cost function values.

• Measured and simulated— Plot empirical data against simulated data.

• Parameter sensitivity— Plot the rate of change of the cost function as a
function of the change in the parameter. That is, plot the derivative of the
cost function with respect to the parameter being varied.

• Parameter trajectory— Plot the parameter values as they change.

• Residuals — Plot the error between the experimental data and the
simulated output.

Basic Steps for Creating Plots
Before you begin estimating the parameters, you must create the plots for
viewing the progress of the estimation.

Note An estimation must be created before creating views. Otherwise, the
Options table will be empty. To learn more, see “Creating an Estimation
Task” on page 2-3.

To create plots for viewing the estimation progress, follow the steps below:

1 Right-click the Views node in the Control and Estimation Tools Manager
and select New.
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2 In theWorkspace tree, select New View to open the View Setup pane.
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3 In the Select plot types table, select the Plot Type from the drop-down
list. In this example, select Cost function.

4 Select Measured and simulated as the Plot Type for Plot 2. This plot
will be used in validating estimated parameters.

5 In the Options area, select the check-box for both Plot 1 and Plot 2.

6 Click Show Plots. This displays an empty cost function plot and a plot of
the measured data.

2-23



2 Parameter Estimation

When you perform the estimation, the plot updates automatically.
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Estimation Options

In this section...

“Accessing Estimation Options” on page 2-25

“Supported Estimation Methods” on page 2-27

“Selecting Optimization Termination Options” on page 2-29

“Selecting Additional Optimization Options” on page 2-29

“Specifying Goodness of Fit Criteria (Cost Function)” on page 2-30

“How to Specify Estimation Options in the GUI” on page 2-30

Accessing Estimation Options
In the New Estimation node in theWorkspace tree, click the Estimation
tab.
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Click Estimation Options. This action opens the Options- New Estimation
dialog box where you can specify the estimation method, algorithm options
and cost function for the estimation.
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The following sections describe the estimation method settings and cost
function:

• “Supported Estimation Methods” on page 2-27

• “Selecting Optimization Termination Options” on page 2-29

• “Selecting Additional Optimization Options” on page 2-29

• “Specifying Goodness of Fit Criteria (Cost Function)” on page 2-30

Supported Estimation Methods
Both the Method and Algorithm options define the optimization method.
Use the Optimization method area of the Options dialog box to set the
estimation method and its algorithm.

For the Method option, the four choices are:

• Nonlinear least squares (default) — Uses the Optimization Toolbox™
nonlinear least squares function lsqnonlin.

• Gradient descent— Uses the Optimization Toolbox function fmincon.
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• Pattern search— Uses the pattern search method patternsearch. This
option requires Global Optimization Toolbox software.

• Simplex search— Uses the Optimization Toolbox function fminsearch,
which is a direct search method. Simplex search is most useful for simple
problems and is sometimes faster than fmincon for models that contain
discontinuities.

The following table summarizes the Algorithm options for the Nonlinear
least squares and Gradient descent estimation methods:

Method Algorithm Option Learn More

Nonlinear
least squares

• Trust-Region-Reflective
(default)

• Levenberg-Marquardt

In the Optimization
Toolbox
documentation,
see:

• “Large Scale
Trust-Region
Reflective Least
Squares”

• “Levenberg-Marquardt
Method”

Gradient
descent

• Active-Set (default)

• Interior-Point

• Trust-Region-Reflective

In the Optimization
Toolbox
documentation,
see:

• “fmincon Active
Set Algorithm”

• “fmincon Interior
Point Algorithm”

• “fmincon Trust
Region Reflective
Algorithm”
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Selecting Optimization Termination Options
Specify termination options in the Optimization options area.

Several options define when the optimization terminates:

• Diff max change — The maximum allowable change in variables
for finite-difference derivatives. See fmincon in the Optimization
Toolboxdocumentation for details.

• Diff min change — The minimum allowable change in variables for
finite-difference derivatives. See fmincon in the Optimization Toolbox
documentation for details.

• Parameter tolerance — Optimization terminates when successive
parameter values change by less than this number.

• Maximum fun evals — The maximum number of cost function
evaluations allowed. The optimization terminates when the number of
function evaluations exceeds this value.

• Maximum iterations— The maximum number of iterations allowed. The
optimization terminates when the number of iterations exceeds this value.

• Function tolerance — The optimization terminates when successive
function values are less than this value.

By varying these parameters, you can force the optimization to continue
searching for a solution or to continue searching for a more accurate solution.

Selecting Additional Optimization Options
At the bottom of the Optimization options pane is a group of additional
optimization options.
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Additional options for optimization include:

• Display level — Specifies the form of the output that appears in the
MATLAB command window. The options are Iteration, which displays
information after each iteration, None, which turns off all output, Notify,
which displays output only if the function does not converge, and Final,
which only displays the final output. Refer to the Optimization Toolbox
documentation for more information on what type of iterative output each
method displays.

• Gradient type — When using Gradient Descent or Nonlinear least
squares as the Method, the gradients are calculated based on finite
difference methods. The Refined method offers a more robust and less
noisy gradient calculation method than Basic, although it does take longer
to run optimizations using the Refined method.

Specifying Goodness of Fit Criteria (Cost Function)
The cost function is a function that estimation methods attempt to minimize.
You can specify the cost function at the bottom of the Optimization options
area.

You have the following options when selecting a cost function:

• Cost function— The default is SSE (sum of squared errors), which uses a
least-squares approach. You can also use SAE, the sum of absolute errors.

• Use robust cost—Makes the optimizer use a robust cost function instead
of the default least-squares cost. This is useful if the experimental data has
many outliers, or if your data is noisy.

How to Specify Estimation Options in the GUI
You can set several options to tune the results of the estimation. These
options include the optimization methods and their tolerances.

To set options for estimation:

1 Select the New Estimation node in the Workspace tree.
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2 Click the Estimation tab.

3 Click Estimation Options to open the Options dialog box.

4 Click the Optimization Options tab and specify the options.
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Simulation Options

In this section...

“Accessing Simulation Options” on page 2-32

“Selecting Simulation Time” on page 2-33

“Selecting Solvers” on page 2-34

Accessing Simulation Options
To estimate parameters of a model, Simulink Design Optimization software
runs simulations of the model.

To set options for simulation:

1 Select the New Estimation node in the Workspace tree.

2 Click the Estimation tab.

3 Click Estimation Options to open the Options dialog box.

4 Click the Simulation Options tab and specify the options, as described in
the following sections:
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• “Selecting Simulation Time” on page 2-33

• “Selecting Solvers” on page 2-34

Selecting Simulation Time
You can specify the simulation start and stop times in the Simulation time
area of the Simulation Options tab.

By default, Start time and Stop time are automatically computed based on
the start and stop times specified in the Simulink model.

To set alternative start and stop times for the optimization, enter the new
times under Simulation time. This action overwrites the simulation start
and stop times specified in the Simulink model.

Simulation Time for Data Sets with Different Time Lengths
Simulink Design Optimization software can simulate models containing
empirical data sets of different time lengths. You can use experimental data
sets for estimation that contain I/O samples collected at different time points.

The following example shows a single-input, two-output model for which
you want to estimate the parameters.

����

�����

�����

The model uses two output data sets containing transient data samples for
parameter estimation:

• Output y1(t) at time points t t t tn1 1
1

2
1 1= { }, ,.... .
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• Output y2(t) at time points t t t tm2 1
2

2
2 2= { }, ,..... .

The simulation time t is computed as:

t t t t t t t t tn m= ∪ = { }1 2 1
1

1
2

2
1

2
2 1 2, , , ,..... ,

This new set ranges from tmin to tmax. The values tmin and tmax represent
the minimum and maximum time points in t respectively.

When you run the estimation, the model is simulated over the time range t.
Simulink extracts the simulated data for each output based on the following
criteria:

• Start time— Typically, the start time in the Simulink model is set to 0.
For a nonzero start time, the simulated data corresponding to time points

before t1
1 for y1(t) and t1

2 for y2(t) are discarded.

• Stop time — If the stop time t tstop ≥ max , the simulated data
corresponding to time points in t1 are extracted for y1(t). Similarly, the
simulated data for time points in t2 are extracted for y2(t).

If the stop time t tstop < max , the data spanning time points > tstop are
discarded for both y1(t) and y2(t).

Selecting Solvers
When running the estimation, the software solves the dynamic system using
one of several Simulink solvers.

Specify the solver type and its options in the Solver options area of the
Simulation Options tab of the Options dialog box.

The solver can be one of the following Type:
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• Auto (default) — Uses the simulation settings specified in the Simulink
model.

• Variable-step — Variable-step solvers keep the error within specified
tolerances by adjusting the step size the solver uses. For example, if the
states of your model are likely to vary rapidly, you can use a variable-step
solver for faster simulation. For more information on the variable-step
solver options, see “Variable-Step Solver Options” on page 2-35.

• Fixed-step — Fixed-step solvers use a constant step-size. For more
information on the fixed-step solver options, see “Fixed-Step Solver
Options” on page 2-36.

See “Choosing a Solver” in the Simulink documentation for information about
solvers.

Note To obtain faster simulations during estimation, you can change the
solver Type to Variable-step or Fixed-step. However, the estimated
parameter values apply only for the chosen solver type, and may differ from
values you obtain using settings specified in the Simulink model.

Variable-Step Solver Options
When you select Variable-step as the solver Type, you can choose one of
the following as the Solver:

• Discrete (no continuous states)

• ode45 (Dormand-Prince)

• ode23 (Bogacki-Shampine)

• ode113 (Adams)

• ode15s (stiff/NDF)

• ode23s (stiff/Mod. Rosenbrock)

• ode23t (Mod. stiff/Trapezoidal)

• ode23tb (stiff/TR-BDF2)
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You can also specify the following parameters that affect the step-size of the
simulation:

• Maximum step size— The largest step-size the solver can use during a
simulation.

• Minimum step size— The smallest step-size the solver can use during a
simulation.

• Initial step size— The step-size the solver uses to begin the simulation.

• Relative tolerance— The largest allowable relative error at any step in
the simulation.

• Absolute tolerance— The largest allowable absolute error at any step in
the simulation.

• Zero crossing control— Set to on for the solver to compute exactly where
the signal crosses the x-axis. This option is useful when using functions
that are nonsmooth and the output depends on when a signal crosses the
x-axis, such as absolute values.

By default, the software automatically chooses the values for these options.
To specify your own values, enter them in the appropriate fields. For more
information, see “Solver Pane” in the Simulink documentation.

Fixed-Step Solver Options
When you select Fixed-step as the solver Type, you can choose one of the
following as the Solver:

• Discrete (no continuous states)

• ode5 (Dormand-Prince)
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• ode4 (Runge-Kutta)

• ode3 (Bogacki-Shanpine)

• ode2 (Heun)

• ode1 (Euler)

You can also specify the Fixed step size value, which determines the
step size the solver uses during the simulation. By default, the software
automatically chooses a value for this option. For more information, see
“Fixed-step size (fundamental sample time)” in the Simulink documentation.
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Progress Display Options
You can specify the display options by clicking Display Options in the
Estimation tab in the Control and Estimation tools Manager. This opens the
following dialog box.

Clearing a check box implies that feature will not appear in the display table
as the estimation progresses. To learn more about the display table, see
“Iterative Display” in the Optimization Toolbox documentation.
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Estimate Parameters (GUI)
Before you begin estimating the parameters, you must have configured the
estimation data and parameters, and specified estimation and simulation
options, as described in “Specify Estimation Data (GUI)” on page 2-3 and
“Specify Parameters to Estimate (GUI)” on page 2-7.

To start the estimation, select the New Estimation node in the Control and
Estimation Tools Manager and select the Estimation tab.

Click Start to begin the estimation process. At the end of the iterations, the
window should resemble the following:

Usually, a lower cost function value indicates a successful estimation,
meaning that the experimental data matches the model simulation with the
estimated parameters.
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Note For information on types of problems you may encounter using
optimization solvers, see “Steps to Take After Running a Solver” in the
Optimization Toolbox documentation.

The Estimation pane displays each iteration of the optimization methods. To
see the final values for the parameters, click the Parameters tab.

The values of these parameters are also updated in the MATLAB workspace.
If you specify the variable name in the Initial Guess column, you can restart
the estimation from where you left off at the end of a previous estimation.

After the estimation process completes, the cost function minimization plot
appears as shown in the following figure.
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If the optimization went well, you should see your cost function converge on a
minimum value. The lower the cost, the more successful is the estimation.

You can also examine the measured versus simulated data plot to see how
closely the simulated data matches the measured estimation data. The next
figure shows the measured versus simulated data plot generated by running
the estimation of the engine_idle_speed model.
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Validate Parameters (GUI)

In this section...

“Model Validation” on page 2-43

“Load and Import Validation Data (GUI)” on page 2-44

“Compare Measured and Simulated Responses (GUI)” on page 2-46

“Compare Residuals (GUI)” on page 2-50

Model Validation
After you complete estimating the parameters, as described in “Estimate
Parameters (GUI)” on page 2-39, you must validate the results against
another set of data.

The steps to validate a model using the Control and Estimation Tools
Manager are:

1 Import the validation data set to the Transient Data node.

2 Add a new validation task in the Validation node in theWorkspace tree.

3 Configure the validation settings by selecting the plot types and the
validation data set from the Validation Setup pane.

4 Click Show Plots in the Validation Setup pane and view the results
in the plot window.

5 Compare the validation plots to the corresponding view plots to see if they
match.

The basic difference between the validation and views features is that you
can run validation after the estimation is complete. All views should be set
up before an estimation, and you can watch the views update in real time.
Validations can use other validation data sets for comparison with the model
response. Also, validations appear after you have completed an estimation
and do not update.
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You can validate your data by comparing measured vs. simulated data for
your estimation data and validation data sets. Also, it is often useful to
compare residuals in the same way.

Load and Import Validation Data (GUI)
To validate the estimated parameters computed in “Estimate Parameters
(GUI)” on page 2-39, you must first import the data into the Control and
Estimation Tools Manager GUI.

To load the validation data, type

load iodataval

at the MATLAB prompt. This loads the data into the MATLAB workspace.
The next step is to import this data into the Control and Estimation Tools
Manager. See “Import Data (GUI)” on page 1-4 for information on importing
data, but the quickest way is to follow these steps:

1 Right-click the Transient Data node in the Workspace tree in the
Control and Estimation Tools Manager and select New.

2 Select New Data (2) from the Transient Data pane.

3 Right-click the New Data (2) node in the Workspace tree and select
Rename. Change the name of the data to Validation Data.

4 In the Input Data pane, select the Data cell associated with Channel
- 1 and click Import. In the Data Import dialog box, select iodataval
and assign column 1 to the selected channel by entering 1 in the Assign
columns field. Click Import to import the input data.
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5 Select the Time/Ts cell and import time using the Data Import dialog box.

6 Similarly, in the Output Data pane, select Time/Ts and import time.

7 In the Output Data pane, select the Data cell associated with Channel
- 1 and click Import. Import the second column of data in iodataval by
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selecting it from the list in the Import Data dialog box and entering 2 in the
Assign columns field. Click Import to import the output data.

The Control and Estimation Tools Manager should resemble the next
figure.

Compare Measured and Simulated Responses (GUI)
After you import the validation data, as described in “Load and Import
Validation Data (GUI)” on page 2-44, right-click the Validation node
and select New. This creates a New Validation node in the Control and
Estimation Tools Manager.
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To perform the validation:

1 Select the New Validation node in the Workspace tree to open the
Validation Setup pane.
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2 Click the Plot Type cell for Plot 1 and select Measured and simulated
from the drop-down menu.

3 In the Options area, select Validation Data in the Validation data set
drop-down list.

4 Click Show Plots to open a plot figure window as shown next.
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Measured Versus Simulated Data Plot for Validation Data

5 Compare this plot with the plot of Measured and simulated data for
the validation data. For more information on how to create this plot, see
“Progress Plots” on page 2-21.
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Measured and Simulated Data Views Plot

Tip Examine the residuals compare the difference between the simulated
response and measured data, as described in “Compare Residuals (GUI)”
on page 2-50.

Compare Residuals (GUI)
The residuals plot shows the difference between the simulated response and
measured data. To indicate a good fit between the simulated output and
measured data, the residuals:

• Should lie within a small percent of the maximum output variation

• Should not display any systematic patterns
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To look at the residuals, select Residuals as the Plot Type for Plot 2 in the
New Validation pane. In the Options area, select the Plot 2 check box and
click Show Plots. The following figure shows the resulting residuals plot.

Plot of Residuals Using the Validation Data

Compare the validation data residuals with the original data set residuals
from the Views node in theWorkspace tree. To create the plot of residuals
for the original data set, select the New View node and choose Residuals as
the Plot Type.
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Plot of Residuals Using the Test Data

The plot on the left agrees with the plot of the residuals for the validation
data. The right side has no plot because residuals were not calculated for the
validation data during the original estimation process.
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Accelerating Model Simulations During Estimation

In this section...

“About Accelerating Model Simulations During Estimation” on page 2-53

“Limitations” on page 2-53

“Setting the Accelerator Mode for Parameter Estimation” on page 2-53

About Accelerating Model Simulations During
Estimation
You can accelerate the parameter estimation computations by changing the
simulation mode of your Simulink model. Simulink Design Optimization
software supports Normal and Accelerator simulation modes. For more
information about these modes, see “Accelerating Models” in the Simulink
documentation.

The default simulation mode is Normal. In this mode, Simulink software uses
interpreted code, rather than compiled C code during simulations.

In the Accelerator mode, Simulink Design Optimization software runs
simulations during estimation with compiled C code. Using compiled C code
speeds up the simulations and reduces the time to estimate parameters.

Limitations
You cannot use the Accelerator mode if your model contains algebraic loops.
If the model contains MATLAB function blocks, you must either remove them
or replace them with Fcn blocks.

Setting the Accelerator Mode for Parameter
Estimation
To set the simulation mode to Accelerator, open the Simulink model window
and perform one of the following actions:

• Select Simulation > Accelerator.

• Choose Accelerator from the drop-down list as shown in the next figure.
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Tip To obtain the maximum performance from the Accelerator mode, close
all Scope blocks in your model.
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Speedup Using Parallel Computing

In this section...

“When to Use Parallel Computing for Parameter Estimation” on page 2-55

“How Parallel Computing Speeds Up Estimation” on page 2-56

When to Use Parallel Computing for Parameter
Estimation
You can use Simulink Design Optimization software with Parallel Computing
Toolbox™ software to speed up parameter estimation of Simulink models.
Using parallel computing may reduce the estimation time in the following
cases:

• The model contains a large number parameters to estimate, and the
Nonlinear least squares or Gradient descent is selected as the
estimation method.

• The Pattern search method is selected as the estimation method.

• The model is complex and takes a long time to simulate.

When you use parallel computing, Simulink Design Optimization software
distributes independent simulations to run them in parallel on multiple
MATLAB sessions, also known as workers. The time required to simulate
the model dominates the total estimation time. Therefore, distributing
the simulations significantly reduces the estimation time. For more
information on the expected speedup, see “How Parallel Computing Speeds
Up Estimation” on page 2-56.

The following sections describe how to configure your system, and use parallel
computing:

• “How to Use Parallel Computing (GUI)” on page 2-59

• “How to Use Parallel Computing (Code)” on page 2-132
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How Parallel Computing Speeds Up Estimation
You can enable parallel computing with the Nonlinear least squares,
Gradient descent and Pattern search estimation methods in the Simulink
Design Optimization software. The following sections describe how parallel
computing speeds up the estimation:

• “Parallel Computing with Nonlinear least squares and Gradient descent
Methods” on page 2-56

• “Parallel Computing with the Pattern search Method” on page 2-57

Parallel Computing with Nonlinear least squares and Gradient
descent Methods
When you select Gradient descent as the estimation method, the model is
simulated during the following computations:

• Objective value computation — One simulation per iteration

• Objective gradient computations — Two simulations for every tuned
parameter per iteration

• Line search computations — Multiple simulations per iteration

The total time, Ttotal , taken per iteration to perform these simulations is
given by the following equation:

T T N T N T T N Ntotal p ls p ls= + × + × = × + ×× +( )) ( ) ( ( )( )2 1 2

where T is the time taken to simulate the model and is assumed to be equal

for all simulations, Np is the number of parameters to estimate, and Nls is
the number of line searches.

When you use parallel computing, Simulink Design Optimization software
distributes the simulations required for objective gradient computations.
The simulation time taken per iteration when the gradient computations

are performed in parallel, TtotalP , is approximately given by the following
equation:
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where Nw is the number of MATLAB workers.

Note The equation does not include the time overheads associated with
configuring the system for parallel computing and loading Simulink software
on the remote MATLAB workers.

The expected reduction of the total estimation time is given by the following
equation:
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Parallel Computing with the Pattern search Method
The Pattern search method uses search and poll sets to create and compute
a set of candidate solutions at each estimation iteration.

The total time, Ttotal , taken per iteration to perform these simulations, is
given by the following equation:

T T N N T N N T N N Ntotal p ss p ps p ss ps= × × + × × = × × +( ( ( )) )

where T is the time taken to simulate the model and is assumed to be equal

for all simulations, Np is the number of parameters to estimate, Nss is a

factor for the search set size, and Nps is a factor for the poll set size.

When you use parallel computing, Simulink Design Optimization software
distributes the simulations required for the search and poll set computations,
which are evaluated in separate parfor loops. The simulation time taken per
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iteration when the search and poll sets are computed in parallel, TtotalP ,
is given by the following equation:
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where Nw is the number of MATLAB workers.

Note The equation does not include the time overheads associated with
configuring the system for parallel computing and loading Simulink software
on the remote MATLAB workers.

The expected speed up for the total estimation time is given by the following
equation:
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For example, for a model with Np=3, Nw=4, Nss=15, and Nps=2, the expected

speedup equals
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Using the Pattern search method with parallel computing may not speed
up the estimation time. When you do not use parallel computing, the method
stops searching for a candidate solution at each iteration as soon as it finds a
solution better than the current solution. When you use parallel computing,
the candidate solution search is more comprehensive. Although the number
of iterations may be larger, the estimation without using parallel computing
may be faster.
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How to Use Parallel Computing (GUI)

In this section...

“Configure Your System for Parallel Computing” on page 2-59

“Specify Model Dependencies” on page 2-60

“Estimate Model Parameters” on page 2-61

“Troubleshooting” on page 2-65

Configure Your System for Parallel Computing
You can use parallel computing on multi-core processors or multi-processor
networks. To configure your system for parallel computing, see the following
sections:

• “Configuring Parallel Computing on Multicore Processors” on page 2-59

• “Configuring Parallel Computing on Multiprocessor Networks” on page 2-59

After you configure your system for parallel computing, you can use the GUI
or the command-line functions to estimate the model parameters.

Configuring Parallel Computing on Multicore Processors
With a basic Parallel Computing Toolbox license, you can establish a pool of
up to four parallel MATLAB sessions in addition to the MATLAB client.

To start a pool of four MATLAB sessions in local configuration, type the
following at the MATLAB prompt:

matlabpool open local

To learn more, see the matlabpool reference page in the Parallel Computing
Toolbox documentation.

Configuring Parallel Computing on Multiprocessor Networks
To use parallel computing on a multiprocessor network, you must have
the Parallel Computing Toolbox software and the MATLAB Distributed
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Computing Server™ software. To learn more, see the Parallel Computing
Toolbox and MATLAB Distributed Computing Server documentation.

To configure a multiprocessor network for parallel computing:

1 Create a user configuration file to include any model file dependencies, as
described in “Define Cluster Profiles” and FileDependencies reference page
in the Parallel Computing Toolbox documentation.

2 Open the pool of MATLAB workers using the user configuration file,
as described in “Apply Cluster Profiles in Client Code” in the Parallel
Computing Toolbox documentation.

Opening the pool allows the remote workers to access the file dependencies
included in the user configuration file.

Specify Model Dependencies
Model dependencies are files, such as referenced models, data files and
S-functions, without which a model cannot run. When you use parallel
computing, Simulink Design Optimization software helps you identify model
path dependencies. To do so, the software uses the Simulink Manifest Tools.
The dependency analysis may not find all the files required by your model.
For example, folder paths that contain code for your model or block callback.
To learn more, see the “Scope of Dependency Analysis” in the Simulink
documentation.

If your model has dependencies that the software cannot detect automatically,
you must add the dependencies before you start the estimation using parallel
computing:

1 Add the path dependencies, as described “Estimate Model Parameters” on
page 2-61 and “How to Use Parallel Computing (Code)” on page 2-132.

2 Add the file dependencies, as described in “Configuring Parallel Computing
on Multiprocessor Networks” on page 2-59.
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Note When you use parallel computing, verify that the remote MATLAB
workers can access all the model dependencies. The optimization errors out if
all the remote workers cannot access all the model dependencies.

Estimate Model Parameters
After you configure your system for parallel computing, as described in
“Configure Your System for Parallel Computing” on page 2-59, you can use
the GUI to estimate the model parameters.

Tip If you want to use functions to estimate parameters using parallel
computing, see “How to Use Parallel Computing (Code)” on page 2-132.

1 Open the Simulink model by typing the model name at the MATLAB
prompt.

2 Configure the model for parameter estimation, as described in “Model
Requirements for Importing Data” on page 1-2.

3 In the Estimation tab of the New Estimation node, click Estimation
Options.
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This action opens the Options - New Estimation dialog box.
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4 In the Parallel Options tab, select the Use the matlabpool during
optimization option.

This action checks for model path dependencies in your Simulink model and
displays the path dependencies in theModel path dependencies list box.

Note As described in “Specify Model Dependencies” on page 2-60,
the automatic path dependencies check may not detect all the path
dependencies in your model.

5 (Optional) Add the path dependencies that the automatic check does not
detect.

a Specify the paths in theModel path dependencies list box.

You can specify the paths separated with a semicolon, or on a new line.
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b Click Apply to include the new paths.

Alternatively, you can click Add path dependency to open a Browse For
Folder dialog box where you can select the folder to add.

6 (Optional) If you modify the Simulink model such that it introduces a new
path dependency, then you must resync the path dependencies. Click Sync
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path dependencies from model in the Parallel Options tab to rerun
the automatic dependency check for your model.

This action updates theModel path dependencies list box with any new
path dependency found in the model.

7 Click OK.

8 In the Estimation tab, click Start to estimate the model parameters using
parallel computing.

9 Examine the values of the estimated parameters in the Value column of
the Parameters tab.

For more information on how to troubleshoot estimation results you
obtained using parallel computing, see “Troubleshooting” on page 2-65.

Troubleshooting

• “Why are the estimation results with and without using parallel computing
different?” on page 2-65

• “Why do I not see the estimation speedup I expected using parallel
computing?” on page 2-66

• “Why does the estimation using parallel computing not make any
progress?” on page 2-67

• “Why do I receive an error "Cannot save model
tpe5468c55_910c_4275_94ef_305e2eeeeef4"?” on page 2-67

• “Why does the estimation using parallel computing not stop when I click
Stop?” on page 2-67

Why are the estimation results with and without using parallel
computing different?
The values of the estimated parameters obtained using parallel computing
may differ from the values obtained without using parallel computing. The
results can be different under the following conditions:

• Different numerical precision on the client and worker machines can
produce marginally different simulation results. Thus, the estimation
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method may take a completely different solution path and produce a
different result.

Note Numerical precision can differ because of different operating systems
or hardware on the client and worker machines.

• The state of the model on the client and the worker machines can differ,
and thus lead to a different result. For example, the state can become
different if you change a parameter value initialized by a callback function
on the client machine after the workers have loaded the model. The model
parameter values on the workers and the client are now out of sync, which
can lead to a different result.

After you change the model parameter values initialized by a callback
function, verify that the parameters exist in the model workspace or
update the callback function so that the remote workers have access to the
changed parameter values.

• When you use parallel computing with the Pattern search method, the
method searches for a candidate solution more comprehensively than when
you do not use parallel computing. This more comprehensive search can
result in a different solution. To learn more, see “Parallel Computing with
the Pattern search Method” on page 2-57.

Why do I not see the estimation speedup I expected using
parallel computing?

• The resulting estimation time may not be faster when you estimate a
small number of model parameters or when the model does not take
long to simulate. In such cases, the overheads associated with creating
and distributing the parallel tasks outweighs the benefits of running the
simulations during estimation in parallel.

• Using Pattern search method with parallel computing may not speed up
the estimation time. When you do not use parallel computing, the method
stops searching for a candidate solution at each iteration as soon as it finds
a solution better than the current solution. The candidate solution search
is more comprehensive when you use parallel computing. Although the
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number of iterations may be larger, the optimization without using parallel
computing is faster.

To learn more about the expected speedup, see “Parallel Computing with
the Pattern search Method” on page 2-57.

Why does the estimation using parallel computing not make
any progress?
In some cases, the gradient computations on the remote worker machines
may silently error out when you use parallel computing. In such cases, the
Estimation progress table shows that the f(x) values do not change, and
the optimization terminates after two iterations.

To troubleshoot the problem:

1 Run the optimization for a few iterations without parallel computing to
see if the optimization progresses.

2 Check if the remote workers have access to all model dependencies. To
learn more, see “Specify Model Dependencies” on page 2-60.

Why do I receive an error "Cannot save model
tpe5468c55_910c_4275_94ef_305e2eeeeef4"?
When you select Refined as the Gradient type, the software may error out
when it saves a temporary model to a nonwriteable folder, and then displays
this error message. Change the Gradient type to Basic to clear this error.
To learn more, see “Selecting Additional Optimization Options” on page 2-29.

Why does the estimation using parallel computing not stop
when I click Stop?
When you use parallel computing, the software has to wait till the current
iteration completes before it notifies the workers to stop the estimation. The
estimation does not terminate immediately when you click Stop, and appears
to continue to run.
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Estimate Initial States

In this section...

“How to Estimate Initial States (GUI)” on page 2-68

“Estimating Initial Conditions for Blocks with External Initial Conditions”
on page 2-71

“Estimate Initial States of a Mass-Spring-Damper System (GUI)” on page
2-71

How to Estimate Initial States (GUI)
You can estimate initial states of Simulink models containing any
blocks, including Simscape™, SimMechanics™, SimPowerSystems™ and
SimHydraulics® blocks. Typically, you estimate only those states whose
values cannot be measured.

Before you estimate initial states, you must have already imported the
estimation data and specified the parameters to estimate. See “Specify
Estimation Data (GUI)” on page 2-3 and “Specify Parameters to Estimate
(GUI)” on page 2-7.

To estimate initial conditions (or initial states) if they are not known:

1 In the Control and Estimation Tools Manager, select the Variables node
in the Workspace tree.

2 Click the Estimated States tab.

3 Click Add to open the Select States dialog box.
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The dialog box shows all states in the model, including:

• States in Simscape, SimMechanics, SimPowerSystems and
SimHydraulics blocks.

• States with unique names, such as Velocity in an integrator block.

• States in model references.
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• States in blocks with vector inputs. For example, an Integrator block
with vector inputs of size 3 and three named states position, velocity
and acceleration:

4 Select the states to estimate, and click OK.

• To select adjacent states, hold the Shift key and click the states.

• To select nonadjacent states, hold the Ctrl key and click the states.

The states selected for estimation now appear in the Estimated States tab.
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Tip

• The Defined in block area of the Estimated States tab shows the
path to the block associated with the state. Click the link to highlight
the block in the model.

• For long state names, move the mouse cursor over the selected state
name in the Selected states area or Name in the Default settings
area to display the full name in a tooltip.

For an example of estimating initial states using the GUI, see “Estimate
Initial States of a Mass-Spring-Damper System (GUI)” on page 2-71.

Estimating Initial Conditions for Blocks with External
Initial Conditions
When an integrator block uses an initial-condition port, which you specify by
an IC block, you cannot estimate the initial conditions (ICs) of the integrator
using Simulink Design Optimization software. Estimation is not possible
because external ICs have priority over the ICs of a specific block to maintain
the integrity of the model.

To tune the ICs of an integrator block with external ICs, you must modify the
model to make the external signal into a tunable parameter. For example,
you can set the IC block that feeds into the integrator to be a tunable variable
and estimate it.

Estimate Initial States of a Mass-Spring-Damper
System (GUI)

• “Loading the Example” on page 2-72

• “Model Parameters” on page 2-73

• “Setting Up the Estimation Project” on page 2-74

• “Importing Transient Data and Selecting Parameters for Estimation” on
page 2-75
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• “Selecting Parameters and Initial Conditions for Estimation” on page 2-77

• “Creating the Estimation Task” on page 2-78

• “Running the Estimation and Viewing Results” on page 2-80

Loading the Example
To open the Simulink model of a mass-spring-damper system, type:

msd_system

at the MATLAB prompt.

This action also loads the two sets of measured data with differing initial
conditions.
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You can also run the Initial State Estimation demo that shows how to
estimate parameters and initial states. This example goes beyond the demo
by providing in-depth discussion of each task.

Model Parameters
The output of the Simulink model, msd_system, is the position of the mass in
a mass-spring-damper system. The model is subject to a constant force F, and
an initial condition, x0, for the mass displacement. x0 is the initial condition
of the integrator block, Position.

The model parameters of interest are the mass, m, the viscous damping, b,
and the spring constant, k. For more information about physical modeling of
mass-spring-damper systems, see any book on mathematical modeling or on
automatic control systems.

For estimating the model parameters m, b, and k, this model uses two
experimental data sets. The data sets contain output data measured using
two different initial positions, x0=0.1 and x0=0.3, and additive noise.

Click to run a simulation. The simulation generates the following plots,
as shown in the next figure:

• Simulated response of the model for x0=-0.1 and parameter values, m=8,
k=500, and b=100

• Experimental data sets
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Setting Up the Estimation Project
To set up the estimation of initial conditions and then transient state space
data, select Tools > Parameter Estimation in the msd_system model
window.
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Importing Transient Data and Selecting Parameters for
Estimation
To import data for initial state estimation:

1 In the Control and Estimation Tools Manager, select Transient Data
under the Estimation Task node.

2 Right-click Transient Data, and select New to create a New Data node.

3 Select New Data under the Transient Data node.

4 In the Output Data tab of the New Data node, select the Data column
of msd_system/Position, and click Import. The Data Import dialog box
opens.

Select yexp1, and click Import to assign the data yexp1 to the model.

2-75



2 Parameter Estimation

5 In the Output Data pane, select the Time/Ts column of
msd_system/Position. In the Data Import dialog box, select texp1, and
click Import to assign the time vector texp1 to the model.

6 Right-click New Data in the Workspace tree, and rename it to Data
set #1.

7 Repeat steps 2–5 to add a second data set, yexp2 and texp2. Rename the
data set to Data set #2.

The Control and Estimation Tools Manager GUI now resembles the next
figure.

For more information on importing data, see “Import Data (GUI)” on page 1-4.
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Selecting Parameters and Initial Conditions for Estimation
To select the parameters and initial states you want to estimate for the
Simulink model msd_system:

1 Select the Variables node in the Workspace tree of the Control and
Estimation Tools Manager GUI.

2 In the Estimated Parameters pane, click Add to open the Select
Parameters dialog box.

3 Select the parameters b, k, and m, and then click OK. The selected
parameters now appear in the Selected parameters area of the
Estimated Parameters pane.

4 In the Estimated States pane, click Add.

The Select States dialog box opens, which displays all the available states
of the msd_system model. Select msd_system/Position, and click OK.
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Note For states that you do not estimate, the software uses the initial
condition value specified in the Simulink model. In this example, the value
of initial velocity, as specified in the model is 0.

The selected state appears in the Selected states area of the Estimated
States pane, as shown in the next figure.

For more information on selecting parameters to estimate, see “Specify
Parameters to Estimate (GUI)” on page 2-7.

Creating the Estimation Task
To create an estimation task in the Control and Estimation Tools Manager
GUI, select the Estimation node in the Workspace tree, and click New.
This action creates a New Estimation node.
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In the New Estimation node, select the following check boxes:

• Data Set #1 and Data Set #2 in the Data Sets pane.

• Estimate for b, k, and m in the Parameters pane.

• Estimate for Position in the States pane. Make sure to select this check
box for both Data Set #1 and Data Set #2 to estimate the initial position
for the spring.

Although the initial positions for the two data sets differ, specify the initial
state guesses for both data sets as -0.1. The Control and Estimation Tools
Manager GUI now resembles the following figure.
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Running the Estimation and Viewing Results
Click Start in the Estimation pane to run the estimation.

As the estimation proceeds, the most current estimation of the position
response (yellow curve) updates in the Scope. The curve toggles between
the two experimental data sets because the software uses the two data sets
successively to update the estimates of the parameter values. The software
converges to the correct parameter values, within the scope of experimental
noise and optimization options settings. The closeness of the estimated
response (yellow) to the experimental data (magenta) indicates that simulated
data is a good match to the measured data.

View the initial position estimates for Data Set #1 and Data Set #2 in the
Value column of the States tab. The estimated values match closely with
the known values, 0.1 and 0.3 of initial position.
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View the estimated parameter values in the Value column of the Parameters
tab.

The estimation of initial states is important for obtaining the correct
estimates of the model parameters. You do not set the initial states (x0 in this
case) as parameters because the initial states do not represent fixed physical
properties of the system. For different experimental data or operating
conditions, these states need not be unique.

In this example, you use two data sets with distinct initial positions together
for a single estimation of model parameters. While the estimates of the
model parameters are unique, the initial state (position) is different, and you
estimate them individually for each data set.
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Estimation Projects

In this section...

“Structure of an Estimation Project” on page 2-82

“Managing Multiple Projects and Tasks” on page 2-83

“Adding, Deleting and Renaming an Estimation Project” on page 2-84

“Saving Control and Estimation Tools Manager Projects” on page 2-85

“Loading Control and Estimation Tools Manager Projects” on page 2-86

Structure of an Estimation Project
The Control and Estimation Tools Manager, which is a graphical user
interface (GUI) for performing parameter estimation, stores and organizes all
data from a given Simulink model inside a project. To open the Control and
Estimation Tools Manager GUI, select Tools > Parameter Estimation in
the Simulink model window.

When using the Control and Estimation Tools Manager for parameter
estimation, you can

• Manage estimation projects.

• Select parameters and initial conditions to configure the estimation.

• Specify cost functions.

• Import experimental data (to be matched by the output of your Simulink
model).

• Specify the initial conditions of your model.

Each estimation task can include

• One or more data sets

• Parameter information

• One or more sets of estimation settings, or configurations
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The default project name is the same as the Simulink model name. The
project name is shown in the Workspace tree of the Control and Estimation
Tools Manager.

You can also add tasks from Simulink Control Design™ and Model Predictive
Control Toolbox™ software to the current project, if these products are
installed on your system.

Managing Multiple Projects and Tasks
The Control and Estimation Tools Manager works seamlessly with products
in the Controls and Estimation family. In particular, if you have licenses for
Simulink Control Design or Model Predictive Control Toolbox software, you
can use these products to perform tasks on projects that you have created in
Simulink Design Optimization software, and vice versa.

This figure shows a tools manager with multiple projects and multiple tasks.
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You can save projects individually, or group multiple projects together in
one saved file, as described in:

• “Saving Control and Estimation Tools Manager Projects” on page 2-85

• “Loading Control and Estimation Tools Manager Projects” on page 2-86

Adding, Deleting and Renaming an Estimation Project
To add, delete, or rename the project or task:

1 Right-click the project or task node in the Workspace tree.

2 Select the appropriate command from the shortcut menu.
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Saving Control and Estimation Tools Manager
Projects
A Control and Estimation Tools Manager project can consist of tasks from
products such as Simulink Control Design, Simulink Design Optimization,
and Model Predictive Control Toolbox software. Each task contains data,
objects, and results for the analysis of a particular model.

To save your project as a MAT-file, select File > Save in the Control and
Estimation Tools Manager window.

To save multiple projects within one file:

1 In the Save Projects dialog box, select the projects that you want to save.

2 Click OK.

3 Choose a folder and name for your project file by either browsing for a file
or typing the full path and filename in the Save as field. Click Save.
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Loading Control and Estimation Tools Manager
Projects
To open previously saved projects, select File > Load in the Control and
Estimation Tools Manager window.

In the Load Projects dialog box, choose a project file by either browsing for
the folder and file, or by typing the full path and filename in the Load from
field. Project files are always MAT-files. The projects within this file appear
in the Projects list.

Select the projects that you want to load, then click OK. When a file contains
multiple projects, you can choose to load them all or just a few.
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Estimate Parameters (Code)

In this section...

“How to Estimate Parameters (Code)” on page 2-87

“F14 Parameters and Initial State Estimation (Code)” on page 2-89

“RC Circuit Parameters and Initial State Estimation (Code)” on page 2-100

“Parameter Estimation Objects” on page 2-105

“Creating Transient Experiment Data Objects” on page 2-106

“Creating Estimation Objects” on page 2-109

“Parameter Objects” on page 2-117

“State Objects” on page 2-120

“Transient Data Objects” on page 2-123

“State Data Objects” on page 2-129

“How to Use Parallel Computing (Code)” on page 2-132

How to Estimate Parameters (Code)
In addition to the Control and Estimation Tools Manager GUI, you can
also use Simulink Design Optimization commands to perform parameter
and state estimation. You can perform the same tasks as the Control and
Estimation Tools Manager using these commands but have the advantages
of command-line execution.

When you perform a state or parameter estimation using the GUI, the
software creates MATLAB objects for all the states and parameters in your
model. If you have a large number of states or parameters, this can use
up large amounts of memory and cause computational delays. With the
command-line approach, only those states and parameters that you select are
assigned MATLAB objects, which is more efficient.

The command-line approach is also useful for batch jobs where you can
estimate parameters for a large numbers of models.
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Simulink Design Optimization software uses MATLAB objects to perform
estimation tasks. To learn more about object-oriented programming in
MATLAB, see Object-Oriented Programming.

To perform estimation using the command-line interface:

1 Open a Simulink model.

Note The Simulink model must contain a fixed signal input block, an
Inport block, Outport block, or logged signals to enable assigning data to
the signals. For more information, see “Model Requirements for Importing
Data” on page 1-2.

2 Define experiments containing empirical data sets, operating conditions
and initial states of your model.

3 Create an estimation object.

4 Specify parameters to estimate.

5 (Optional) Specify states to estimate.

6 Perform the estimation.

7 Review the results and refine the parameters iteratively.

8 Validate estimation results.

Note The Simulink model must remain open to perform parameter
estimation tasks.

For more information, see:

• “F14 Parameters and Initial State Estimation (Code)” on page 2-89

• “RC Circuit Parameters and Initial State Estimation (Code)” on page 2-100

• “Parameter Estimation Objects” on page 2-105
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F14 Parameters and Initial State Estimation (Code)

• “Objectives” on page 2-89

• “Data Description” on page 2-89

• “Opening the F14 Aircraft Model” on page 2-90

• “Baseline Simulation” on page 2-91

• “Specifying Experimental Data” on page 2-93

• “Specifying Parameters and States to Estimate” on page 2-94

• “Running the Estimation” on page 2-96

• “Viewing Estimated Parameter and State Values” on page 2-97

• “Rerunning the Estimation Using Estimated Parameter Values” on page
2-99

• “Saving and Loading the Estimation Results” on page 2-99

Objectives
This example shows how to estimate model parameters and states using
Simulink Design Optimization objects and commands. To learn more about
the parameter estimation objects and their properties and methods, see
“Parameter Estimation Objects” on page 2-105.

In this example, you estimate the following parameters and state of a F14
aircraft.

Parameters State

• Actuator time constant Ta

• Vertical velocity Zd

• Pitch rate gains Md

f14/Actuator Model

Data Description
The f14_estim.mat file contains the following variables:

• time — Time vector.
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• iodata— Single-input multi-output data measured for:

- A square wave input applied to the stick.

- Pilot G force output

- Angle of attack output

Opening the F14 Aircraft Model
Open the f14 Simulink model by typing the model name at the MATLAB
prompt:

f14

The model opens, as shown in the following figure.
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F14 Fighter Jet Model

The command also loads the estimation data iodata into the MATLAB
workspace.

Baseline Simulation
Before performing an estimation, run a baseline simulation to compare the
simulated response with initial parameter values and the measured data.

%% Load experimental data.
load f14_estim

%% Initialize unknown parameters.
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% Actuator time constant (ideal Ta=0.05)
Ta = 0.5;
% Aircraft dynamic model parameters (ideal Md=-6.8847,Zd=-63.998)
Md = -1; Zd = -80;

%% Plot measured data and simulation results.
[T,X,Y] = sim('f14', time, [], [time iodata(:,1)]);
plot(time, iodata(:,2:3), T, Y, '-');
legend( 'Measured angle of attack', 'Measured pilot g force', ...

'Simulated angle of attack', 'Simulated pilot g force');

See the sim reference page for information on how to simulate models from
the MATLAB prompt.

The measured and simulated outputs are a poor match, as shown in the
following figure.
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Next, you estimate values of the model parameters Ta, Zd, and Md to obtain a
better match between the simulated and measured responses.

Specifying Experimental Data
To specify experimental data for parameter estimation:

1 Create a TransientExperiment object using the constructor syntax:

exp_data = ParameterEstimator.TransientExperiment('f14')

This command returns the following information about the f14 model.

Experimental transient data set for the model 'f14':

Output Data
(1) f14/alpha (rad)
(2) f14/Nz Pilot (g)

Input Data
(1) f14/u

Initial States
(1) f14/Actuator Model
(2) f14/Aircraft Dynamics Model/Transfer Fcn.1
(3) f14/Aircraft Dynamics Model/Transfer Fcn.2
(4) f14/Controller/Alpha-sensor Low-pass Filter
(5) f14/Controller/Pitch Rate Lead Filter
(6) f14/Controller/Proportional plus integral compensator
(7) f14/Controller/Stick Prefilter
(8) f14/Dryden Wind Gust Models/Q-gust model
(9) f14/Dryden Wind Gust Models/W-gust model

2 Assign the experimental I/O data in iodata to the Transient Experiment
object.

%% Assign input data.
set(exp_data.InputData(1), 'Data', iodata(:,1), 'Time', time);

% Assign output data.
set(exp_data.OutputData(1), 'Data', iodata(:,2), 'Time', ...
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time, 'Weight', 5);
set(exp_data.OutputData(2), 'Data', iodata(:,3), 'Time', time);

Note For multi-input, multi-output models:

• Assign separate data object to each input and output port. The data object
can be a vector or matrix that corresponds to that channel.

• Use multiple inport or outport blocks to represent multiple channels.

Specifying Parameters and States to Estimate
To specify parameters and states to estimate:

1 Create an Estimation object.

est = ParameterEstimator.Estimation('f14');

This command creates objects for all parameters and states in the model.
To view the properties of est, type:

get(est)

To view the parameter objects, type:

est.Parameters

To view the state objects, type:

est.States

2 Specify the model parameters Ta, Zd and Md to estimate. These parameters
are located in the F14 aircraft dynamics subsystem.
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% Select Md.
est.Parameters(5).Estimated = true;
% Specify minimum and maximum values.
set(est.Parameters(5), 'Minimum', -10, 'Maximum', 0);

% Select Ta.
est.Parameters(9).Estimated = true;
% Specify minimum and maximum values.
set(est.Parameters(9), 'Minimum', 0.01, 'Maximum', 1);

% Select Zd.
est.Parameters(16).Estimated = true;
% Specify minimum and maximum values.
set(est.Parameters(16), 'Minimum', -100, 'Maximum', 0);
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3 Specify the f14//Actuator Model state to estimate.

% Select the state.
est.States(1).Estimated = true;
% Specify the minimum value of the state.
set(est.States(1), 'Minimum', -1,'Maximum',+1);

Running the Estimation
To run the estimation:

1 Specify the experimental data for the estimation:

est.Experiments = exp_data;

2 Estimate the model parameters and initial state:

% Display the estimation iterations.
est.OptimOptions.Display ='iter';
% Estimate parameters and state.
est.estimate

The estimation runs for a few iterations. After the estimation completes, plot
the measured and simulated responses.

%% Plot measured data and final simulation responses.
[T,X,Y] = sim('f14', time, [], [time iodata(:,1)]);
figure
plot(time, iodata(:,2:3), T, Y, '-');
legend( 'Measured angle of attack', 'Measured pilot g force', ...

'Simulated angle of attack', 'Simulated pilot g force');

The measured and simulated outputs now closely match, as shown in the
following figure.
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Viewing Estimated Parameter and State Values

1 To view the estimated parameter values for comparison with the default
values, extract the values from the Estimation object. For example:

% Extract Md.
MdValue = est.Parameters(5).Value

% Extract Ta.
TaValue = est.Parameters(9).Value

% Extract Zd.
ZdValue = est.Parameters(16).Value

These command returns the following results:

MdValue =

2-97



2 Parameter Estimation

-6.8869

TaValue =

0.0501

ZdValue =

-64.0356

2 To view the estimated initial state value, type:

% Extract initial state value.
stateValue = est.State(1)

This command returns the following result:

(1) State data for f14/Actuator Model:
The block has 1 continuous state(s).

State value : 6.977e-006
Initial guess : 0

Estimated : true

You can verify that these values match the default values of the f14 model by
clearing your workspace, loading the model, and checking the values.

clear all
f14
whos
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Note You can use find to identify scalar, vector, or matrix parameters.
The dimensions of the Estimated value must match the dimensions of the
parameters you are trying to find. For example, find only scalar estimated
parameters by typing:

find(est.Parameters, 'Estimated', true)

To find only vector estimated parameters with dimensions 1-by-2, type:

find(est.Parameters, 'Estimated', [true;true])

Rerunning the Estimation Using Estimated Parameter Values
If the measured and simulated responses are not a good match after
estimation, you can rerun the estimation using the estimated parameter
values as initial parameter values.

% Extract all estimated parameter values and assign them
% as initial guesses.
for k=1:length(est.Parameters)

if (est.Parameters(k).Estimated == true)
est.Parameters(k).InitialGuess = est.Parameters(k).Value;

end
end

% Restart the estimation using results from previous estimation.
est.estimate;

Saving and Loading the Estimation Results
You can save the estimation results as a MAT-file by typing:

save filename est

You can specify any value for filename— including a folder path — provided
the filename is supported by your operating system.

To load the file, type:
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load filename

which loads est into the MATLAB workspace.

RC Circuit Parameters and Initial State Estimation
(Code)
In this example, you estimate the capacitance value C1 of an RC circuit
modeled in Simulink software using Simscape blocks.

The sldo_rc_circuit.mat file contains experimental I/O data and includes
the following variables:

• data — Voltage across the capacitor when an input of 5V is applied to
the RC circuit

• time — Time vector

To estimate the model parameter (C1) and state (initial capacitor voltage):

1 Open the Simulink model.

model = 'sldo_rc_circuit';
open_system(model)

The following model opens.
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2 Perform a baseline simulation to compare the simulated model response
with initial parameter values and measured data.

% Load experimental data.
load sldo_rc_circuit.mat

% Simulate model and compare response with experimental data.
SimOut = sim(model, 'ReturnWorkspaceOutputs', 'on');
plot(time,data,'ro', SimOut.find('tout'),SimOut.find('yout'),'b')
legend('Measured Voltage', 'Simulated Voltage')

The measured and simulated voltages do not match, as shown in the
following figure.
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3 Create a Transient Experiment object, and assign the I/O data.

% Create data container for the experimental data.
experiment = ParameterEstimator.TransientExperiment(model);
experiment.Description = 'Response to 5V DC voltage';

% Specify measured output data for output voltage accross
% the capacitor.
experiment.OutputData(1).Data = data;

% Specify the time vector.
experiment.OutputData(1).Time = time;

4 Create an Estimation object for the model.

est = ParameterEstimator.Estimation(model);

This command also creates Parameter and State objects for estimation.

2-102



Estimate Parameters (Code)

5 Specify the experimental data to use for this estimation.

est.Experiments = experiment;

6 Estimate the model parameter C1.

a Specify the parameter to estimate.

% Specify the parameter to estimate.
est.Parameters(1).Estimated = true;
% Specify initial guess C1 = 470uF.
est.Parameters(1).InitialGuess = 470e-6;

b Estimate the parameter.

est.OptimOptions.Display = 'iter';
est.estimate

To view the estimated parameter value, type:

est.Parameters(1).Value

7 Simulate the model with the estimated parameters to see how well it
matches the measured data.

SimOut = sim(model, 'ReturnWorkspaceOutputs', 'on');
plot(time,data,'ro', SimOut.find('tout'),SimOut.find('yout'),'b')
legend('Measured Voltage', 'Simulated Voltage')

The measured and simulated voltages match, as shown in the following
figure. Because the software uses the initial capacitor voltage specified
in the model during estimation, the initial voltage does not match the
measured data.
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Next, you estimate the initial capacitor voltage together with the capacitor
value.

8 Estimate the capacitance value together with the initial capacitor voltage.

a Specify initial state (initial capacitor voltage) to estimate.

% Specify initial state to estimate.
est.States(1).Estimated = true;
% Initial guess for C1 voltage 1V
est.States(1).InitialGuess = 1.0;

b Estimate initial state and model parameter.

est.estimate

9 Simulate the model to verify how well the simulated response using the
estimated initial state and parameter matches the measured data.

a Assign initial state value to Simulink state structure before simulation.
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x0 = Simulink.BlockDiagram.getInitialState(model);
x0.signals(1).values = est.States(1).Value;

b Simulate the model.

SimOut = sim(model, 'LoadInitialState','on', 'InitialState','x0');
plot(time,data,'ro', SimOut.find('tout'),SimOut.find('yout'),'b')

The simulated voltage now accounts for the initial capacitor voltage,
as shown in the following figure.

Parameter Estimation Objects
The following sections describe how to create and modify parameter
estimation objects:

• “Creating Transient Experiment Data Objects” on page 2-106

• “Creating Estimation Objects” on page 2-109
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• “Parameter Objects” on page 2-117

• “State Objects” on page 2-120

• “Transient Data Objects” on page 2-123

• “State Data Objects” on page 2-129

First, a quick look at terminology:

• Objects are instantiations of classes.

• Classes define properties and methods. Classes can be grouped in a parent
folder called the package folder.

• You use a constructor to create an object, and use the set method or dot
notation to modify the properties of your objects.

For more information, see Object-Oriented Programming in the MATLAB
documentation.

Creating Transient Experiment Data Objects

• “What is a Transient Experiment Object?” on page 2-106

• “Constructor” on page 2-107

• “Properties” on page 2-107

• “Example: Creating a Transient Experiment Object” on page 2-107

• “Example: Creating an Experiment Object Using Transient Data and State
Data Objects” on page 2-108

• “Modifying Properties” on page 2-109

• “Methods” on page 2-109

What is a Transient Experiment Object?
The TransientExperiment object encapsulates the data measured at the
input and output ports of a system during a single experiment, as well as the
system’s known initial states. This object belongs to the ParameterEstimator
package.
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Note Creating a TransientExperiment object automatically creates
TransientData and StateData objects.

Constructor
The syntax to create a TransientExperiment object is:

exp = ParameterEstimator.TransientExperiment('model');

where model specifies the name of the Simulink model.

Properties
Model Simulink model with which this experiment is

associated.

InputData,
OutputData

TransientData objects associated with appropriate I/O
blocks in the model. Blocks with unassigned objects
or objects with no data are not used in estimations,
meaning:

• For input ports, assign zeros to these ports/channels
during simulation.

• For output ports, don’t use these ports/channels in
the cost function.

InitialStates StateData objects associated with dynamic blocks in
the model.

InitFcn Function to configure the model for this particular
experiment.

Example: Creating a Transient Experiment Object
To create an empty TransientExperiment for the f14 model:

% Open the model.
f14;
% Create the transient experiment object.
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exp1 = ParameterEstimator.TransientExperiment('f14')

The TransientExperiment object is shown as follows:

Experimental transient data set for the model 'f14':

Output Data
(1) f14/alpha (rad)
(2) f14/Nz Pilot (g)

Input Data
(1) f14/u

Initial States
(1) f14/Actuator Model
(2) f14/Aircraft Dynamics Model/Transfer Fcn.1
(3) f14/Aircraft Dynamics Model/Transfer Fcn.2
(4) f14/Controller/Alpha-sensor Low-pass Filter
(5) f14/Controller/Pitch Rate Lead Filter
(6) f14/Controller/Proportional plus integral compensator
(7) f14/Controller/Stick Prefilter
(8) f14/Dryden Wind Gust Models/Q-gust model
(9) f14/Dryden Wind Gust Models/W-gust model

The Input Data and Output Data are TransientData object. The Initial
States are StateData objects.

Example: Creating an Experiment Object Using Transient Data
and State Data Objects
To create a transient experiment from TransientData objects for I/Os and
StateData objects for states:

% Open the model.
vdp;

% Create transient data object for the output data.
out1 = ParameterEstimator.TransientData('vdp/Out1');

% Create state data object for the initial state.
ic1 = ParameterEstimator.StateData('vdp/x1');
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% Create an experiment using the previously-defined objects.
exp1 = ParameterEstimator.TransientExperiment...
(gcs, [], out1, ic1)

The TransientExperiment object is shown as follows:

Experimental transient data set for the model 'vdp':

Output Data
(1) vdp/Out1

Input Data
(none)

Initial States
(1) vdp/x1

Modifying Properties
The objects in InputData, OutputData, and InitialStates properties can
be modified or removed as necessary. For example, to modify the InputData
and StateData properties of the TransientExperiment object created in
“Example: Creating a Transient Experiment Object” on page 2-107, type:

exp1.InputData(1).Data = [10 20 30]
exp1.InputData(1).Time = [1 2 3]
exp1.InitialStates(1).Data = 0.3

Methods

update Updates the object after the Simulink model has been
modified. The objects in the InputData, OutputData,
and InitialStates properties are also updated.

Creating Estimation Objects

• “What is an Estimation Object?” on page 2-110
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• “Constructor” on page 2-110

• “Properties” on page 2-111

• “Example: Creating an Estimation Object” on page 2-115

• “Example: Estimating Parameters and States” on page 2-115

• “Modifying Properties” on page 2-116

• “Methods” on page 2-116

What is an Estimation Object?
The Estimation object defines the estimation problem, and is the coordinator
between the model, experiments, parameter objects, and state objects. This
object belongs to the ParameterEstimator package.

Note Creating an Estimation object automatically creates Parameter and
State objects.

Constructor
The syntax to create an estimation object is:

est = ParameterEstimator.Estimation('model');

Alternatively, you can create Parameter and TransientExperiment objects
first and use them construct an Estimation object using one of the following
syntaxes:

est = ParameterEstimator.Estimation('model', hParam);
est = ParameterEstimator.Estimation('model', hParam, hExps);

hParam is an array of Parameter objects and hExps is an array of
TransientExperiment objects.
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Properties

Model Name of the Simulink model associated with this
estimation.

Experiments Experiments to be used in estimations. For multiple
experiments, the cost function uses a concatenation of the
output error vectors obtained using each experimental
data set.

Parameters Parameters objects to be used in estimations.

States States objects to be used in estimations. This is a handle
matrix with as many columns as there are experiments,
and as many rows as there are states in Model.
The handle matrix is created automatically in the
constructor. You can reorganize its rows to specify shared
states between experiments, and set the Estimated flag
of desired states.
If state data is provided in an experiment, the state
objects stored in the columns of this matrix are initialized
from the experiments.

SimOptions Same as simset structure. This property is initialized to
simget(this.Model).

OptimOptions Estimation options. Has the following fields:

Property Description Possible Settings

Method Optimization solver. The
following solvers are
available:
• lsqnonlin —
Optimization Toolbox
function lsqnonlin

• fmincon —
Optimization Toolbox
function fmincon

• patternsearch —
Global Optimization

{'lsqnonlin'}
| 'fmincon' |
'patternsearch'
| 'fminsearch'
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Toolbox function
patternsearch

• fminsearch —
Optimization Toolbox
function fminsearch

Algorithm The algorithm used by
the optimization method.

For fmincon
optimization method:

• {'active-set'}

• 'trust-region-reflective'

• 'interior-point'

Display The level of information
that the optimization
displays:
• off— No output

• iter — Output at
each iteration

• final— Final output
only

• notify—Output only
if the function does
not converge

'off' | {'iter'} |
'final' | 'notify'

GradientType Method used to calculate
gradients. Use one
of the following finite
difference methods for
gradient calculation:
• basic — Default
method for computing
the gradients

• refined — Offers
a more robust and
less noisy gradient
calculation method
than 'basic'

{'basic'} |
'refined'
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The refined method
is sometimes more
expensive, and does
not work with certain
models such as
SimPowerSystems
models.

MaxIter Maximum number of
iterations allowed

Positive integer

TolFun Termination tolerance
on the function value

Positive scalar

TolX Termination tolerance
on the parameter values

Positive scalar

UseParallel Parallel computing
option for the following
optimization methods:
• lsqnonlin

• fmincon

• patternsearch

Note Parallel
Computing Toolbox
software must be
installed to enable
parallel computing
for the optimization
methods.

When set to 'always',
the methods compute the
following in parallel:

• lsqnonlin and
fmincon — Compute

'always' |
{'never'}
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finite difference
gradients

• patternsearch —
Performs population
evaluation

Disable the option by
setting to 'never'.

ParallelPathDependenciesOption to store model
path dependencies when
using parallel computing

Cell array of strings

SearchMethod Search options for use
with the patternsearch
method

See “Search Options”
in the Global
Optimization Toolbox
documentation.

CostType Cost function that the
optimization solver
attempts to minimize.

'SAE' | {'SSE'}

DiffMaxChange Maximum change
in variables for
finite-difference
gradients

Positive scalar

DiffMinChange Minimum change
in variables for
finite-difference
gradients

Positive scalar

MaxFunEvals Maximum number of
function evaluations
allowed

Positive integer

RobustCost Use a robust cost
function instead of
the default least-squares
cost. Useful if the
experimental data has
many outliers, or if your
data is noisy.

'on' | {'off'}
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EstimInfo This property is used to store estimation-related
information at each iteration of the optimizer, and is
initialized as

this.EstimInfo = struct( 'Cost', [],...
'Covariance', [],...
'FCount', [],...
'FirstOrd', [],...
'Gradient', [],...
'Iteration', [],...
'Procedure', [],...
'StepSize', [],...
'Values', [] );

Example: Creating an Estimation Object
To create an estimation object for the f14 model:

% Open the model, if it is not already open.
f14;
% Create estimation object.
est1 = ParameterEstimator.Estimation(gcs)

This command returns the following result:

Estimated variables for the model 'f14':

Estimated Parameters

Using Experiments
(none)

Example: Estimating Parameters and States
Estimate the parameters Ta and Kf and states of the f14 model:

% Open the model, if it is not already open.
f14;
% Define experiments.
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exp1 = ParameterEstimator.TransientExperiment(gcs);
% Create estimation object and assign experimental data.
est1 = ParameterEstimator.Estimation(gcs, [], exp1);
% Specify parameters to estimate.
est1.Parameters(2).Estimated = true;
est.Parameters(9).Estimated = true;
% Specify states to estimate.
est1.States(1).Estimated = true;
% Estimate parameters and states.
est1.estimate;

Modifying Properties
After an estimation object is created, you can modify its properties using
this syntax:

est.OptimOptions.Method = 'fmincon'; % Estimation method
est.OptimOptions.Display = 'iter'; % Show estimation information
...in workspace
est.Parameters(1).Estimated = false; % Do not estimate first
...parameter
est.States(2,3).Estimated = false; % Do not estimate second state
...of third expression

Methods

compare Compare an experiment and a simulation.

simulate Simulate the model with current parameters and
states.

estimate Run an estimation.

update Update the estimation object after the Simulink
model has been modified.
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Parameter Objects

• “What is a Parameter Object?” on page 2-117

• “Constructor” on page 2-117

• “Properties” on page 2-118

• “Example: Creating a Parameter Object Automatically” on page 2-119

• “Modifying Properties” on page 2-119

• “Methods” on page 2-120

What is a Parameter Object?
The Parameter object refers to the parameters of the Simulink model.
This object also stores information such as whether the parameter is to be
estimated, initial values, current values, and ranges. This object belongs to
the ParameterEstimator package.

One Parameter object corresponds to each parameter in the Simulink model.
These objects represent parameters represented as scalars, vectors, and
multidimensional arrays.

Constructor
Creating an Estimation object automatically creates Parameter objects
corresponding to each model parameter.

If your model has a large number of parameters, constructing a Parameter
object manually for each parameter that you want to estimate makes handling
of the objects more manageable. For an example, see the F14 Parameter
Estimation at the Command Line demo.

To manually construct a Parameter object, type one of the following syntaxes:

h = ParameterEstimator.Parameter('Name');
h = ParameterEstimator.Parameter('Name', Value);
h = ParameterEstimator.Parameter('Name', Value, Minimum,

Maximum);
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Properties

Name Parameter name. The parameter can be a
multidimensional array of any size.

Dimensions Dimensions of the value of the parameter. This
is the defining property for the size of other
properties.

Value The current or estimated value of the parameter.
This is the defining property for size checking
and scalar expansions.

Estimated A Boolean array of the same size as that of
Value. Depending on the value of the elements
of the Estimated property, the behavior of the
corresponding elements of Value is as follows:

• The elements of Value is estimated if the
corresponding elements in Estimate are set to
true. The result is stored in the Value property.

• The elements of Value are not estimated if the
corresponding elements in Estimated are set
to false. However, these elements are used to
reset the corresponding workspace parameter
during estimations.

This property is set to false by default, meaning
that the parameter value is not estimated.

InitialGuess Separate properties are required to hold the
initial and current values of the parameters. So,
when the InitialGuess property is initialized
with a value, both it and the Value property are
assigned the same value.

Depending on the value of the elements of
the Estimated property, the behavior of the
corresponding elements of InitialGuess is as
follows:

• If any element in Estimated is set to true, then
the corresponding element of InitialGuess
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is used to initialize the workspace parameter
during estimations.

• If any element in Estimated is set to false, then
the corresponding element of InitialGuess is
not used in any way.

Minimum, Maximum Parameter range.

TypicalValue The typical values of the parameters. This
property is used in estimations for scaling
purposes. The default value is 1.

Example: Creating a Parameter Object Automatically
To automatically create parameter objects for the f14 model:

% Open the model.
f14;
% Create an estimation object.
est = ParameterEstimator.Estimation('f14')

To view the parameter objects:

est.Parameters

To view the value of a parameter:

est.Parameters(1).Value

Modifying Properties
After a parameter object is created, you can modify its properties. For
example:

par1.Estimated = true; % Estimate this parameter

Most of the properties, for example, Estimated and TypicalValue support
scalar expansion with respect to the size of Value.
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Methods

hiliteBlock Highlights the referenced blocks associated with
parameter objects in the Simulink diagram.

update Updates the parameter object after the Simulink
model has been modified. If the size of the Value
property changes, then the other properties are
reset to their default values.

State Objects

• “What is a State Object?” on page 2-120

• “Constructor” on page 2-120

• “Properties” on page 2-121

• “Example: Creating a State Object Automatically” on page 2-122

• “Modifying Properties” on page 2-123

• “Methods” on page 2-123

What is a State Object?
The State object is similar to the Parameter object, and refers to the states of
the Simulink model. This object belongs to the ParameterEstimator package.

One State object corresponds to each block with states in the model.

Constructor
Creating an Estimation object automatically creates State objects.

If your model has a large number of states, constructing a State object
manually for each state that you want to estimate makes handling of the
objects more manageable. For an example, see the F14 Parameter Estimation
at the Command Line demo.

To manually construct a State object, type one of the following syntaxes:
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h = ParameterEstimator.State('block');
h = ParameterEstimator.State('block', Value);
h = ParameterEstimator.State('block', Value, Minimum,

Maximum);

Properties

Block Name of the Simulink block whose states are
defined by this object.

StateName Name of a state. This property shows a state name
if your model has:
• Blocks, such as integrators, containing states
with unique names

• Blocks from Simscape, SimMechanics,
SimPowerSystems and SimHydraulics software

Dimensions Scalar value to store the number of states of the
relevant block.

Value Column vector to store the value of the state for the
block specified by this object. The length of this
vector should be consistent with the Dimensions
property.

Estimated A Boolean array of the same size as that of
Value. Depending on the value of the elements
of the Estimated property, the behavior of the
corresponding elements of Value is as follows:

• The elements of Value are estimated if the
corresponding elements in Estimate are set to
true. The result is stored in the Value property.

• The elements of Value are not estimated if the
corresponding elements in Estimated are set to
false. However, these elements are used to reset
the corresponding states during estimations.

This property is set to false by default, meaning
that the state value is not estimated.
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InitialGuess Separate properties are required to hold the initial
and current values of the states. So, when the
InitialGuess property is initialized with a value,
both it and the Value property are assigned the
same value.
Depending on the value of the elements of
the Estimated property, the behavior of the
corresponding elements of InitialGuess is as
follows:

• If any element in Estimated is set to true, then
the corresponding element of InitialGuess is
used to initialize the state during estimations.

• If any element in Estimated is set to false, then
the corresponding element of InitialGuess is
not used in any way.

Minimum, Maximum State vector range.

TypicalValue The typical values of the states. This property
is used in estimations for scaling purposes. The
default value is 1.

Ts Sampling time of discrete blocks. Set to zero for
continuous blocks. This property is read-only and is
currently used for information only.

Example: Creating a State Object Automatically
To create a state objects for all blocks with states in the f14 model:

% Open the model.
f14;
% Create an estimation object.
est = ParameterEstimator.Estimation('f14')

To view the state objects:

est.States

To view the value of a state:
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est.States(1).Value

Modifying Properties
After a state object is created, you can modify its properties using this syntax:

est.States(1).Estimated = true; % Estimate this state

Most of the properties, for example, Estimated and TypicalValue, support
scalar expansion with respect to the size of Value.

Methods

hiliteBlock Highlights the referenced blocks associated with
state objects in the Simulink diagram.

update Updates the state object after the Simulink model
has been modified. If the size of Value property
changes, then the other properties are reset to their
default values.

Transient Data Objects

• “What is a Transient Data Object?” on page 2-124

• “Constructor” on page 2-124

• “Properties” on page 2-125

• “Example: Creating Transient Data Objects from Transient Experiment
Object” on page 2-127

• “Example: Using Transient Data Objects for Creating an Experiment
Object” on page 2-127

• “Modifying Properties” on page 2-128

• “Methods” on page 2-128
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What is a Transient Data Object?
The TransientData object encapsulates the data measured at a single input
or output of a physical system during an experiment. This object belongs to
the ParameterEstimator package.

Transient data objects are associated with three types of Simulink blocks:

• Inport blocks

• Outport blocks

• Blocks that have logged signals

Each TransientData object describes the time history of a signal at a
Simulink port. A data set is identified by the Block property of this object
corresponding to a block name in the Simulink model. A PortNumber value
is also necessary for internal blocks to uniquely identify signals within the
block diagram.

Constructor
Creating an TransientExperiment object automatically creates
TransientData objects corresponding to Inport blocks, Outport blocks or
logged signals in the model.

Alternatively, you can also create a TransientData object using the following
constructor syntaxes and assign them to the TransientExperiment object:

% Inport Outport block.
io_ports = ParameterEstimator.TransientData('block');

% Block with logged signal.
logged_signals = ParameterEstimator.TransientData('block',portnumber);

% Additional input arguments.
h = ParameterEstimator.TransientData('block',data,time);
h = ParameterEstimator.TransientData('block',data,Ts);
h = ParameterEstimator.TransientData('block',portnumber,data,time);
h = ParameterEstimator.TransientData('block',portnumber,data,Ts);
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Properties

Block Name of the Simulink block with which the data is
associated. Must be a string.

PortType The type of signal that this object represents is
determined in the constructor from the Block
property, which may be Inport, Outport, or Signal.

PortNumber For data associated with the outputs of regular blocks
or subsystems, this property specifies the output port
number of interest. The default value is 1.

Dimensions Dimensions of the data required for this data set.
It is computed from the CompiledPortDimensions
property of the appropriate port of the block, and
it defines the size of other properties. Currently,
Simulink supports scalar, vector, or matrix signals,
so Dimensions is either a scalar or a 1-by-2 array.

Data Actual experimental data. Its size must be consistent
with the Dimensions property. To conform with
Simulink conventions, the data is stored in the
following formats:

• Scalar or vector-valued data. The data is of the
form Ns m, where Ns is the number of data
samples, and m is the number of channels in the
signal.

• Multidimensional data (matrix and higher
dimensions). The data is of the form m1 . . . mn
Ns, where Ns is the number of data samples, and
mi is the number of channels in the ith dimension
of the signal.

• For missing or unspecified data, NaNs are used.
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Ts,
Tstart,
Tstop

For uniformly sampled data, Ts is the sample time
and Tstart is the start time of the signal. The stop
time Tstop and the time vector Time are given by

Tstop = Tstart + Ts * (Ns -1)

Time = Tstart : Ts : Tstop

For nonuniform time data, Ts is set to NaN, and the
start and stop times are calculated from the time
vector.

Time The time data in column vector format. The length of
Time must be consistent with the number of samples
in Data.

For a nonuniformly spaced Time vector, its length
should match the length of Data.

Otherwise, Time is automatically adjusted based on
the length of Data.

Modifying Ts resets Time internally. In this case,
Time is a virtual property whose value is computed
from Ts and Tstart when you request it. The rules
for setting time related properties are

• Modifying Time sets

Ts = NaN
Tstart = Time(1)

• If the time vector is uniformly spaced, a sample
time Ts is calculated.

• Modifying Tstart translates time forward or
backward.

• Modifying Ts sets Time = [] internally and
generates it when required by the simulation.

2-126



Estimate Parameters (Code)

Weight The weight associated with each channel of this data
set. It is used to specify the relative importance of
signals. The default value is 1.

InterSample Interpolation method between samples can be
zero-order hold (zoh) or first-order hold (foh). This
property is used for data preprocessing.

Example: Creating Transient Data Objects from Transient
Experiment Object
To automatically create transient data objects from a transient experiment
object:

% Open the model.
f14;
% Create the transient experiment object.
exp1 = ParameterEstimator.TransientExperiment('f14')

To view the transient data objects:

class(exp1.InputData)
exp1.InputData

These commands return the following results:

ans =

ParameterEstimator.TransientData

(1) Transient data for Inport block f14/u:

Sampling time: 1 sec.

Data set has 0 samples and 1 channels.

Example: Using Transient Data Objects for Creating an
Experiment Object
To create an experiment object using transient data objects:
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% Open the model.
vdp;

% Create transient data object for the output data.
out1 = ParameterEstimator.TransientData('vdp/Out1');

% Create an experiment using the previously-defined objects.
exp1 = ParameterEstimator.TransientExperiment...
(gcs, [], out1);

Modifying Properties
After a transient data object is created, you can modify its properties using
this syntax:

in1.Data = rand(2,1,10); % 10 data values each of size [2 1]
in1.Time = 1:10; % Automatically converted to column vector

Some properties (e.g., Weight) support scalar expansion with respect to the
value of the Dimensions property.

Methods

select Extracts a portion of data. The result is returned in a new
transient data object. For example:

in2 = select(in1, 'Sample', 10:100); % 91 samples
in3 = select(in1, 'Range', [1 4]); % Samples for 1<t<4
% ... or an alternative
in3 = select(in1, 'Sample', find(in1.Time > 1 & in1.Time <

To extract data from a subset of available channels, use

in4 = select(in1, 'Channel', [1 3 2]);
% channels 1,3,and 2 in this order
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hiliteBlock Highlights the block associated with this object in the
Simulink diagram.

update Updates the transient data object from the corresponding
Simulink model block.

State Data Objects

• “What is a State Data Object?” on page 2-129

• “Constructor” on page 2-130

• “Properties” on page 2-130

• “Example: Creating State Data Objects from Transient Experiment Object”
on page 2-131

• “Example: Using State Data Objects for Creating an Experiment Object”
on page 2-131

• “Modifying Properties” on page 2-132

• “Methods” on page 2-132

What is a State Data Object?
The StateData object defines the known states of a dynamic Simulink block.
It is used in a transient estimation to define known initial conditions of a
model, and in a steady-state estimation context to define the known states of
the model. This object belongs to the ParameterEstimator package.

For example, the Simulink model of a simple mass-spring-damper system
has two integrator blocks to generate velocity and position signals from
acceleration and velocity values, respectively, during simulation. If the
corresponding physical system is known to be at rest at the beginning of an
experiment, the initial states (velocity and position) of these integrators are
zero. So, two StateData objects can be created to describe these known
initial conditions.
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Constructor
Creating an Transient Experiment object automatically creates StateData
objects.

To manually create a StateData object, type one of the following syntaxes:

h = ParameterEstimator.StateData('block');
h = ParameterEstimator.StateData('block', data);

In the first constructor, the state vector is initialized from the model
containing the block.

Properties

Block Name of the Simulink block whose states are defined
by this object.

StateName Name of a state. This property shows a state name
if your model has:
• Blocks, such as integrators, containing states with
unique names

• Blocks from Simscape, SimMechanics,
SimPowerSystems and SimHydraulics software

Dimensions Scalar value to store the number of states of the
relevant block.

Data Column vector to store the initial value of the state
for the block specified by this object. The length of
this vector should be consistent with the Dimensions
property. Since the underlying Simulink model also
stores an initial state vector for all dynamic blocks,
the following conventions are used to resolve the
initial state values during estimations:

• If Data is not empty, use it when forming the state
vector.

• If Data is empty, get the state vector for this block
from the model. This behavior is useful when
using helper methods to create an experiment
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object that instantiates empty state data objects
for all dynamic blocks in the Simulink model.

• If there is no state data object for a dynamic
block in the model, get the state vector of that
block from the model. This behavior is useful for
command-line users, when there are too many
states in the model and only a few of them have to
be set to different initial values.

Ts Sampling time of discrete blocks. Set to 0 for
continuous blocks. This property is read only and is
currently used for information only.

Example: Creating State Data Objects from Transient
Experiment Object
To create transient data objects automatically by creating a transient
experiment object:

% Open the model.
f14;
% Create the transient experiment object.
exp1 = ParameterEstimator.TransientExperiment('f14')

To view the state data objects:

exp1.InitialStates

Example: Using State Data Objects for Creating an Experiment
Object
To create an experiment object using transient data objects:

% Open the model.
vdp;

% Create state data object for the initial state.
ic1 = ParameterEstimator.StateData('vdp/x1');

% Create an experiment using the previously-defined objects.
exp1 = ParameterEstimator.TransientExperiment...
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(gcs, [], ic1);

Modifying Properties
After a state data object is created, you can modify its properties using this
syntax:

st1.Data = [2 3]; % State vector of size 2

Some properties (e.g., Data) support scalar expansion with respect to the
value of the Dimensions property.

Methods

hiliteBlock Highlights the block associated with this object in
the Simulink diagram.

update Updates the object after the Simulink model has
been modified. If the Dimensions property value
changes, the other properties are reset to their
default values.

How to Use Parallel Computing (Code)
After you configure your system for parallel computing, as described in
“Configure Your System for Parallel Computing” on page 2-59, you can
estimate the model parameters using the command-line functions. To learn
more about parameter estimation using parallel computing, see “Speedup
Using Parallel Computing” on page 2-55.

To use parallel computing for parameter estimation at the command line:

1 Open the Simulink model by typing the model name at the MATLAB
prompt.

2 Configure an estimation project, as described in “How to Estimate
Parameters (Code)” on page 2-87.
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3 Enable the parallel computing option in the estimation project by typing
the following command:

hEst.OptimOptions.UseParallel='always';

To view that the UseParallel property has been set, type the following
command:

hEst.OptimOptions

4 Find the model path dependencies by typing the following command:

dirs=hEst.finddepend;

This command returns the model path dependencies in your Simulink
model in the dirs cell array.

Note As described in “Specify Model Dependencies” on page 2-60, the
finddepend command may not detect all the path dependencies in your
model.

5 (Optional) Modify dirs to include the model path dependencies that
finddepend does not detect by typing the following command.

dirs=vertcat(dirs;'\\hostname\C$\matlab\work')

6 Assign the path dependencies to the estimation project by typing the
following command:

hEst.OptimOptions.ParallelPathDependencies=dirs;

7 Run the estimation by typing the following command:

estimate(hEst);

For more information on how to troubleshoot estimation results you
obtained using parallel computing, see “Troubleshooting” on page 2-65.
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Response Optimization

• “Response Optimization Workflow” on page 3-3

• “How the Optimization Algorithm Formulates Minimization Problems”
on page 3-4

• “Specify Signals to Log (GUI)” on page 3-14

• “Specifying Time Domain Design Requirements (GUI)” on page 3-16

• “Specifying Frequency Domain Design Requirements (GUI)” on page 3-32

• “Design Variables (GUI)” on page 3-54

• “General Options” on page 3-60

• “Optimization Options” on page 3-64

• “Creating Linearization I/O Sets (GUI)” on page 3-69

• “Linearization Options” on page 3-71

• “Plots” on page 3-74

• “Compare Requirements and Design Variables Using Spider Plot” on page
3-81

• “Run the Optimization (GUI)” on page 3-85

• “Design Optimization to Meet Time- and Frequency-Domain Requirements”
on page 3-88

• “Design Optimization to Meet a Custom Objective Using the GUI” on
page 3-103

• “Design Optimization to Meet a Custom Objective at the Command Line”
on page 3-123

• “Design Optimization to Meet Custom Signal Requirements (GUI)” on
page 3-133
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• “Design Optimization to Meet Frequency-Domain Requirements” on page
3-138

• “Optimizing Parameters for Robustness” on page 3-157

• “Accelerating Model Simulations During Optimization” on page 3-171

• “Speedup Using Parallel Computing” on page 3-173

• “How to Use Parallel Computing” on page 3-178

• “Refining and Troubleshooting Optimization Results” on page 3-186

• “Managing Design Optimization Tool Session” on page 3-196
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Response Optimization Workflow
The process for optimizing model parameters to meet design requirements
consists of the following tasks:

1 Specify design requirements

2 Specify design variables

3 (Optional) Specify optimization options

4 Optimize the design

Related Examples

• “Optimize Controller Parameters to Meet Step Response Requirements
(GUI)”

• “Optimize Controller Parameters to Track Reference Signal (GUI)”

• “Optimize Controller Parameters to Meet Step Response Requirements
(Code)”
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How the Optimization Algorithm Formulates Minimization
Problems

When you optimize parameters of a Simulink model to meet design
requirements, Simulink Design Optimization software automatically converts
the requirements into a constrained optimization problem and then solves
the problem using optimization techniques. The constrained optimization
problem iteratively simulates the Simulink model, compares the results of the
simulations with the constraint objectives, and uses optimization methods to
adjust tuned parameters to better meet the objectives.

This topic describes how the software formulates the constrained optimization
problem used by the optimization algorithms. For each optimization
algorithm, the software formulates one of the following types of minimization
problems:

• Feasibility

• Tracking

• Mixed feasibility and tracking

For more information on how each optimization algorithm formulates these
problems, see:

• “Gradient Descent Method Problem Formulations” on page 3-8

• “Simplex Search Method Problem Formulations” on page 3-10

• “Pattern Search Method Problem Formulations” on page 3-11

• “Gradient Computations” on page 3-12

Feasibility Problem and Constraint Formulation
Feasibilitymeans that the optimization algorithm finds parameter values that
satisfy all constraints to within specified tolerances but does not minimize
any objective or cost function in doing so.

In the following figure, x1, x3, and xn represent a combination of parameter
values P1 and P2 and are feasible solutions because they do not violate the
lower bound constraint.
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In a Simulink model, you constrain a signal by specifying lower and upper
bounds in a Check block or a requirement object, as shown in the following
figure.
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These constraints are piecewise linear bounds. A piecewise linear bound ybnd
with n edges can be represented as:
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The software computes the signed distance between the simulated response
and the edge. The signed distance for lower bounds is:
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where ysim is the simulated response and is a function of the parameters
being optimized.

The signed distance for upper bounds is:
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At the command line, opt_fcn supplies c directly from the Cleq field of vals.

If all the constraints are met (c ≤ 0) for some combination of parameter values,
then that solution is said to be feasible. In the following figure, x1 and x3
are feasible solutions.

"
����
��

�#

�$

��

�%

&#

&$

When your model has multiple requirements or vector signals feeding a
requirement, the constraint vector is extended with the constraint violations
for each signal and bound:

C c c cn= [ ]1 2; ; ; .
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Tracking Problem
In addition to lower and upper bounds, you can specify a reference signal in
a Check Against Reference block or sdo.requirements.SignalTracking
object, which the Simulink model output can track. The tracking objective is a
sum-squared-error tracking objective.

You specify the reference signal as a sequence of time-amplitude pairs:

y t t T T Tref ref ref ref ref refN( ), { , , , }.∈ 0 1 

The software computes the simulated response as a sequence of
time-amplitude pairs:

y t t T T Tsim sim sim sim sim simN( ), { , , , },∈ 0 1 

where some values of tsim may match the values of tref.

A new time base, tnew, is formed from the union of the elements of tref and
tsim. Elements that are not within the minimum-maximum range of both tref
and tsim are omitted:

t t t tnew sim ref= ∩{ : }

Using linear interpolation, the software computes the values of yref and ysim at
the time points in tnew and then computes the scaled error:

e t
y t y t

y
new

sim new ref new

t
ref

new

( )
( ) ( )

max
.=

−( )

Finally, the software computes the weighted, integral square error:

f w t e t dt= ( )∫ ( ) .2
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Note The weight w(t) is 1 by default. You can specify a different value of
weight only at the command line.

When your model has requirements or vector signals feeding a requirement,
the tracking objective equals the sum of the individual tracking integral
errors for each signal:

F fi= ∑ .

Gradient Descent Method Problem Formulations
The Gradient Descent method uses the Optimization Toolbox function
fmincon to optimize model parameters to meet design requirements.

Problem Type Problem Formulation

Feasibility Problem The software formulates the constraint C(x) as described in
“Feasibility Problem and Constraint Formulation” on page 3-4.

• If you do not select the maximally feasible solution option (i.e.,
the optimization terminates as soon as a feasible solution is
found), the software uses the following problem formulation:

min

. . ( )
[ , ]x

s t C x w

x x x





 0

   

            
            

≤ −( )
≤ ≤

1

0 ≤≤ 

The constraint weight vector w is dimensionally commensurate
with C(x) and defaults to a vector of ones. When all the constraint
weights are one, the scalar slack variable γ plays no role in the
calculation. Otherwise, the slack variable permits a feasible
solution with C(x) ≤ (1–w)γ rather than C(x) ≤ 0.

• If you select the maximally feasible solution option (i.e., the
optimization continues after an initial feasible solution is found),
the software uses the following problem formulation:
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Problem Type Problem Formulation

min

. . ( )
,x

s t C x
x x x





[ ]

≤
≤ ≤

 

   
     

In this formulation, x is a feasible solution if γ ≤ 0.

Tracking Problem The software formulates the tracking objective F(x) as described
in “Tracking Problem” on page 3-7 and minimizes the tracking
objective:

min ( )

. .
x

F x

s t x x x

 

   ≤ ≤
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Problem Type Problem Formulation

Mixed Feasibility and
Tracking Problem

The software minimizes following problem formulation:

min ( )

. . ( )
x

F x

s t C x
x x x

  

     
       

≤
≤ ≤

0

Note When tracking a reference signal, the software ignores the
maximally feasible solution option.

Simplex Search Method Problem Formulations
The Simplex Search method uses the Optimization Toolbox function
fminsearch and fminbnd to optimize model parameters to meet design
requirements. fminbnd is used if one scalar parameter is being optimized,

otherwise fminsearch is used. You cannot use parameter bounds x x x≤ ≤
with fminsearch.

Problem Type Problem Formulation

Feasibility Problem The software formulates the constraint C(x) as described in
“Feasibility Problem and Constraint Formulation” on page 3-4 and
then minimizes the maximum constraint violation:

min
x

C x max ( )( )

Tracking Problem The software formulates the tracking objective F(x) as described in
“Tracking Problem” on page 3-7 and then minimizes the tracking
objective:
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Problem Type Problem Formulation

min ( )
x

F x 

Mixed Feasibility and
Tracking Problem

The software formulates the problem in two steps:

1 Finds a feasible solution.

min
x

C x max ( )( )

2 Minimizes the tracking objective. The software uses the results
from step 1 as initial guesses and maintains feasibility by
introducing a discontinuous barrier in the optimization objective.

min

( )
inf max ( )
( )

x
x

where

x
if C x

F x otherwise

  Γ

Γ

( )

= ( ) >⎧
⎨
⎩

0

Pattern Search Method Problem Formulations
The Pattern Search method uses the Global Optimization Toolbox function
patternsearch to optimize model parameters to meet design requirements.

Problem Type Problem Formulation

Feasibility Problem The software formulates the constraint C(x) as described in
“Feasibility Problem and Constraint Formulation” on page 3-4 and
then minimizes the maximum constraint violation:

min

. .
x

C x

s t x x x

 max

     

( )( )

≤ ≤

Tracking Problem The software formulates the tracking objective F(x) as described in
“Tracking Problem” on page 3-7 and then minimizes the tracking
objective:
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Problem Type Problem Formulation

min ( )

. .
x

F x

s t x x x

  

    ≤ ≤

Mixed Feasibility and
Tracking Problem

The software formulates the problem in two steps:

1 Finds a feasible solution.

min

. .
x

C x

s t x x x

 max

     

( )( )

≤ ≤

2 Minimizes the tracking objective. The software uses the results
from step 1 as initial guesses and maintains feasibility by
introducing a discontinuous barrier in the optimization objective.

min ( )

. .

( )
inf max ( )
( )

x
x

s t x x x
where

x
if C x

F x other

  

    

Γ

Γ

≤ ≤

= ( ) > 0
wwise

⎧
⎨
⎩

Gradient Computations
For the Gradient descent (fmincon) optimization solver, given an objective
function opt_fcn and scalar parameter x, the gradients are computed using
numerical perturbation:
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dx eps x x

dL x dx x

dR x dx x

F

typical   
  
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3 max
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min ,
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opt fcn dL
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F F

dL dR





 
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_ ( )

_ ( )

dx is relatively large to accommodate simulation solver tolerances.

If you want to compute the gradients in any other way, you can do so in the cost
function you write for performing design optimization programmatically. See
sdo.optimize and GradFcn of sdo.OptimizeOptions for more information.
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Specify Signals to Log (GUI)
Design requirements require logged model signals. During optimization, the
model is simulated using the current value of the design variables and the
logged signal is used to evaluate the design requirements.

1 In the Design Optimization tool, select Signal in the New drop-down
list. A window opens where you select a signal to log.

2 In the Simulink model window, click the signal where you want to add
a requirement.

The window updates and displays the name of the block and the port
number where the selected signal is located.

3 Select the signal and click to add it to the signal set.

4 In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool window.
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See Also

• “Optimize Controller Parameters to Track Reference Signal (GUI)”

• sdo.SimulationTest
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Specifying Time Domain Design Requirements (GUI)

In this section...

“Specifying Piecewise-Linear Lower and Upper Bounds” on page 4-4

“Specifying Step Response Characteristics” on page 4-35

“Track Reference Signals” on page 4-13

“Specifying Custom Requirements” on page 4-38

“Editing Design Requirements” on page 4-17

Specifying Piecewise-Linear Lower and Upper
Bounds
To specify upper and lower bounds on a signal:

1 In the Design Optimization tool, select Signal Bound in the New
drop-down list. A window opens where you specify upper or lower bounds
on a signal.

2 Specify a requirement name in the Name box.

3 Select the requirement type using the Type list.

4 Specify the edge start and end times and corresponding amplitude in the
Time (s) and Amplitude columns.

5 Click to specify additional bound edges.

Select a row and click to delete a bound edge.

6 In the Select Signals to Bound area, select a logged signal to apply the
requirement to.

If you have already selected signals, as described in “Specify Signals to
Log (GUI)” on page 3-14, they appear in the list. Select the corresponding
check-box.

If you haven’t selected a signal to log:
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a Click . A window opens where you specify the logged signal.

b In the Simulink model window, click the signal where you want to add
a requirement.

The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool window.

7 Click OK.

A variable with the specified requirement name appears in the Design
Optimization Workspace. A graphical display of the requirement also
appears in the Design Optimization tool window.

8 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6
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• “Split and Join Constraints” on page 4-8

Alternatively, you can add a Check Custom Bounds block to your model to
specify piecewise-linear bounds.

Moving Constraints

• “Moving Constraints Graphically” on page 4-6

• “Positioning Constraints Exactly” on page 4-7

Constraint-bound edges define time-domain constraints you would like to
place on a particular signal in your model. You can position these edges,
which appear as a yellow shaded region bordered by a black line, graphically
or exactly.

Moving Constraints Graphically. Use the mouse to click and drag edges in
the amplitude versus time plot, as shown in the following figure.

• To move a constraint edge boundary or to change the slope of a constraint
edge, position the pointer over a constraint edge endpoint, and press and
hold down the left mouse button. The pointer should change to a hand
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symbol. While still holding the button down, drag the pointer to the target
location, and release the mouse button. Note that the edges on either side
of the boundary might not maintain their slopes.

• To move an entire constraint edge up, down, left, or right, position the
mouse pointer over the edge and press and hold down the left mouse
button. The pointer should change to a four-way arrow. While still holding
the button down, drag the pointer to the target location, and release the
mouse button. Note that the edges on either side of the boundary might
not maintain their slopes.

To move a constraint edge to a perfectly horizontal or vertical position, hold
down the Shift key while clicking and dragging the constraint edge. This
causes the constraint edge to snap to a horizontal or vertical position.

When moving constraint bound edges, it is sometimes helpful to display
gridlines on the axes for careful alignment of the constraint bound edges. To
turn the gridlines on or off, right-click within the axes and select Grid.

Note You can move a lower bound constraint edge above an upper bound
constraint edge, or vice versa, but this produces an error when you attempt to
run the optimization.

Positioning Constraints Exactly. To position a constraint edge exactly:

1 Position the pointer over the edge you want to move and right-click. Select
Edit to open the Edit Design Requirement dialog box.
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2 Specify the position of each constraint edge in the Time and Amplitude
columns.

Split and Join Constraints
To split a constraint segment, position the pointer over the segment to be split,
and press the right mouse button. Select Split from the context menu. The
segment splits in half. You can now manipulate each segment individually.

3-20



Specifying Time Domain Design Requirements (GUI)

To join two neighboring constraint segments, position the pointer over one
constraint segment, and press the right mouse button. Select Join left or
Join right from the menu to join the segment to the segment too the left
or right respectively.

Specifying Step Response Characteristics
To specify step response characteristics:

1 You can apply this requirement to either a signal or a linearization of
your model.

In the Design Optimization Tool, click New. To apply this requirement to
a signal, select the Step Response Envelope entry in the New Time
Domain Requirement section of the New list. To apply this requirement
to a linearization of your model, select the Step Response Envelope
entry in the New Frequency Domain Requirement section of the New
list. The latter option requires Simulink Control Design software.

A window opens where you specify the step response requirements on
a signal, or system.

2 Specify a requirement name in the Name box.
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3 Specify the step response characteristics:
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• Initial value: Input level before the step occurs

• Step time: Time at which the step takes place

• Final value: Input level after the step occurs

• Rise time: The time taken for the response signal to reach a specified
percentage of the step’s range. The step’s range is the difference between
the final and initial values.

• % Rise: The percentage used in the rise time.

• Settling time: The time taken until the response signal settles within a
specified region around the final value. This settling region is defined
as the final step value plus or minus the specified percentage of the
final value.

• % Settling: The percentage used in the settling time.

• % Overshoot: The amount by which the response signal can exceed the
final value. This amount is specified as a percentage of the step’s range.
The step’s range is the difference between the final and initial values.

3-22



Specifying Time Domain Design Requirements (GUI)

• % Undershoot: The amount by which the response signal can
undershoot the initial value. This amount is specified as a percentage
of the step’s range. The step’s range is the difference between the final
and initial values.

4 Specify the signals or systems to be bound.

You can apply this requirement to a model signal or to a linearization of
your Simulink model (requires Simulink Control Design software).

• Apply this requirement to a model signal:

In the Select Signals to Bound area, select a logged signal to which
you will apply the requirement.

If you have already selected a signal to log, as described in “Specify
Signals to Log (GUI)” on page 3-14, it appears in the list. Select the
corresponding check-box.

If you haven’t selected a signal to log:

a Click . A window opens where you specify the logged signal.

b In the Simulink model window, click the signal where you want to
add a requirement.
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The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the
Design Optimization Workspace of the Design Optimization tool
window.

• Apply this requirement to a linear system.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using
the Snapshot Times box. For multiple simulation snapshot times,
specify a vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click
to open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A variable with the specified requirement name appears in the Design
Optimization Workspace. A graphical display of the requirement also
appears in the Design Optimization tool window.

Alternatively, you can use the Check Step Response Characteristics block to
specify step response bounds for a signal.
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See Also

“Optimize Controller Parameters to Meet Step Response Requirements (GUI)”

Track Reference Signals
Use reference tracking to force a model signal to match a desired signal.

To track a reference signal:

1 In the Design Optimization tool, select Signal Tracking in the New
drop-down list. A window opens where you specify the reference signal
to track.

2 Specify a requirement name in the Name box.

3 Define the reference signal by entering vectors, or variables from the
workspace, in the Time vector and Amplitude fields.

Click Update reference signal data to use the new amplitude and time
vector as the reference signal.

4 Specify how the optimization solver minimizes the error between the
reference and model signals using the Tracking Method list:

• SSE — Reduces the sum of squared errors

• SAE — Reduces the sum of absolute errors

5 In the Specify Signal to Track Reference Signal area, select a logged
signal to apply the requirement to.

If you already selected a signal to log, as described in “Specify Signals to
Log (GUI)” on page 3-14, they appear in the list. Select the corresponding
check-box.

If you haven’t selected a signal to log:

a Click . A window opens where you specify the logged signal.

b In the Simulink model window, click the signal where you want to add
a requirement.
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The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool window.

e Select the check-box corresponding to the signal and click OK.

A variable with the specified requirement name appears in the Design
Optimization Workspace. A graphical display of the signal bound also
appears in the Design Optimization tool window.

Note When tracking a reference signal, the software ignores the maximally
feasible solution option. For more information on this option, see “Selecting
Optimization Termination Options” on page 3-66.
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Alternatively, you can use the Check Against Reference block to specify
a reference signal to track.

See Also

“Optimize Controller Parameters to Track Reference Signal (GUI)”

Specifying Custom Requirements
To specify custom requirements such as minimizing system energy:

1 In the Design Optimization tool, select Custom Requirement in the New
drop-down list. A window opens where you specify the custom requirement.

2 Specify a requirement name in the Name box.

3 Specify the requirement type using the Type list.

4 Specify the name of the function that contains the custom requirement in
the Function box. The field must be specified as a function handle using

@. The function must be on the MATLAB path. Click to review
or edit the function.

If the function does not exist, clicking opens a template MATLAB
file. Use this file to implement the custom requirement. The default
function name is myCustomRequirement.

5 (Optional) Specify the signal or system, or both, to be bound.

You can apply this requirement to model signals, or a linearization of your
Simulink model (requires Simulink Control Design software), or both.

Click Select Signals and Systems to Bound (Optional) to view the
signal and linearization I/O selection area.

• Apply this requirement to a model signal:

In the Signal area, select a logged signal to which you will apply the
requirement.
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If you have already selected a signal to log, as described in “Specify
Signals to Log (GUI)” on page 3-14, it appears in the list. Select the
corresponding check-box.

If you haven’t selected a signal to log:

a Click . A window opens where you specify the logged signal.

b In the Simulink model window, click the signal where you want to
add a requirement.

The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the
Design Optimization Workspace of the Design Optimization tool
window.

• Apply this requirement to a linear system.
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Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using
the Snapshot Times box. For multiple simulation snapshot times,
specify a vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click
to open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

6 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.

See Also

• “Design Optimization to Meet a Custom Objective Using the GUI” on
page 3-103

• “Design Optimization to Meet Custom Signal Requirements (GUI)” on
page 3-133

Editing Design Requirements
The Edit Design Requirement dialog box allows you to exactly position
constraint segments and to edit other properties of these constraints. The
dialog box has two main components:
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• An upper panel to specify the constraint you are editing

• A lower panel to edit the constraint parameters

The upper panel of the Edit Design Requirement dialog box resembles the
image in the following figure.

In the context of the SISO Tool in Control System Toolbox™ software, Design
requirement refers to both the particular editor within the SISO Tool
that contains the requirement and the particular requirement within that
editor. To edit other constraints within the SISO Tool, select another design
requirement from the drop-down menu.

Edit Design Requirement Dialog Box Parameters
The particular parameters shown within the lower panel of the Edit Design
Requirement dialog box depend on the type of constraint/requirement. In
some cases, the lower panel contains a grid with one row for each segment and
one column for each constraint parameter. The following table summarizes
the various constraint parameters.

Edit Design Requirement Dialog Box Parameters

Parameter Found in Description

Time Upper and lower time
response bounds on step
and impulse response plots

Defines the time range of a segment
within a constraint/requirement.

Amplitude Upper and lower time
response bounds on step
and impulse response plots

Defines the beginning and ending
amplitude of a constraint segment.
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Edit Design Requirement Dialog Box Parameters (Continued)

Parameter Found in Description

Slope (1/s) Upper and lower time
response bounds

Defines the slope, in 1/s, of a
constraint segment. It is an
alternative method of specifying the
magnitude values. Entering a new
Slope value changes any previously
defined magnitude values.

Final value Step response bounds Defines the input level after the step
occurs.

Rise time Step response bounds Defines a constraint segment for a
particular rise time.

% Rise Step response bounds The percentage of the step’s range
used to describe the rise time.

Settling time Step response bounds Defines a constraint segment for a
particular settling time.

% Settling Step response bounds The percentage of the final value that
defines the settling region used to
describe the settling time.

% Overshoot Step response bounds

% Undershoot Step response bounds Defines the constraint segments for a
particular percent undershoot.
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Specifying Frequency Domain Design Requirements (GUI)

In this section...

“Specifying Lower Bounds on Gain and Phase Margin” on page 4-20

“Specifying Piecewise-Linear Lower and Upper Bounds on Frequency
Response” on page 4-22

“Specifying Bound on Closed-Loop Peak Gain” on page 4-24

“Specifying Lower Bound on Damping Ratio” on page 4-26

“Specifying Upper and Lower Bounds on Natural Frequency” on page 4-28

“Specifying Upper Bound on Approximate Settling Time” on page 4-30

“Specifying Piecewise-Linear Upper and Lower Bounds on Singular Values”
on page 4-32

“Specifying Step Response Characteristics” on page 4-35

“Specifying Custom Requirements” on page 4-38

Specifying Lower Bounds on Gain and Phase Margin
To specify lower bounds on the gain and phase margin of a linear system:

1 In the Design Optimization tool, select Gain and Phase Margin in the
New list. A window opens where you specify lower bounds on the gain and
phase margin of your linear system.

2 Specify a requirement name in Name.

3 Specify bounds on the gain margin or phase margin, or both.
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• Gain margin— Amount of gain increase or decrease required to make
the loop gain unity at the frequency where the phase angle is –180°.

• Phase margin — Amount of phase increase or decrease required to
make the phase angle –180° when the loop gain is 1.0

To specify a lower bound on the gain margin or phase margin, or both,
select the corresponding check box and enter the lower bound value.

4 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.
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If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A variable with the specified requirement name appears in the Design
Optimization Workspace. A graphical display of the requirement also
appears in the Design Optimization tool window.

6 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Gain and Phase Margins block to specify
bounds on the gain and phase margin. (Requires Simulink Control Design.)

Specifying Piecewise-Linear Lower and Upper
Bounds on Frequency Response
To specify upper or lower bounds on the magnitude of a system response:

1 In the Design Optimization tool, select Bode Magnitude in the New
list. A window opens where you specify the lower or upper bounds on the
magnitude of the system response.

2 Specify a requirement name in the Name box.

3 Specify the requirement type using the Type list.

4 Specify the edge start and end frequencies and corresponding magnitude in
the Frequency and Magnitude columns.
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5 Insert or delete bound edges.

Click to specify additional bound edges.

Select a row and click to delete a bound edge.

6 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

7 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool window.
A graphical display of the requirement also appears in the Design
Optimization tool window.
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8 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Bode Characteristics block to specify
bounds on the magnitude of the system response. (Requires Simulink Control
Design.)

Specifying Bound on Closed-Loop Peak Gain
To specify an upper bound on the closed-loop peak response of a system:

1 In the Design Optimization tool, select Closed-Loop Peak Gain in the
New list. A window opens where you specify an upper bound on the
closed-loop peak gain of the system.

2 Specify a requirement name in the Name box.
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3 Specify the upper bound on the closed-loop peak gain in the Closed-Loop
peak gain box.

4 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool window.
A graphical display of the requirement also appears in the Design
Optimization tool window.
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6 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Nichols Characteristics block to specify
bounds on the magnitude of the system response. (Requires Simulink Control
Design.)

Specifying Lower Bound on Damping Ratio
To specify a lower bound on the damping ratio of the system:

1 In the Design Optimization tool, select Damping Ratio in the New list. A
window opens where you specify an upper bound on the damping ratio of
the system.
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2 Specify a requirement name in the Name box.

3 Specify the lower bound on the damping ratio in the Damping ratio box.

4 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.
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6 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Pole-Zero Characteristics block to specify
a bound on the damping ratio. (Requires Simulink Control Design.)

Specifying Upper and Lower Bounds on Natural
Frequency
To specify a bound on the natural frequency of the system:

1 In the Design Optimization tool, select Natural Frequency in the New
list. A window opens where you specify a bound on the natural frequency of
the system.
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2 Specify a requirement name in the Name box.

3 Specify a lower or upper bound on the natural frequency in the Natural
frequency box.

4 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.
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6 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Pole-Zero Characteristics block to specify
a bound on the natural frequency. (Requires Simulink Control Design.)

Specifying Upper Bound on Approximate Settling
Time
To specify an upper bound on the approximate settling time of the system:

1 In the Design Optimization tool, select Settling Time in the New list.
A window opens where you specify an upper bound on the approximate
settling time of the system.
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2 Specify a requirement name in the Name box.

3 Specify the upper bound on the approximate settling time in the Settling
time box.

4 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.

3-43



3 Response Optimization

6 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Pole-Zero Characteristics block to specify
the approximate settling time. (Requires Simulink Control Design.)

Specifying Piecewise-Linear Upper and Lower
Bounds on Singular Values
To specify piecewise-linear upper and lower bounds on the singular values
of a system:
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1 In the Design Optimization tool, select Singular Values in the New
list. A window opens where you specify the lower or upper bounds on the
singular values of the system.

2 Specify a requirement name in the Name box.

3 Specify the requirement type using the Type list.

4 Specify the edge start and end frequencies and corresponding magnitude in
the Frequency and Magnitude columns, respectively.

5 Insert or delete bound edges.

Click to specify additional bound edges.

Select a row and click to delete a bound edge.

6 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.
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7 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.

8 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Singular Value Characteristics block to
specify bounds on the singular value. (Requires Simulink Control Design.)
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Specifying Step Response Characteristics
To specify step response characteristics:

1 You can apply this requirement to either a signal or a linearization of
your model.

In the Design Optimization Tool, click New. To apply this requirement to
a signal, select the Step Response Envelope entry in the New Time
Domain Requirement section of the New list. To apply this requirement
to a linearization of your model, select the Step Response Envelope
entry in the New Frequency Domain Requirement section of the New
list. The latter option requires Simulink Control Design software.

A window opens where you specify the step response requirements on
a signal, or system.

2 Specify a requirement name in the Name box.

3 Specify the step response characteristics:
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• Initial value: Input level before the step occurs

• Step time: Time at which the step takes place

• Final value: Input level after the step occurs

• Rise time: The time taken for the response signal to reach a specified
percentage of the step’s range. The step’s range is the difference between
the final and initial values.

• % Rise: The percentage used in the rise time.

• Settling time: The time taken until the response signal settles within a
specified region around the final value. This settling region is defined
as the final step value plus or minus the specified percentage of the
final value.

• % Settling: The percentage used in the settling time.

• % Overshoot: The amount by which the response signal can exceed the
final value. This amount is specified as a percentage of the step’s range.
The step’s range is the difference between the final and initial values.

• % Undershoot: The amount by which the response signal can
undershoot the initial value. This amount is specified as a percentage
of the step’s range. The step’s range is the difference between the final
and initial values.

4 Specify the signals or systems to be bound.

You can apply this requirement to a model signal or to a linearization of
your Simulink model (requires Simulink Control Design software).

• Apply this requirement to a model signal:

In the Select Signals to Bound area, select a logged signal to which
you will apply the requirement.

If you have already selected a signal to log, as described in “Specify
Signals to Log (GUI)” on page 3-14, it appears in the list. Select the
corresponding check-box.

If you haven’t selected a signal to log:

a Click . A window opens where you specify the logged signal.
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b In the Simulink model window, click the signal where you want to
add a requirement.

The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the
Design Optimization Workspace of the Design Optimization tool
window.

• Apply this requirement to a linear system.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using
the Snapshot Times box. For multiple simulation snapshot times,
specify a vector.
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b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click
to open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A variable with the specified requirement name appears in the Design
Optimization Workspace. A graphical display of the requirement also
appears in the Design Optimization tool window.

Alternatively, you can use the Check Step Response Characteristics block to
specify step response bounds for a signal.

See Also

“Optimize Controller Parameters to Meet Step Response Requirements (GUI)”

Specifying Custom Requirements
To specify custom requirements such as minimizing system energy:

1 In the Design Optimization tool, select Custom Requirement in the New
drop-down list. A window opens where you specify the custom requirement.

2 Specify a requirement name in the Name box.

3 Specify the requirement type using the Type list.

4 Specify the name of the function that contains the custom requirement in
the Function box. The field must be specified as a function handle using

3-50



Specifying Frequency Domain Design Requirements (GUI)

@. The function must be on the MATLAB path. Click to review
or edit the function.

If the function does not exist, clicking opens a template MATLAB
file. Use this file to implement the custom requirement. The default
function name is myCustomRequirement.

5 (Optional) Specify the signal or system, or both, to be bound.

You can apply this requirement to model signals, or a linearization of your
Simulink model (requires Simulink Control Design software), or both.

Click Select Signals and Systems to Bound (Optional) to view the
signal and linearization I/O selection area.

• Apply this requirement to a model signal:

In the Signal area, select a logged signal to which you will apply the
requirement.

If you have already selected a signal to log, as described in “Specify
Signals to Log (GUI)” on page 3-14, it appears in the list. Select the
corresponding check-box.

If you haven’t selected a signal to log:

a Click . A window opens where you specify the logged signal.

b In the Simulink model window, click the signal where you want to
add a requirement.
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The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the
Design Optimization Workspace of the Design Optimization tool
window.

• Apply this requirement to a linear system.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using
the Snapshot Times box. For multiple simulation snapshot times,
specify a vector.

b Select the linearization input/output set from the Linearization I/O
area.
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If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click
to open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

6 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.

See Also

• “Design Optimization to Meet a Custom Objective Using the GUI” on
page 3-103

• “Design Optimization to Meet Custom Signal Requirements (GUI)” on
page 3-133
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Design Variables (GUI)

In this section...

“Specifying Design Variables” on page 3-54

“Specifying Independent Parameters” on page 3-55

“Specify Independent Parameters to Optimize” on page 3-56

Specifying Design Variables
Before running the optimization, you must define the model parameters to
optimize. These parameters form the design variable set for optimization. By
tuning these parameters, Simulink Design Optimization software attempts to
make the signals meet the requirements.

Simulink Design Optimization software optimizes the response signals of the
model by varying the tuned parameters so that the response signals lie within
the constraint bound segments or closely match a specified reference signal.
You can specify these tuned parameters by selecting New in the Design
Variable Set drop-down list of the Design optimization tol.

The design variables can be scalar, vector, matrix or an expression that
evaluates to one of these values.

1 Select New in the Design Variables Set drop-down list.

A window opens where you specify design variables. All model parameters
are displayed in this window.

2 Select one or more parameter names and click

to add the selected parameters to a design variables set.

Note You can add the same parameter to multiple design variable sets.
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3 (Optional) Specify design variable settings.

Setting Description Default

Variable The name of the parameter. Not an editable field

Value Value of the model parameter. This value is used
by the optimization method as the initial value
and is modified during optimization.

Current value of the parameter
in the model. If you edit this
column, click Update model
variable values to update the
values in the model.

Minimum The minimum value or lower bound for the
parameter. You can edit this field to provide an
alternate minimum value.

-Inf

Maximum The maximum value or upper bound for the
parameter. You can edit this field to provide an
alternate maximum value.

Inf

Scale During optimization, the design variables are
scaled, or normalized, by dividing their current
value by a scale value. You can edit this field to
provide an alternate scaling factor.

1

The check-box indicates whether the parameter is selected as an design
variable in the set. Select it if you want this parameter to be tuned during
the optimization. Unselect if you do not want this parameter to be tuned
during the optimization but you would like to keep it on the list of tuned
parameters (for a subsequent optimization).

Expand Variable Detail to see the block in the model that contains this
parameter.

4 Click OK to create a design variable set.

Specifying Independent Parameters
Sometimes parameters in your model depend on independent parameters that
do not appear in the model. The following steps give an overview of how to
tune and include uncertainty in these independent parameters.
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1 Add the independent parameters to the model workspace (along with
initial values).

2 Define a Simulation Start function that runs before each simulation of the
model. This Simulation Start function defines the relationship between the
dependent parameters in the model and the independent parameters in
the model workspace.

3 The independent parameters now appear in the dialog box when you select
design or uncertain variables. Add these parameters to a design variables
set to tune them during response ptimization.

Caution Avoid adding independent parameters together with their
corresponding dependent parameters to the lists of tuned and uncertain
parameters. Otherwise, the optimization could give incorrect results. For
example, when a parameter x depends on the parameters a and b, avoid
adding all three parameters to the lists of tuned and uncertain parameters.

Specify Independent Parameters to Optimize
Assume that the parameter Kint in the model srotut1 is related to the
parameters x and y according to the relationship Kint=x+y. Also assume
that the initial values of x and y are 1 and -0.7, respectively. To tune x and
y instead of Kint, first define these parameters in the model workspace. To
do this,

1 Select View > Model Explorer from the srotut1 window to open the
Model Explorer window.

2 In the Model Hierarchy tree, select srotut1 > Model Workspace.
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3 Select Add > MATLAB Variable to add a new variable to the model
workspace. A new variable with a default name Var appears in the Name
column.

4 Double-click Var to make it editable and change the variable name to x.
Edit the initial Value to 1.

5 Repeat step 3 and 4 to add a variable y with an initial value of -0.7.

The Model Explorer window resembles the following figure.
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6 To add the Simulation Start function that defines the relationship between
Kint and the independent parameters x and y, select File > Model
Properties in the srotut1 model window.

7 In the Model Properties window, click the Callbacks tab.

8 To enter a Simulation start function, select StartFcn*, and type the name
of a new function. For example, srotut1_start in the Simulation start
function panel. Then, click OK.

9 Create a MATLAB file named srotut1_start.

The content of the file defines the relationship between the parameters in
the model and the parameters in the workspace. For this example, the
content resembles the following:

wks = get_param(gcs, 'ModelWorkspace')
x = wks.evalin('x')
y = wks.evalin('y')
Kint = x+y;
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Note You must first use the get_param function to get the variables x and
y from the model workspace before you can use them to define Kint.

When you add a new design or uncertain parameter, x and y appear in the
dialog box.
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General Options

In this section...

“Accessing General Options” on page 3-60

“Progress Options” on page 3-60

“Result Options” on page 3-61

Accessing General Options
You can set optimization progress and result options. To set these options,
click Options in the Design Optimization tool. A window opens. Select the
General Options tab.

Progress Options
You can specify options related to optimization progress using the options in
the Progress Options area.
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• Show optimization progress window during optimization

Opens an optimization progress window during optimization. The window
displays information such as constraint violations and cost function if
Display level is Iteration. The window is updated at the end of the
optimization with the termination information such as whether the
optimization converged.

• Update plots during optimization

Updates model response and design variable plots at each optimization
iteration.

Result Options
You can specify options for optimization results in the Result Options area.

• Update model at end of optimization

Updates optimized parameter values in the Simulink model after the
optimization terminates.

• Save optimization termination information
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Saves termination information returned by the optimization solver as a
variable named info in the Design Optimization Workspace. info is a
structure with one or more of the following fields:

- F — Optimized cost (objective) value.

- Cleq— Optimized nonlinear inequality constraint violations.

The field appears if the optimization problem includes a nonlinear
inequality constraint.

The value is a mx1 vector. Positive values indicate that the constraint
has not been satisfied. Check exitflag to confirm that the optimization
succeeded.

- Ceq— Optimized nonlinear equality constraint violations.

The field appears if the optimization problem includes a nonlinear
equality constraint.

The value is a double rx1 vector. Any nonzero values indicate that the
constraint has not been satisfied. Check exitflag to confirm that the
optimization succeeded.

- Gradients— Cost and constraint gradients at the optimized parameter
values. See “How the Optimization Algorithm Formulates Minimization
Problems” on page 3-4 on how the solver computes gradients.

This field appears if the solver specified in the Method property of
sdo.OptimizeOptions computes gradients.

The value is a structure.

- exitflag — Integer identifying the reason the algorithm terminated.
See fmincon, patternsearch and fminsearch for a list of the values and
the corresponding termination reasons.

- iterations — Number of optimization iterations

- SolverOutput — A structure with solver-specific output information.
The fields of this structure depends on the optimization solver specified
in the Method property of sdo.OptimizeOptions. See fmincon,
patternsearch and fminsearch for a list of solver outputs and their
description.
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- Stats — A structure that contains statistics collected during
optimization, such as start and end times, number of function
evaluations and restarts.

• Design variable sets

- Overwrite optimized variable values in design variable set

Overwrites the optimized model parameter values in the design variable
set variable used in the optimization. You can see the updated values in
the Value field.

- Save optimized variable values as new design variable set

Creates a new variable in the Design Optimization Workspace that
contains the optimized parameter values. To update the model with the
optimized parameter values, select the variable in theDesign Variables
Set drop-down list and click Update model variable values.
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Optimization Options

In this section...

“Accessing Optimization Options” on page 3-64

“Selecting Optimization Methods” on page 3-65

“Selecting Optimization Termination Options” on page 3-66

“Selecting Additional Optimization Options” on page 3-67

Accessing Optimization Options
You can set several options for the optimization. These options include the
optimization methods and the tolerances the methods use.

To set optimization options, click Options in the Design Optimization tool. A
window opens. Select the Optimization Options tab.
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Selecting Optimization Methods
Both the Method and Algorithm options in the Optimization method
area define the optimization method.

The choices for the Method option are:

• Gradient descent (default) — Uses the Optimization Toolbox function
fmincon to optimize the response signal subject to the constraints.

The Algorithm options for Gradient descent are:

Algorithm Option Learn More

Active-Set (default) “fmincon Active Set Algorithm”
in the Optimization Toolbox
documentation.

Interior-Point “fmincon Interior Point Algorithm”
in the Optimization Toolbox
documentation.

Trust-Region-Reflective “fmincon Trust Region Reflective
Algorithm” in the Optimization
Toolbox documentation.

• Pattern search — Uses the Global Optimization Toolbox function
patternsearch, an advanced direct search method, to optimize the
response. This option requires the Global Optimization Toolbox.

• Simplex search— Uses the Optimization Toolbox function fminsearch,
a direct search method, to optimize the response. Simplex search is
most useful for simple problems and is sometimes faster than Gradient
descent for models that contain discontinuities.

3-65



3 Response Optimization

For more information on the problem formulations for each optimization
method, see “How the Optimization Algorithm Formulates Minimization
Problems” on page 3-4.

Selecting Optimization Termination Options
Use the Optimization options panel to specify when you want the
optimization to terminate.

• Parameter tolerance: The optimization terminates when successive
parameter values change by less than this number. For more details,
refer to the discussion of the parameter TolX in the reference page for the
Optimization Toolbox function fmincon.

• Constraint tolerance: This number represents the maximum relative
amount by which the constraints can be violated and still allow a successful
convergence.

• Function tolerance: The optimization terminates when successive
function values are less than this value. Changing the default Function
tolerance value is only useful when you are tracking a reference signal or
using the Simplex searchmethod. For more details, refer to the discussion
of the parameter TolFun in the reference page for the Optimization Toolbox
function fmincon.

• Maximum iterations: The maximum number of iterations allowed.
The optimization terminates when the number of iterations exceeds this
number.

• Look for maximally feasible solution: When selected, the optimization
continues after it has found an initial, feasible solution, until it finds a
maximally feasible, optimal solution. When this option is unselected, the
optimization terminates as soon as it finds a solution that satisfies the
constraints and the resulting response signal sometimes lies very close
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to the constraint segment. In contrast, a maximally feasible solution is
typically located further inside the constraint region.

Note If selected, the software ignores this option when tracking a
reference signal.

By varying these parameters you can force the optimization to continue
searching for a solution or to continue searching for a more accurate solution.

Selecting Additional Optimization Options
At the bottom of the Optimization Options panel is a group of additional
optimization options.

• “Display Level” on page 3-67

• “Restarts” on page 3-68

Display Level
The Display level option specifies the form of the output that appears in the
Optimization Progress window. The options are:

• Iterations (default) — Displays information after each iteration

• Off — Turns off all output display

• Notify— Displays output only if the function does not converge

• Final — Displays only the final output

For more information on the type of iterative output that appears for
the method you selected in Method, see the discussion of output for the
corresponding function.
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Method Function Output Information

Gradient
descent

fmincon fmincon section of “Function-Specific
Headings” in the Optimization
Toolbox documentation

Simplex
search

fminsearch fminsearch section of
“Function-Specific Headings” in the
Optimization Toolbox documentation

Pattern
search

patternsearch “Display to Command Window
Options” in the Global Optimization
Toolbox documentation

Restarts
In some optimizations, the Hessian may become ill-conditioned and the
optimization does not converge. In these cases, it is sometimes useful to
restart the optimization after it stops, using the endpoint of the previous
optimization as the starting point for the next one. To automatically restart
the optimization, indicate the number of times you want to restart in this field.
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Creating Linearization I/O Sets (GUI)
This example shows how to create a linearization input/output set using the
Design Optimization Tool.

You create a linearization input/output set using the Create Linearization I/O
Set dialog box. This dialog box may be accessed in two ways:

• In the Design Optimization tool, select Linearization I/Os in the New
drop-down list.

• In a requirement dialog box, in the Select Systems to Bound area, click

.

Create Linearization I/O Set
To create a new linearization I/O set:

1 In your Simulink model, select a signal that you want to define as a
linearization input or output point.

The selected signal appears in the Create linearization I/O set dialog box
under Currently selected signals.
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2 In the Create linearization I/O set dialog box, click the signal name under
Currently selected signals.

3 Click Add. The signal appears in the list of Analysis I/Os.

4 Select the linearization point type from the Configuration drop-down list.
For example, if you want the selected signal to be a linearization output
point, select Output.

5 If you want the signal to be a loop opening point, click the Open Loop
check box.

6 Repeat steps 1–5 for any other signals you want to define as linearization
I/O points.

Tip To highlight in the Simulink model the blocks that are included in the
linearization specified by the current list of Analysis I/Os, click Highlight.

7 After you define all the signals for the I/O set, enter a name for the I/O set
in the Variable name box.

8 Click OK.
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Linearization Options

In this section...

“Accessing Linearization Options ” on page 3-71

“Configuring Linearization Options” on page 3-71

Accessing Linearization Options
If you have Simulink Control Design, you can set several options for
linearization. These options include the linearization methods and the sample
time of the linear systems.

To set linearization options, click Options in the Design Optimization tool. A
window opens. Select the Linearization Options tab.

Configuring Linearization Options

Models with Time Delays
Simulink Control Design lets you choose whether to linearize models using
exact representation or Pade approximation of continuous time delays. How
you treat time delays during linearization depends on your nonlinear model.
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Simulink blocks that model time delays are:

• Transport Delay block

• Variable Time Delay block

• Variable Transport Delay block

• Delay block

• Unit Delay block

By default, linearization uses Pade approximation for representing time
delays in your linear model.

Use Pade approximation to represent time delays when:

• Applying more advanced control design techniques to your linear plant,
such as LQR or H-infinity control design.

• Minimizing the time to compute a linear model.

Specify to linearize with exact time delays for:

• Minimizing errors that result from approximating time delays

• PID tuning or loop-shaping control design methods in Simulink Control
Design

• Discrete-time models (to avoid introducing additional states to the model)

The software treats discrete-time delays as internal delays in the linearized
model. Such delays do not appear as additional states in the linearized
model.

Specify How Delays are Treated. To specify whether the linearization
should approximate delays or use them exactly, set the Use exact delays
check box appropriately.

Linearization Sampling Time
To specify the sampling time of the linearized model, use the Linear system
sample time box. By default, the software chooses the slowest applicable
sampling time. Use 0 to specify a continuous-time linear model.
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Linearization Rate Conversion Method
When you linearize models with multiple sample times, such as a discrete
controller with a continuous plant, a rate conversion algorithm generates a
single-rate linear model. The rate conversion algorithm affects linearization
results.

Rate Conversion Method When to Use

Zero-Order Hold Use when you need exact
discretization of continuous
dynamics in the time-domain for
staircase inputs.

Tustin Use when you need good
frequency-domain matching between
a continuous-time system and the
corresponding discretized system, or
between an original system and the
resampled system.

Tustin with Prewarping Use when you need good
frequency domain matching at
a particular frequency between the
continuous-time system and the
corresponding discretized system, or
between an original system and the
resampled system.

Upsampling when possible
(Zero-Order Hold, Tustin, and
Tustin with Prewarping)

Upsample discrete states when
possible to ensure gain and phase
matching of upsampled dynamics.
You can only upsample when the
new sample time is an integer
multiple of the sampling time of
the original system. Otherwise,
the software uses an alternate rate
conversion method.
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Plots

In this section...

“Adding Plots in Design Optimization Tool” on page 3-74

“Plotting Current Response” on page 3-74

“Plotting Intermediate Steps” on page 3-74

“Modifying Plot Properties” on page 3-74

“Plot Types” on page 3-76

Adding Plots in Design Optimization Tool
To create a new plot or to add to an existing plot in the Design Optimization
Tool, choose the variable to plot in the Data to Plot list. Then select the plot
type using the Add Plot list. The Add Plot list has entries for the supported
plot types for the given plot variable.

Plotting Current Response
To display the current response, click Plot Current Response in the
Response Optimization tab or the Plot tab of the Design Optimization tool.
The current response appears as a thick line.

Plotting Intermediate Steps
To turn on, or off, the display of the response signal at intermediate steps
during the optimization, right-click within the white space in the plot and
select Responses > Show Iteration Responses. The response at an
intermediate step is based on parameter values at that intermediate point in
the optimization.

Modifying Plot Properties

Modifying Properties of Response Plots
Right-click the white space in a plot and select Axes Properties to open the
Property Editor dialog box.
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This figure shows the Property Editor dialog box for a step response.

In general, you can change the following properties of response plots.

• Labels — Titles and X- and Y-labels

To specify new text for plot titles and axis labels, type the new string in the
field next to the label you want to change. The label changes immediately
as you type, so you can see how the new text looks as you are typing.

• Limits — Numerical ranges of the x- and y- axes

Default values for the axes limits make sure that the maximum and
minimum x and y values are displayed. If you want to override the default
settings, change the values in the Limits pane fields. The Auto-Scale
check box automatically clears if you click a different field. The new limits
appear immediately in the response plot.

To reestablish the default values, select the Auto-Scale check box again.

• Units — Units where applicable (e.g., rad/s to Hertz). If you cannot
customize units, the Property Editor displays that no units are available
for the selected plot.

• Style — Show a grid, adjust font properties, such as font size, bold and
italics, and change the axes foreground color
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• Options—Change options where applicable. These include peak response,
settling time, phase and gain margins, etc. Plot options change with each
plot response type. The Property Editor displays only the options that
make sense for the selected response plot. For example, phase and gain
margins are not available for step responses.

Plot Types

• “Response Plots” on page 3-76

• “Spider Plots” on page 3-78

• “Iteration Plots” on page 3-79

Response Plots
You can view model signals and the requirements applied to the signal
using a response plot. You can also plot the frequency response of a system
(requires Simulink Control Design).

The response plot shows the system response as it varies during optimization.
You can also view the uncertain system responses in the plot.
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Tip To select the responses and systems displayed in a given plot, right-click
on the plot and use the Systems and Responses menu.

3-77



3 Response Optimization

Spider Plots
You can compare the values of design variable sets or evaluated requirements
using a spider plot.

Spider plots depict multivariate data using an axis for each variable. The
various axes are arranged clockwise and have a common intersecting point, as
this example shows:
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Tip To view only some of the requirement values in a given plot, right-click
on the plot and select the requirements of interest in the Show list.

For information on using a spider plot to compare design variables sets or
evaluated requirements, see “Compare Requirements and Design Variables
Using Spider Plot” on page 3-81

Iteration Plots
You can plot the values of design variables and requirements as they vary
during optimization using an iteration plot.

Iteration plots depict the value of the plot variable(s) for each iteration. The
x-axis represents the iteration number, as this example shows:
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Tip To view scaled values of the plot variable(s), right-click on the plot and
select Show scaled values.
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Compare Requirements and Design Variables Using Spider
Plot

This example shows how to use a spider plot to compare requirement
evaluations before and after optimizing the response. You can use a similar
procedure to compare the values of sets of design variables.

Open the Simulink model and load the pre-configured Design Optimization Tool
session.

For this example, which uses a distillation column model, the step response
requirements are pre-configured and loaded in the model workspace.

• Open the distillation model.

sys = 'distillation_demo';
open_system(sys)

• Open the Design Optimization Tool.

In the Simulink model window, select Tools > Response Optimization.

Alternatively, click the Response Optimization GUI with preloaded
data block in the model and skip the next step.

• Load the pre-configured Design Optimization Tool session.

Click the Design Optimization tab. In the Open drop-down list, select
Open from model workspace. A window opens where you select the
Design Optimization Tool session to load. Select distillation_optim
and click OK.

The pre-configured step response requirements are loaded in the Design
Optimization Tool.

Evaluate the value of the requirement before optimization.

In the Response Optimization tab, click Evaluate Requirements.

A new variable, ReqValues, containing the evaluation of the requirements
appears in the Design Optimization Workspace.
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When optimizing the model response, you create a set of requirements that it
must satisfy. If the requirements are violated, meaning that they evaluate
to nonnegative values, the design variables must be optimized. After the
optimization, you can compare the original requirement value with the
requirement evaluated using the optimized design variable values.

Plot the value of the requirement before optimization using a spider plot.

• In the Data to Plot list, select ReqValues.

• In the Add Plot list, select Spider plot.

The plot has an axis for each edge-and-signal combination defined in the
distillation_demo/Desired Step Response check block. Points on each
axis represent the violation for that signal-edge combination and the plot
connects these points to form a closed polygon representing the initial design.
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Note that some points are negative, representing satisfied constraints, and
some positive, representing violated constraints.

Optimize the model.

Click Optimize.

A new variable, ReqValues1, containing the evaluation of the requirements
using the optimized design variables appears in the Design Optimization
Workspace.

Compare the requirement values before and after optimization using the spider
plot.

• In the Data to Plot list, select ReqValues1.

• In the Add Plot list, select Spider plot 1.
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The optimized requirement values, ReqValues1, are all negative or zero,
indicating that all the constraints are satisfied.
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Run the Optimization (GUI)
After you specify design requirements and design variables and optionally
uncertain variables and optimization settings, you can optimize the design.

Run the optimization by clicking Optimize in the Design Optimization tool.

Simulink Design Optimization software uses optimization methods to find
parameter values that allow a feasible solution, or best fit in the case of
reference tracking, to the given constraints.To learn more about how the
software formulates the optimization problems, see “How the Optimization
Algorithm Formulates Minimization Problems” on page 3-4.

Simulink Design Optimization software begins by plotting the initial
response. During the optimization, intermediate responses are also plotted.
The plot shows the plots of the last five iterations. If you include uncertain
variables, the uncertain response signals are plotted as dashed lines, along
with the nominal response as a solid line.
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Simulink Design Optimization software changes the values of the design
variables and displays the optimization termination information in the
optimization progress window. You can click the design variable set name in
the Design Optimization Workspace to see its final value.

Note After the optimization, the values of the tuned parameters are changed
to the new optimized values. This means that if you want to run another
optimization, it uses these values of the parameters as initial values.

The Optimization Progress window displays numerical output. The form of
this output depends on the optimization method being used. To learn more,
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see “Selecting Optimization Methods” on page 3-65 and the discussion of
Display level in “Selecting Additional Optimization Options” on page 3-67.

The Gradient descent optimization method may violate the bounds on
parameter values when it cannot satisfy the design requirements and the
bounds on parameter values simultaneously. To learn how to troubleshoot
this problem, see “Troubleshooting Optimization Results” on page 3-186

Note For more information on types of problems you may encounter using
optimization solvers, see “Steps to Take After Running a Solver” in the
Optimization Toolbox documentation.

If the optimization does not converge the first time, it often converges after
adjusting the constraints or tuned parameter characteristics, or choosing
different options. For more information, see “Troubleshooting Optimization
Results” on page 3-186.
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Design Optimization to Meet Time- and Frequency-Domain
Requirements

This example shows how to tune a controller to satisfy time- and
frequency-domain design requirements using the Design Optimization tool.

The example requires Simulink Control Design™.

F-14 Longitudinal Flight Control Model

Open the Simulink model.

sys = 'sdoF14';
open_system(sys);

The F-14 model is based on the Simulink sldemo_f14 model. The model
includes:
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• Subsystems to model aircraft dynamics (Aircraft Dynamics Model), wind
gusts (Dryden Wind Gust Models), and pilot G-forces (Pilot G-force
calculation). For more information on the subsystems, see "F-14
Longitudinal Flight Control".

• A step change applied to the aircraft joystick at 1 second into the simulation
that causes the aircraft to pitch upward.

Controller Design Problem

You tune the controller gains to meet the following time- and
frequency-domain design requirements:

• Angle-of-attack alpha response to a step change in the joystick has a rise
time of less than 1 second, less than 1% overshoot, and settles to within 1%
of steady state within less than 5 seconds

• Pitch-rate control loop has good tracking below 1 rad/s and 20db noise
rejection above 100 rad/s

• Closed loop response from joystick to pilot G-Force is below 0db above 5
rad/s.

These requirements reduce the high frequency G-forces experienced by
the pilot in response to joystick changes while still maintaining flight
performance.

The model includes the following blocks (from Simulink Design Optimization™
and Simulink Control Design Model Verification libraries):

• Alpha Response specifies the alpha step response requirement.
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• Pitch Rate Loop specifies the pitch-rate performance requirement.

The linearization inputs/outputs are already selected in the Linearizations
tab. The pitch-rate loop starts from the input of the controller (the
controller error signal) and ends at the output of the pitch-rate sensor. The
angle-of-attack loop is opened signal so that the block only computes the
pitch-rate loop response. The linear system is computed at a simulation time
of 0.
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The Bounds tab specifies the following pitch-rate loop shape requirements:

• Greater than 20db over the range 0.01 rad/s to 0.1 rad/s

• Greater than 0db over the range 0.1 rad/s to 1 rad/s

• Less than -20db over the range 100 rad/s to 1000 rad/s
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• Pilot G Response specifies the G-force requirement.

The linearization inputs/outputs are already selected in the Linearizations
tab. The linear system is computed at a simulation time of 0.
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The Bounds tab specifies the G-force requirements of less than 0db over
the range 5 rad/s 100 rad/s.
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Open the Design Optimization Tool

Open the Design Optimization tool to configure and run design optimization
problems interactively. Click Response Optimization on the Block
Parameters dialog of Alpha Response, Pitch Rate Loop or Pilot G
Response block. Alternatively, type sdotool('sdoF14'). To show multiple
requirement plots at the same time, use the plot layout widgets at the
top-right of the tool.
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The tool detects the requirements specified in the Model Verification blocks
and automatically includes them as requirements to satisfy.

Specify Design Variables

Specify the following model parameters as design variables for optimization:
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• Controller gains Ki and Kf

• Pitch-rate sensor gain Kq

• Alpha sensor gain Ka

In the Design Variables Set drop-down list, select New. A dialog to select
model parameters for optimization opens.

Select Ki, Kf, Kq and Ka. Click << to add the selected parameters to the
design variables set.

Specify minimum and maximum gain values, the Ki and Kf values must
remain negative while Ka and Kq must remain positive.

Press Enter after you enter the values.

ClickOK. A new variable DesignVars appears in the SDOTOOLWorkspace.

Evaluate the Initial Design
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Click Plot Current Response to simulate the model and check how well the
initial design satisfies the design requirements.
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The plots indicate that the current design does not satisfy the pilot G-force
requirement and the alpha step response overshoot requirement is violated.

Optimize the Design

Create a plot to display how the controller variables are modified during the
optimization. In the Add plot drop-down list, select DesignVars, which
contains the optimization design variables Ki, Kf, Kq and Ka.

3-99



3 Response Optimization

Click Optimize.
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To load a pre-configured file and run the optimization, click Open in the
Design Optimization tab and select sdoF14_sdosession.mat. Alternatively
load the project by typing:

>> load sdoF14_sdosession

>> sdotool(SDOSessionData)

The optimization progress window updates at each iteration and shows that
the optimization converged after 5 iterations.

The Alpha Response and Pilot G Response plots indicate that the design
requirements are satisfied. The DesignVars plot shows that the controller
gains converged to new values.

To view the optimized design variable values, click DesignVars in the
SDOTOOL Workspace. The optimized values of the design variables are
automatically updated in the Simulink model.

% Close the model
setOption(sdotool('sdoF14'),'NoPromptClose',true)
bdclose('sdoF14')
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Design Optimization to Meet a Custom Objective Using
the GUI

This example shows how to optimize a design to meet a custom objective
using the Design Optimization tool. You optimize the cylinder parameters to
minimize the cylinder geometry and satisfy design requirements.

Hydraulic Cylinder Model

The hydraulic cylinder model is based on the Simulink model sldemo_hydcyl.
The model includes:

• Pump and Cylinder Assembly subsystems. For more information on the
subsystems, see "Single Hydraulic Cylinder Simulation".

• A step change applied to the cylinder control valve orifice area that causes
the cylinder piston position to change.

Hydraulic Cylinder Design Problem

You tune the cylinder cross-sectional area and piston spring constant to meet
the following design requirements:

• Ensure that the piston position has a step response rise time of less than
0.04 seconds and setting time of less than 0.05 seconds.

• Limit the maximum cylinder pressures to 1.75e6 N/m.

• Minimize the cylinder cross-sectional area.

Open the Design Optimization Tool

Open the Design Optimization tool to configure and run design optimization
problems interactively.

sdotool('sdoHydraulicCylinder')
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Specify Design Variables

Specify the following model parameters as design variables for optimization:

• Cylinder cross-sectional area Ac
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• Piston spring constant K

In the Design Variables Set drop-down list, select New. A dialog to select
model parameters for optimization opens.

Select Ac and K. Click <- to add the selected parameters to the design
variables set.

Limit the cylinder cross-sectional area to circular area with radius between 1
and 2 centimeters and the piston spring constant to a range of 1e4 to 10e4
N/m. To do so, specify the maximum and minimum for the corresponding
variable in the Maximum and Minimum columns.

Because the variable values are different orders of magnitude, scale Ac by
1e-3 and K by 1e5.

Press Enter after you specify the values.
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ClickOK. A new variable DesignVars appears in the SDOTOOLWorkspace.

Specify Design Requirements

The design requirements require logged model signals. During optimization,
the model is simulated using the current value of the design variables and the
logged signal is used to evaluate the design requirements.

Log the cylinder pressures, which is the first output port of the Cylinder
Assembly block.

In the New drop-down list, select Signal. A dialog to select model signals
to log opens.
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Enter Pressures as the signal name in the Signal set field. Then, in the
Simulink model, click the first output port of the Cylinder Assembly block
named Pressure. The dialog updates to display the selected signal.

Select the signal in the dialog and click -> to add it to the signal set.

Click OK. A new variable Pressures appears in the SDOTOOL Workspace.

Similarly, log the piston position, which is the second output of the Cylinder
Assembly block, in a variable named PistonPosition.
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Specify the maximum cylinder pressure requirement of less than 1.75e6 N/m.

In the New drop-down list, select Signal Bound. A dialog to create a signal
bound requirement opens.
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In the Amplitude columns, enter the maximum pressure requirement of
1.75e6 N/m and Requirement Name as MaxPressure. In the Select Model
Signals area, select Pressures, the signal on which this requirement applies.
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Click OK.

• A new MaxPressure variable appears in the SDOTOOL Workspace.

• A graphical view of the maximum pressure requirement is automatically
created.
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Specify the piston position step response requirement of rise time of less than
0.04 seconds and a settling time of less than 0.05 seconds.

In the New drop-down list of the Response Optimization tab, select Step
Response Envelope. A dialog to create a step response requirement opens.
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Specify a requirement name PistonResponse, the required rise and settling
time bounds. Select PistonPosition as the signal to apply the step response
requirement to.

Click OK.

Specify Custom Objective

The custom objective is to minimize the cylinder cross-sectional area.

In the New drop-down list, select Custom Requirement. A dialog to create
custom requirement opens.
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Specify a function to call during optimization in the Requirement
function field. At each optimization iteration, the software calls the
function and passes the current design variable values. You can also
optionally pass logged signals to the custom requirement. Here, you use
sdoHydraulicCylinder_customObjective as the custom requirement
function, which returns the value of the cylinder cross-sectional area.

In the Requirement type drop-down list, specify whether the requirement is
an objective to minimize (min), an inequality constraint (<=), or an equality
constraint (==).
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type sdoHydraulicCylinder_customObjective

function objective = sdoHydraulicCylinder_customObjective(data)
%SDOHYDRAULICCYLINDER_CUSTOMOBJECTIVE
%
% The sdoHydraulicCylinder_customObjective function is used to define a
% custom requirement that can be used in the graphical SDTOOL environment.
%
% The |data| input argument is a structure with fields containing the
% design variable values chosen by the optimizer.
%
% The |objective| return argument is the objective value to be minimized by
% the SDOTOOL optimization solver.
%

% Copyright 2011 The MathWorks, Inc.
% $Revision: 1.1.8.1 $ $Date: 2011/05/09 01:20:51 $

%For the cylinder design problem we want to minimize the cylinder
%cross-sectional area so return the cylinder cross-sectional area as an
%objective value.
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Ac = data.DesignVars(1);
objective = Ac.Value;
end

Evaluate the Initial Design

Click Plot Current Response to simulate the model and check how well the
initial design satisfies the design requirements. To show both requirement
plots at the same time, use the plot layout widgets at the top-right of the tool.
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From the plots, see that the maximum pressure requirement is satisfied but
the piston position step response requirement is not satisfied.

Optimize the Design
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Create a plot to display how the cylinder cross-sectional area and piston
spring constant are modified during optimization.

In the Add plot drop-down list, select DesignVars, which contains the
optimization design variables Ac and K.
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Click Optimize.
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The optimization progress window updates at each iteration and shows that
the optimization converged after 5 iterations.

The Pressures and PistonPosition plots indicate that the design
requirements are satisfied. The DesignVars plot shows that the cylinder
cross-sectional area Ac is minimized.

To view the optimized design variable values, click the variable name in the
SDOTOOL Workspace. The optimized values of the design variables are
automatically updated in the Simulink model.

Related Examples

To learn how to optimize the cylinder design using the sdo.optimize
command, see "Design Optimization to Meet Custom Objective at the
Command Line".

% Close the model
setOption(sdotool('sdoHydraulicCylinder'),'NoPromptClose',true)
bdclose('sdoHydraulicCylinder')
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Design Optimization to Meet a Custom Objective at the
Command Line

This example shows how to optimize a design to meet custom objective
using sdo.optimize. You optimize the cylinder parameters to minimize the
cylinder geometry and satisfy design requirements.

Hydraulic Cylinder Model

Open the Simulink model.

sys = 'sdoHydraulicCylinder';
open_system(sys);

The hydraulic cylinder model is based on the Simulink model sldemo_hydcyl.
The model includes:

• Pump and Cylinder Assembly subsystems. For more information on the
subsystems, see "Single Hydraulic Cylinder Simulation".

• A step change applied to the cylinder control valve orifice area that causes
the cylinder piston position to change.

Hydraulic Cylinder Design Problem
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You tune the cylinder cross-sectional area and piston spring constant to meet
the following design requirements:

• Ensure that the piston position has a step response rise time of less than
0.04 seconds and setting time of less than 0.05 seconds.

• Limit the maximum cylinder pressures to 1.75e6 N/m.

• Minimize the cylinder cross-sectional area.

Specify Design Variables

Select the following model parameters as design variables for optimization:

• Cylinder cross-sectional area Ac

• Piston spring constant K

Ac = sdo.getParameterFromModel('sdoHydraulicCylinder','Ac');
K = sdo.getParameterFromModel('sdoHydraulicCylinder','K');

Limit the cylinder cross-sectional area to a circular area with radius between
1 and 2 centimeters.

Ac.Minimum = pi*1e-2^2; % m^2
Ac.Maximum = pi*2e-2^2; % m^2

Limit the piston spring constant to a range of 1e4 to 10e4 N/m.

K.Minimum = 1e4; % N/m
K.Maximum = 10e4; % N/m

Specify Design Requirements

The design requirements require logged model signals. During optimization,
the model is simulated using the current value of the design variables and the
logged signal is used to evaluate the design requirements.

Log the following signals:
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• Cylinder pressures, available at the first output port of the Cylinder
Assembly block

Pressures = Simulink.SimulationData.SignalLoggingInfo;
Pressures.BlockPath = 'sdoHydraulicCylinder/Cylinder Assembly';
Pressures.OutputPortIndex = 1;

• Piston position, available at the second output port of the Cylinder
Assembly block

PistonPosition = Simulink.SimulationData.SignalLoggingInfo;
PistonPosition.BlockPath = 'sdoHydraulicCylinder/Cylinder Assembly';
PistonPosition.OutputPortIndex = 2;

Create an object to store the logging information and use later to simulate
the model

simulator = sdo.SimulationTest('sdoHydraulicCylinder');
simulator.LoggingInfo.Signals = [PistonPosition,Pressures];

Specify the piston position step response requirement of rise time of less than
0.04 seconds and settling time less than of 0.05 seconds.

PistonResponse = sdo.requirements.StepResponseEnvelope;
set(PistonResponse, ...

'RiseTime', 0.04, ...
'FinalValue', 0.04, ...
'SettlingTime', 0.05, ...
'PercentSettling', 1);

Specify the maximum cylinder pressure requirement of less than 1.75e6 N/m.

MaxPressure = sdo.requirements.SignalBound;
set(MaxPressure, ...

'BoundTimes', [0 0.1], ...
'BoundMagnitudes', [1.75e6 1.75e6], ...
'Type', '<=');

For convenience, collect the performance requirements into a single structure
to use later.
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requirements = struct(...
'PistonResponse', PistonResponse, ...
'MaxPressure', MaxPressure);

Create Objective/Constraint Function

To optimize the cylinder cross-sectional area and piston spring constant,
create a function to evaluate the cylinder design. This function is called at
each optimization iteration.

Here, use an anonymous function with one argument that calls the
sdoHydraulicCylinder_design function.

evalDesign = @(p) sdoHydraulicCylinder_design(p,simulator,requirements);

The function:

• Has one input argument that specifies the cylinder cross-sectional area
and piston spring constant values.

• Returns the optimization objective value and optimization constraint
violation values.

The optimization solver minimizes the objective value and attempts
to keep the optimization constraint violation values negative. Type
help sdoExampleCostFunction for more details on how to write the
objective/constraint function.

The sdoHydraulicCylinder_design function uses the simulator
and requirements objects to evaluate the design. Type edit
sdoHydraulicCylinder_design to examine the function in more detail.

type sdoHydraulicCylinder_design

function design = sdoHydraulicCylinder_design(p,simulator,requirements)
%SDOHYDRAULICCYLINDER_DESIGN
%
% The sdoHydraulicCylinder_design function is used to evaluate a cylinder
% design.
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%
% The |p| input argument is the vector of cylinder design parameters.
%
% The |simulator| input argument is a sdo.SimulinkTest object used to
% simulate the |sdoHydraulicCylinder| model and log simulation signals
%
% The |requirements| input argument contains the design requirements used
% to evaluate the cylinder design
%
% The |design| return argument contains information about the design
% evaluation that can be used by the |sdo.optimize| function to optimize
% the design.
%
% see also sdo.optimize, sdoExampleCostFunction

% Copyright 2011 The MathWorks, Inc.
% $Revision: 1.1.8.2 $ $Date: 2011/06/30 16:51:02 $

%% Simulate the model
%
% Use the simulator input argument to simulate the model and log model
% signals.
%
% First ensure that we simulate the model with the parameter values chosen
% by the optimizer.
%
simulator.Parameters = p;
% Simulate the model and log signals.
%
simulator = sim(simulator);
% Get the simulation signal log, the simulation log name is defined by the
% model |SignalLoggingName| property
%
logName = get_param('sdoHydraulicCylinder','SignalLoggingName');
simLog = get(simulator.LoggedData,logName);

%% Evaluate the design requirements
%
% Use the requirements input argument to evaluate the design requirements
%
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% Check the PistonPosition signal against the stepresponse requirement
%
PistonPosition = get(simLog,'PistonPosition');
cPiston = evalRequirement(requirements.PistonResponse,PistonPosition.Values
% Check the Pressure signals against the maximum requirement
%
Pressures = find(simLog,'Pressures');
cPressure = evalRequirement(requirements.MaxPressure,Pressures.Values);
% Use the PistonResponse and MaxPressure requirements as non-linear
% constraints for optimization.
design.Cleq = [cPiston(:);cPressure(:)];
% Add design objective to minimize the Cylinder cross-sectional area
Ac = p(1); %Since we called sdo.optimize(evalDesign,[Ac;K])
design.F = Ac.Value;
end

Evaluate the Initial Design

Call the objective function with the initial cylinder cross-sectional area and
initial piston spring constant.

initDesign = evalDesign([Ac;K]);

The function simulates the model and evaluates the design requirements.
The scope shows that the maximum pressure requirement is satisfied but the
piston position step response requirement is not satisfied.

initDesign is a structure with the following fields:

• Cleq shows that some of the inequality constraints are positive indicating
they are not satisfied by the initial design.

initDesign.Cleq

ans =

-0.3839
-0.1861
-0.1836
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-1.0000
0.3033
0.2909
0.1671
0.2326

-0.0480
-0.0480

• F shows the optimization objective value (in this case the cylinder
cross-sectional area). The initial design cross-sectional area, as expected,
has the same value as the initial cross-sectional area parameter Ac.

initDesign.F

ans =

1.0000e-03

Optimize the Design

Pass the objective function, initial cross-sectional area and piston spring
constant values to sdo.optimize.

[pOpt,optInfo] = sdo.optimize(evalDesign,[Ac;K]);

Optimization started 04-Jan-2012 12:33:08

max Line search Directional First-o
Iter F-count f(x) constraint Steplength derivative optimal

0 5 0.001 0.3033
1 10 0.000390105 3.762 0.696 -0.000876 0.001
2 15 0.000462964 0.348 0.106 0.000689 0.003
3 20 0.000509424 0.04789 0.0706 0.000658 0.01
4 25 0.000503622 0.001654 0.0109 -0.000531 0.05
5 30 0.000500809 0.0004008 0.00197 -0.00143 0.001

Local minimum possible. Constraints satisfied.
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fmincon stopped because the size of the current search direction is less th
twice the selected value of the step size tolerance and constraints are
satisfied to within the selected value of the constraint tolerance.

The optimization repeatedly evaluates the cylinder design by adjusting
the cross-sectional area and piston spring constant to meet the design
requirements. From the scope, see that the maximum pressure and piston
response requirements are met.

The sdo.optimize function returns:

• pOpt shows the optimized cross-sectional area and piston spring constant
values.

pOpt

pOpt(1,1) =

Name: 'Ac'
Value: 5.0081e-04

Minimum: 3.1416e-04
Maximum: 0.0013

Free: 1
Scale: 0.0020
Info: [1x1 struct]

pOpt(2,1) =

Name: 'K'
Value: 2.0651e+04

Minimum: 10000
Maximum: 100000

Free: 1
Scale: 65536
Info: [1x1 struct]
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2x1 param.Continuous

• optInfo is a structure that contains optimization termination information
such as number of optimization iterations and the optimized design.

optInfo

optInfo =

Cleq: [10x1 double]
F: 5.0081e-04

Gradients: [1x1 struct]
exitflag: 4

iterations: 5
SolverOutput: [1x1 struct]

Stats: [1x1 struct]

For example, the Cleq field shows the optimized non-linear inequality
constraints are all non-positive to with-in optimization tolerances, indicating
that the maximum pressure and piston response requirements are satisfied.

optInfo.Cleq

ans =

-0.1093
0.0003
0.0003

-1.0000
-0.1186
0.0004

-0.0205
0.0002

-0.0476
-0.0476
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The F field contains the optimized cross-sectional area. The optimized
cross-sectional area value is nearly 50% less that the initial value.

optInfo.F

ans =

5.0081e-04

Update the Model Variable Values

By default, the model variables Ac and K are not updated at the end of
optimization. Use the setValueInModel command to update the model
variable values.

sdo.setValueInModel('sdoHydraulicCylinder',pOpt)

Related Examples

To learn how to optimize the cylinder design using the Design Optimization
tool, see "Design Optimization to Meet Custom Objective Using the Design
Optimization Tool".

% Close the model
bdclose('sdoHydraulicCylinder')
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Design Optimization to Meet Custom Signal Requirements
(GUI)

This example shows how to optimize a design to meet a custom signal
requirement. You optimize the controller parameters to minimize the plant
actuation signal energy while satisfying step response requirements.

1 Load a saved Design Optimization tool session.

load sldo_model1_custom_signal_session
sdotool(SDOSessionData);

The following Simulink model opens.

The Design Optimization tool, configured with the following settings, also
opens:

• Step response characteristics, specified on the output of the Plant block,
that the model output must satisfy:

– Maximum overshoot of 5%

– Maximum rise time of 10 seconds
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– Maximum settling time of 30 seconds

• Design variable set with the controller parameters Kp, Ki and Kd. These
parameters have a minimum value of 0.

• The variables for step requirement (PlantResponse), logged signal
(PlantOutput) and design variables (DesignVars) which appear in the
Design Optimization Workspace.

2 Specify a signal to log. You apply the custom requirement on this logged
signal.
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a Select New > Signal.

A window opens where you select a signal to log.

b In the Simulink model window, click the output of the Controller block.

The window updates to display the selected signal.

c Select the signal and click to add it to the signal set.

d In Signal set, enter PlantActuator.

Click OK. A new variable PlantActuator appears in the Design
Optimization Workspace of the Design Optimization tool window.

3 Specify the custom requirement to apply to the signal.

The custom requirement calls the objective function
sldo_model1_minimize_energy which returns the energy in the
PlantActuator signal. The signal energy is minimized. This function
accepts:

• An input argument data which is a structure with fields for the design
variables in the Design Optimization Workspace. Signals are logged
for the nominal and uncertain parameter values if there are any.

• Returns the objective value to be minimized.

Tip Type type sldo_model1_minimize_energy to see the contents of this
function.

a Select New > Custom Requirement.

A window opens where you specify the custom requirement.

b Specify MinimizeEnergy as the Requirement Name.

c Specify @sldo_model1_minimize_energy as the Requirement
function.

d Select min as the Requirement type.
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4 In the Select Model Signals area, select the PlantActuator check box to
associate the custom requirement with that signal.

Click OK. A new variable appears in the Design Optimization
Workspace. The window also updates to graphically display the custom
signal requirement.

5 Click Optimize.
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After a few iterations, the optimization converges to meet both the custom
signal and step response requirements.

6 Close the model.

setOption(sdotool('sldo_model1'),'NoPromptClose',true)
bdclose('sldo_model1')
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Design Optimization to Meet Frequency-Domain
Requirements

This example shows how to tune model parameters to meet frequency-domain
requirements using the Design Optimization tool.

The example requires Simulink Control Design™

Mass-Spring-Damper Model

Open the Simulink Model.

open_system('sdoMassSpringDamper')

Mass-spring-damper models represent simple suspension systems
and for this example we tune the system to meet typical suspension
requirements. The model implements the second order system representing a
mass-spring-damper using Simulink blocks and includes:
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• a Mass gain block parameterized by the total suspended mass, m0+mload.
The total mass is the sum of a nominal mass m0 and a variable load mass
mLoad.

• a Damper gain block parameterized by the damping coefficient, b.

• a Spring gain block parameterized by the spring constant, k.

• two integrator blocks to compute the mass velocity and position.

• a Band-Limited Disturbance Force block applying a disturbance force to
the Mass. The disturbance force is assumed to be band-limited white noise.

Simulate the model to view the system response to the applied disturbance
force.

Design Problem

The initial system has a bandwidth that is too high. This can be seen from
the spiky position signal. You tune the spring and damper values to meet
the following requirements:

• The -3dB system bandwidth must not exceed 10 rad/s.
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• The damping ratio of the system must be less than 1/sqrt(2). This ensures
that no frequencies in pass band are amplified by the system.

• Minimize the expected failure rate of the system. The expected failure
rate is described by a Weibull distribution dependent on the mass, spring,
and damper values.

• These requirements must all be satisfied as the load mass ranges from
0 to 20.

Open the Design Optimization Tool

In the Simulink model Tools menu, select Response Optimization.

Specify Design Variables

In the Design Variables Set list, select New. Add the b and k model
variables to the design variable set.

• Specify the Minimum and Maximum values for the b variable as 100 and
10000 respectively.

• Specify the Minimum and Maximum values for the k variable as 10000 and
100000 respectively.
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Click OK. A new variable, DesignVars, appears in the Design Optimization
Workspace.

In the Uncertain Variables Set list, select New. Add the mLoad variable to
the uncertain variables set.

• Specify the Uncertain Values value for the mLoad variable as [10 15 20]

Click OK. A new variable, UncVars, appears in the Design Optimization
Workspace.

Specify Linear Analysis Input/Output Points

Specify the input/output points defining the linear system used to compute
the bandwidth and damping ratio.

To specify the input/output points:

• In the New list, select Linearization I/Os.
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• In the Simulink model, click the signal at the output of the Band-Limited
Disturbance Force block. The Create linearization I/O set dialog box
is updated and the chosen signal appears in it.

• In the Create linearization I/O dialog box, select the signal and click
Add.

• In the Configuration list for the selected signal, choose Input to specify
it as an input signal.

• Similarly, add the pos signal from the Simulink model. Specify this signal
as an output. In the Configuration list, select Output.
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• Click OK. A new variable, IOs, appears in the Design Optimization
Workspace.

Add Bandwidth and Damping-Ratio Requirements

Tune the spring and damper values to satisfy bandwidth and damping ratio
requirements.

To specify the bandwidth requirement:

• Open a dialog to specify bounds on the Bode magnitude. In the New list,
select Bode Magnitude.

• Specify the requirement name as Bandwidth.

• Specify the edge start frequency and magnitude as 10 rad/s and -3db,
respectively.
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• Specify the edge end frequency and magnitude as 100 rad/s and -3db,
respectively.

• Specify the input/output set to which the requirement applies by clicking
Select Systems to Bound. Select the IOs check box .

• Click OK. A new requirement, Bandwidth, appears in the Design
Optimization Workspace and a graphical view of the bandwidth
requirement is automatically created.

To specify the damping ratio requirement:
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• Open a dialog to specify bounds on the damping ratio. In the New list,
select Damping Ratio.

• Specify the damping ratio bound value as 0.7071.

• Specify the input/output set to which the requirement applies by clicking
Select Systems to Bound. Select the IOs check box .

• Click OK. A new requirement, DampingRatio, appears in the Design
Optimization Workspace and a graphical view of the damping ratio
requirement is automatically created.

Add a Reliability Requirement

Tune the spring and damper values to minimize the expected failure rate
over a lifetime of 100e3 miles. The failure rate is computed using a Weibull
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distribution on the damping ratio of the system. As the damping ratio
increases the failure rate is expected to increase.

Specify the reliability requirement as a custom requirement:

• Open a dialog box to specify the custom requirements. In the New list,
select Custom Requirement.

• Specify the custom requirement name as MinFailureRate.

• In the Specify Function area, select Minimize the function output
from the Type list.

• Specify the function as @sdoMSD_FailureRate.

• Click OK. A new requirement, MinFailureRate, appears in the Design
Optimization Workspace and a graphical view of the custom requirement
is automatically created.

The @sdoMSD_FailureRate function returns expected mass-spring-damper
failure rate for a lifetime of 100e3 miles.
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type sdoMSD_FailureRate

function pFailure = sdoMSD_FailureRate(data)
%SDOMSD_FAILURERATE
%
% The sdoMSD_FailureRate function is used to define a custom requirement
% that can be used in the graphical SDTOOL environment.
%
% The |data| input argument is a structure with fields containing the
% design variable values chosen by the optimizer.
%
% The |pFailure| return argument is the failure rate to be minimized by the
% SDOTOOL optimization solver. The failure rate is given by a Weibull
% distribution that is a function of the mass, spring and damper values.
% The design minimizes the failure rate for a 100e3 mile lifetime.
%

% Copyright 2011 The MathWorks, Inc.
% $Revision: 1.1.8.1 $ $Date: 2011/11/17 21:29:26 $

%Get the spring and damper design values
allVarNames = {data.DesignVars.Name};
idx = strcmp(allVarNames,'k');
k = data.DesignVars(idx).Value;
idx = strcmp(allVarNames,'b');
b = data.DesignVars(idx).Value;

%Get the nominal mass from the model
m = slResolve('m0','sdoMassSpringDamper');

%The expected failure rate is defined by the Weibull cumulative
%distribution function, 1-exp(-(x/l)^k), where k=3, l is a function of the
%mass, spring and damper values, and x the lifetime.
d = b/2/sqrt(m*k);
pFailure = 1-exp(-(100e3*d/250e3)^3);
end

Optimize the Design
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Before running the optimization be sure to have completed the earlier steps.
Alternatively, you can load the sdoMassSpringDamper_sdosession from the
model workspace into the Design Optimization tool.

To save the initial design variable values and later compare them with the
optimized values configure the optimization.

• Click Options.

• Select the Save optimized variable values as new design variable
set option.

To study how the design variable values change during optimization:

• In the Data to Plot list, select DesignVars.

• In the Add Plot list, and select Iteration Plot.

• View the design variables in an appropriately scaled manner. Right-click
on the DesignVars plot and select Show scaled values.

To evaluate the requirements at the initial design point, click Evaluate
Requirements . The requirement plots are updated and a ReqValues
variable is added to the Design Optimization Workspace.
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To optimize the design, click Optimize. The plots are updated during
optimization. At the end of optimization, the optimal design values are
written to the DesignVars1 variable. The requirement values for the
optimized design are written to the ReqValues1 variable.
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Analyze the Design

To compare design variables before and after optimization:

• In the Data to Plot list, select DesignVars.

• In the Add Plot list, select Spider Plot.

• To add the optimized design variables to the same plot, select DesignVars1
in the Design Optimization Workspace and drag it onto the Spider plot.
Alternatively, in the Data to Plot list, select DesignVars1. Then, in the
Add Plot list, select Spider plot 1 from the Add to Existing Plot section.
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The plot shows that the optimizer reduced both the k and b values for the
optimal design.

To compare requirements before and after optimization:

• In the Data to Plot list, select ReqValues.

• In the Add Plot list, select Spider Plot.

• To add the optimized requirement values to the same plot, select
ReqValues1 in the Design Optimization Workspace and drag it onto
the Spider plot. Alternatively, in the Data to Plot list, select ReqValues1.
Then, in the Add Plot list, select Spider plot 2 from the Add to Existing
Plot section.
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The plot shows that the optimal design has a lower failure rate (the
MinFailureRate axis) and better satisfies the bandwidth requirement. The
value plotted on the bandwidth axis is the difference between the bandwidth
bound and the bandwidth value. The optimization satisfies the bound
by keeping this value negative; a more negative value indicates better
satisfaction of the bound.

The improved reliability and bandwidth are achieved by pushing the damping
ratio closer to the damping ratio bound. The plot has two axes for the damping
ratio requirement, one for each system pole, and the plotted values are the
difference between the damping ratio bound and the damping ratio value. The
optimization satisfies the bound by keeping this value negative.

Finally the simulated mass position is smoother than the initial position
response (indication of a lower bandwidth as required) at the expense of
larger position deflection.

% Close the model
bdclose('sdoMassSpringDamper')
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Optimizing Parameters for Robustness

In this section...

“What Is Robustness?” on page 3-157

“Sampling Methods for Uncertain Parameters” on page 3-158

“Optimize Parameters for Robustness (GUI)” on page 3-162

What Is Robustness?
A design is robust when it’s response does not violate design requirements
under model parameter variations. Your model may contain parameters
whose values are not precisely known. Such parameters vary over a given
range of values and are defined as uncertain parameters. You may know the
nominal value and the range of values in which these uncertain parameters
vary.

You can use Simulink Design Optimization software to incorporate the
parameter uncertainty to test the robustness of your design. When you
optimize parameters for robustness, the optimization solver uses the
responses computed using all the uncertain parameter values to adjust the
design variable values.

You can specify the same parameter both as a design and uncertain variable.
However, you cannot use a parameter both as a design and uncertain variable
in the same optimization run. Also, you cannot add uncertainty to controller
or plant parameters during optimization-based control design in the SISO
Design Tool.

The uncertain variables can be scalar, vector, matrix or an expression.

You can test and optimize parameters for model robustness in the following
ways:

• Before Optimization. Specify the parameter uncertainty before you
optimize the parameters to meet the design requirements. In this case,
the optimization method optimizes the signals based on both nominal
parameter values as well as the uncertain values. This mode requires
more computational time.
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• After Optimization. Specify the parameter uncertainty after you have
optimized the model parameters to meet design requirements. You can
then test the effect of the uncertain parameters by plotting the model’s
response. If the response violates the design requirements, you can
optimize the parameters again by including the parameter uncertainty
during the optimization.

Related Examples

“Optimize Parameters for Robustness (GUI)” on page 3-162

More About

“Sampling Methods for Uncertain Parameters” on page 3-158

Sampling Methods for Uncertain Parameters
Sample values for uncertain parameters are a vector of numerical values. You
can specify the vector yourself or generate a vector of random numbers using
the software. The sample values you specify can be uniformly distributed or
random. For example, four sample values for two uncertain parameters a and
b in the range [0 3] and [1 2.5] may look like the following figure.
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�
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There are two methods to determine the number of sample values to use
during optimization:

• Only the combination of minimum and maximum values (circled)

	




� �

�

�
�

• Combination of the entire set of values (all solid dots in the previous figure)

Tip Using only the minimum and maximum values during optimization
increases the computation speed when compared to using the entire set of
values.

For the previous example, there are 4 combinations using the minimum and
maximum values and 16 combinations if you use all sample values.

In the Design Optimization tool, you specify the sampling method using the
options as shown in the following figure.
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Related Examples

“Optimize Parameters for Robustness (GUI)” on page 3-162

More About

• “What Is Robustness?” on page 3-157
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Optimize Parameters for Robustness (GUI)
This example shows how to optimize parameters for model robustness.

1 Load a saved Design Optimization tool session.

load sldo_model1_desreq_optim_sdosession;
sdotool(SDOSessionData);

The following Simulink model opens.

The Simulink model parameters Kp, Ki and Kd have already been optimized
to meet the following step response requirements:

• Maximum overshoot of 5%

• Maximum rise time of 10 seconds

• Maximum settling time of 30 seconds

The command also opens the Design Optimization tool.
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2 Specify parameter uncertainty.

a In the Uncertain Variables Set drop-down list, select New.

A window opens where you specify uncertain variables.

b Click w0 and zeta to select them.

c Click to add the selected parameters to an uncertain variables
set.
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The software displays the following parameter settings:

• Variable — Parameter name

• Nominal Value— Nominal value of the parameters as specified in
the Simulink model

• Uncertain Values— Values that the uncertain parameter can take.
By default, the maximum and minimum values vary by 10% of the
nominal value.

The total number of sample values to use during optimization is a
combination of the maximum and minimum values of the uncertain
parameters.

The check-box indicates that the parameter is included in the uncertain
variable set. The default uncertain variable set name is UncVars.

Click OK. A new variable UncVars appears in Design Optimization
Workspace of the Design Optimization tool.
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Specify Random Values

Instead of specifying sample values, you can auto-generate random
values in a specific range. Select a parameter and click Set Uncertain
Values.

A window opens where you specify the range and the number of samples.

3 Test the model robustness to the uncertain parameters.

a In the Add Plot drop-down list, select
sldo_model1_desreq_optim_Step Response.
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A plot window displaying the requirements specified in the Step
Response block in the model opens.

b Click Plot Current Response.

The plot updates.
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• The solid curve corresponds to the model response computed using the
optimized parameters and nominal values of the uncertain parameter.

• The four dashed curves correspond to the model response with the
minimum and maximum values of the uncertain parameters.

The dashed plot lines show that the response during the period of 10
to 20 seconds violates the design requirements.

4 Optimize the parameters for model robustness. Click Optimize.

3-168



Optimizing Parameters for Robustness

The Optimization Progress window opens which displays the optimization
iterations.

After the optimization completes, the message Optimization converged
indicates that the final model response computed by varying the uncertain
parameters meets the specified design requirements.

5 Examine the responses.
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Tip To view only the final responses of the model, right-click the white
area in the plot and uncheck Responses > Show Iteration Responses.

The final responses appear as the thick solid and dashed curves. The
nominal and uncertain responses with parameter variations now meet the
design requirements.

More About

• “What Is Robustness?” on page 3-157

• “Sampling Methods for Uncertain Parameters” on page 3-158
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Accelerating Model Simulations During Optimization

In this section...

“About Accelerating Optimization” on page 3-171

“Limitations” on page 3-171

“Setting Accelerator Mode for Response Optimization” on page 3-171

About Accelerating Optimization
You can accelerate the response optimization computations by changing the
simulation mode of your Simulink model. Simulink Design Optimization
software supports Normal and Accelerator simulation modes. For more
information about these modes, see “Accelerating Models” in the Simulink
documentation.

The default simulation mode is Normal. In this mode, Simulink uses
interpreted code, rather than compiled C code during simulations.

In the Accelerator mode, Simulink Design Optimization software runs
simulations during optimization with compiled C code. Using compiled C
code speeds up the simulations and reduces the time to optimize the model
response signals.

Limitations
You cannot use the Accelerator mode if your model contains algebraic loops.
If the model contains MATLAB function blocks, you must either remove them
or replace them with Fcn blocks.

If the model structure changes during optimization, the model is compiled
to regenerate the C code for each iteration. Using the Accelerator mode
increases the computation time. To learn more about code regeneration, see
“Code Regeneration in Accelerated Models” in the Simulink documentation.

Setting Accelerator Mode for Response Optimization
To set the simulation mode to Accelerator, open the Simulink model window
and perform one of the following actions:
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• Select Simulation > Accelerator.

• Choose Accelerator from the drop-down list as shown in the next figure.

Tip To obtain the maximum performance from the Accelerator mode,
close all Scope blocks in your model.
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Speedup Using Parallel Computing

In this section...

“When to Use Parallel Computing for Response Optimization” on page 3-173

“How Parallel Computing Speeds Up Optimization” on page 3-174

When to Use Parallel Computing for Response
Optimization
You can use Simulink Design Optimization software with Parallel Computing
Toolbox software to speed up the time-domain response optimization of
a Simulink model. Using parallel computing may reduce your model’s
optimization time in the following cases:

• The model contains a large number of tuned parameters, and the Gradient
descent method is selected for optimization.

• The Pattern search method is selected for optimization.

• The model contains a large number of uncertain parameters and uncertain
parameter values.

• The model is complex and takes a long time to simulate.

When you use parallel computing, Simulink Design Optimization software
distributes independent simulations to run them in parallel on multiple
MATLAB sessions, also known as workers. Distributing the simulations
significantly reduces the optimization time because the time required
to simulate the model dominates the total optimization time. For more
information on how the software distributes the simulations and the expected
speedup, see “How Parallel Computing Speeds Up Optimization” on page
3-174.

See “How to Use Parallel Computing” on page 3-178 for more information on
how to configure your system, and use parallel computing.
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How Parallel Computing Speeds Up Optimization
You can enable parallel computing with the Gradient descent and Pattern
search optimization methods in the Simulink Design Optimization software.
When you enable parallel computing, Simulink Design Optimization software
distributes independent simulations during optimization on multiple
MATLAB sessions. The following topics describe which simulations are
distributed and the expected speedup using parallel computing:

• “Parallel Computing with the Gradient descent Method” on page 3-174

• “Parallel Computing with the Pattern search Method” on page 3-175

Parallel Computing with the Gradient descent Method
When you select Gradient descent as the optimization method, the model
is simulated during the following computations:

• Constraint and objective value computation — One simulation per iteration

• Constraint and objective gradient computations — Two simulations for
every tuned parameter per iteration

• Line search computations — Multiple simulations per iteration

The total time, Ttotal , taken per iteration to perform these simulations is
given by the following equation:

T T N T N T T N Ntotal p ls p ls= + × + × = × + ×× +( )) ( ) ( ( )( )2 1 2

where T is the time taken to simulate the model and is assumed to be equal

for all simulations, Np is the number of tuned parameters, and Nls is the
number of line searches.

When you use parallel computing, Simulink Design Optimization software
distributes the simulations required for constraint and objective gradient
computations. The simulation time taken per iteration when the gradient

computations are performed in parallel, TtotalP , is approximately given by
the following equation:

T T ceil
N
N

T N T T ceil
N
N

totalP
p

w
ls

p

w
= + ⎛

⎝⎜
⎞
⎠⎟

× × + × = × + × ⎛
⎝⎜

⎞( ) ( ) (2 1 2
⎠⎠⎟

+ Nls)

3-174



Speedup Using Parallel Computing

where Nw is the number of MATLAB workers.

Note The equation does not include the time overheads associated with
configuring the system for parallel computing and loading Simulink software
on the remote MATLAB workers.

The expected speedup for the total optimization time is given by the following
equation:
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For a demo on the performance improvement achieved with the Gradient
descent method, see the Improving Optimization Performance Using Parallel
Computing demo.

Parallel Computing with the Pattern search Method
The Pattern search optimization method uses search and poll sets to create
and compute a set of candidate solutions at each optimization iteration.

The total time, Ttotal , taken per iteration to perform these simulations, is
given by the following equation:

T T N N T N N T N N Ntotal p ss p ps p ss ps= × × + × × = × × +( ( ( )) )

where T is the time taken to simulate the model and is assumed to be equal

for all simulations, Np is the number of tuned parameters, Nss is a factor for

the search set size, and Nps is a factor for the poll set size.
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When you use parallel computing, Simulink Design Optimization software
distributes the simulations required for the search and poll set computations,
which are evaluated in separate parfor loops. The simulation time taken per

iteration when the search and poll sets are computed in parallel, TtotalP ,
is given by the following equation:

T T ceil N
N
N

T ceil N
N
N

T ceil N
N

totalP p
ss

w
p

ps

w

p

= × × + × ×

= × ×

( ( )) ( ( ))

( (
sss

w
p

ps

wN
ceil N

N
N

) ( ))+ ×

where Nw is the number of MATLAB workers.

Note The equation does not include the time overheads associated with
configuring the system for parallel computing and loading Simulink software
on the remote MATLAB workers.

The expected speed up for the total optimization time is given by the following
equation:
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For example, for a model with Np=3, Nw=4, Nss=15, and Nps=2, the expected
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Note Using the Pattern search method with parallel computing may not
speed up the optimization time. To learn more, see “Why do I not see the
optimization speedup I expected using parallel computing?” on page 3-191 in
“Troubleshooting Optimization Results” on page 3-186.
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For a demo on the performance improvement achieved with the Pattern
search method, see the Improving Optimization Performance Using Parallel
Computing demo.
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How to Use Parallel Computing

In this section...

“Configure Your System for Parallel Computing” on page 3-178

“Specify Model Dependencies” on page 3-179

“Optimize Design Using Parallel Computing (GUI)” on page 3-180

“Optimize Design Using Parallel Computing (Code)” on page 3-184

Configure Your System for Parallel Computing
To use parallel computing, you must first configure your system as described
in the following topics:

• “Configuring Parallel Computing on Multicore Processors” on page 3-178

• “Configuring Parallel Computing on Multiprocessor Networks” on page
3-178

After you configure your system for parallel computing, you can use the
GUI or the command-line functions to optimize the model’s response using
parallel computing.

Configuring Parallel Computing on Multicore Processors
With a basic Parallel Computing Toolbox license, you can establish a pool of
up to four parallel MATLAB sessions in addition to the MATLAB client.

To start a pool of four MATLAB sessions in local configuration, type the
following at the MATLAB prompt:

matlabpool open local

To learn more, see the matlabpool reference page in the Parallel Computing
Toolbox documentation.

Configuring Parallel Computing on Multiprocessor Networks
To use parallel computing on a multiprocessor network, you must have
the Parallel Computing Toolbox software and the MATLAB Distributed
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Computing Server software. To learn more, see the Parallel Computing
Toolbox and MATLAB Distributed Computing Server documentation.

To configure a multiprocessor network for parallel computing:

1 Create a user configuration file to include any model file dependencies, as
described in “Define Cluster Profiles” and FileDependencies reference page
in the Parallel Computing Toolbox documentation.

2 Open the pool of MATLAB workers using the user configuration file,
as described in “Apply Cluster Profiles in Client Code” in the Parallel
Computing Toolbox documentation.

Opening the pool allows the remote workers to access the file dependencies
included in the user configuration file.

Specify Model Dependencies
Model dependencies are files, such as referenced models, data files and
S-functions, without which a model cannot run. When you use parallel
computing, Simulink Design Optimization software helps you identify model
path dependencies. To do so, the software uses the Simulink Manifest Tools.
The dependency analysis may not find all the files required by your model.
For example, folder paths that contain code for your model or block callback.
To learn more, see the “Scope of Dependency Analysis” in the Simulink
documentation.

Before you start the optimization using parallel computing, verify that all
model dependencies are included and the remote workers can access them.
You can add additional dependencies and make the dependencies accessible
to remote workers, as described in the following topics:

• “Specifying Additional Path and File Dependencies” on page 3-179

• “Making Model Dependencies Accessible to Remote Workers” on page 3-180

Specifying Additional Path and File Dependencies
If your model has path and file dependencies that the software cannot find
automatically, add the dependencies before you start the optimization using
parallel computing:
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1 Add the path dependencies using the GUI or at the command line, as
described “Optimize Design Using Parallel Computing (GUI)” on page
3-180, and “Optimize Design Using Parallel Computing (Code)” on page
3-184.

2 Add the file dependencies, as described in “Configuring Parallel Computing
on Multiprocessor Networks” on page 3-178.

Making Model Dependencies Accessible to Remote Workers
If your model has dependencies that the remote MATLAB workers cannot
access directly, modify the list of dependencies to make them accessible.
For example, remote workers cannot access model dependencies on your
local drive. Update the list of paths so that the workers can access them, as
described in “Optimize Design Using Parallel Computing (GUI)” on page
3-180, and “Optimize Design Using Parallel Computing (Code)” on page 3-184.

Optimize Design Using Parallel Computing (GUI)
After you configure your system for parallel computing, as described in
“Configure Your System for Parallel Computing” on page 3-178, you can use
the GUI to optimize the model response:

1 Open the Design Optimization tool for a model.

2 Configure the design requirements, design variables and optionally
optimization settings. See “Specifying Time Domain Design Requirements
(GUI)” on page 3-16, “Design Variables (GUI)” on page 3-54 and
“Optimization Options” on page 3-64.
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3 In the Design Optimization tool, , click Options.

Select the Parallel Options tab.

4 Select Use the matlabpool during optimization.

This action checks for model path dependencies in your Simulink model and
displays the path dependencies in theModel path dependencies list box.

Note As described in “Specify Model Dependencies” on page 3-179,
the automatic path dependencies check may not detect all the path
dependencies in your model.
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5 (Optional) Add the path dependencies that the automatic check does not
detect.

a Specify the paths in theModel path dependencies list box.

You can specify the paths separated with a semicolon, or on a new line.

b Click Apply to include the new paths.
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Alternatively, you can click Add path dependency to open a Browse For
Folder dialog box where you can select the folder to add.

6 (Optional) In the Model path dependencies list box, update the paths
on local drives to make them accessible to remote workers. For example,
change C:\ to \\\\hostname\\C$\\.

7 (Optional) If you modify the Simulink model such that it introduces a new
path dependency, then you must resync the path dependencies. Click Sync
path dependencies from model in the Parallel Options tab to rerun
the automatic dependency check for your model.

This action updates theModel path dependencies list box with any new
path dependency found in the model.

8 Click OK.

9 In the Design Optimization tool, click Optimize to optimize the model
response using parallel computing.

For more information on how to troubleshoot problems that occur during
optimization using parallel computing, see “Optimization Speed and Parallel
Computing” on page 3-190.
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Optimize Design Using Parallel Computing (Code)
After you configure your system for parallel computing, as described in
“Configure Your System for Parallel Computing” on page 3-178, you can
optimize your model’s response using the command-line functions. To learn
more about response optimization using parallel computing, see “Speedup
Using Parallel Computing” on page 3-173.

To use parallel computing for response optimization at the command line:

1 Open the model you want to optimize.

2 Specify design requirements and design variables.

3 Enable parallel computing.

sim_opt = sdo.OptimizeOptions;
sim_opt.UseParallel = 'always';

4 Find the model path dependencies.

dirs = sdo.getModelDependencies(modelname)

This command returns the model path dependencies in your Simulink
model.

Note As described in “Specify Model Dependencies” on page 3-179,
the sdo.getModelDependencies command may not detect all the path
dependencies in your model.

5 (Optional) Modify dirs to include path dependencies that
sdo.getModelDependencies does not detect.

dirs = vertcat(dirs,'\\hostname\C$\matlab\work')

6 (Optional) Modify dirs to make paths on local drives accessible to remote
workers.

dirs = regexprep(dirs,'C:/','\\\\hostname\\C$\\')
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7 Add the path dependencies for optimization.

sim_opt.ParallelPathDependencies = dirs;

8 Run the optimization.

For more information on how to troubleshoot problems that occur during
optimization using parallel computing, see “Optimization Speed and Parallel
Computing” on page 3-190 in “Troubleshooting Optimization Results” on
page 3-186.
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Refining and Troubleshooting Optimization Results

Troubleshooting Optimization Results
When optimizing model parameters, the optimization solver may run into
issues. Simulink Design Optimization software provides visual cues to inform
you about issues during the progress of an optimization. The following list
represents the commonly encountered problems, and recommends solutions,
advice, and tips to help you troubleshoot the issue.

• “Optimization Does Not Make Progress” on page 3-186

• “Optimization Convergence” on page 3-187

• “Optimization Speed and Parallel Computing” on page 3-190

• “Undesirable Parameter Values” on page 3-192

• “Reverting to Initial Parameter Values” on page 3-194

Optimization Does Not Make Progress

• “Should I worry about the scale of my responses and how constraints and
design requirements are discretized?” on page 3-186

• “Why don’t the responses and parameter values change at all?” on page
3-187

• “Why does the optimization stall?” on page 3-187

Should I worry about the scale of my responses and how constraints
and design requirements are discretized?. No. Simulink Design
Optimization software automatically normalizes constraints, design
requirement and response data.
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Why don’t the responses and parameter values change at all?. The
optimization problem you formulated might be nonsmooth. This means that
small parameter changes have no effect on the amount by which response
signals satisfy or violate the constraints and only large changes will make a
difference. Try switching to a search-based method such as simplex search or
pattern search. Alternatively, look for initial guesses outside of the dead zone
where parameter changes have no effect. If you are optimizing the response
of a Simulink model, you could also try removing nonlinear blocks such as
Quantizer or Dead Zone.

Why does the optimization stall?. When optimizing a Simulink model,
certain parameter combinations can make the simulation stall for models
with strong nonlinearities or frequent mode switching. In these cases, the
ODE solvers take smaller and smaller step sizes. Stalling can also occur
when the model’s ODEs become too stiff for some parameter combinations.
A symptom of this behavior is when the Simulink model status is Running
and clicking the Stop button fails to interrupt the optimization. When this
happens, you can try one of the following solutions:

• Switch to a different ODE solver, especially one of the stiff solvers.

• Specify a minimum step size.

• Disable zero crossing detection if chattering is occurring.

• Tighten the lower and upper bounds on parameters that cause simulation
difficulties. In particular, eliminate regions of the parameter space where
some model assumptions are invalid and the model behavior can become
erratic.

Optimization Convergence

• “What to do if the optimization does not get close to an acceptable solution?”
on page 3-188

• “Why does the optimization terminate before exceeding the maximum
number of iterations, with a solution that does not satisfy all the constraints
or design requirements?” on page 3-188

• “What to do if the optimization takes a long time to converge even though it
is close to a solution?” on page 3-189
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• “What to do if the response becomes unstable and does not recover?” on
page 3-189

What to do if the optimization does not get close to an acceptable
solution?.

• If you are using pattern search, check that you have specified appropriate
maximum and minimum values for all your tuned parameters or
compensator elements. The pattern search method looks inside these
bounds for a solution. When they are set to their default values of Inf
and -Inf, the method searches within ±100% of the initial values of the
parameters. In some cases this region is not large enough and changing the
maximum and minimum values can expand the search region.

• Your optimization problem might have local minima. Consider running one
of the search-based methods first to get closer to an acceptable solution.

• Reduce the number of tuned parameters and compensator elements by
removing from the design variables or from the Compensators pane (when
using a SISO Design Task) those parameters that you know only mildly
influence the optimized responses. After you identify reasonable values for
the key parameters, add the fixed parameters back to the tunable list and
restart the optimization using these reasonable values as initial guesses.

Why does the optimization terminate before exceeding the
maximum number of iterations, with a solution that does not satisfy
all the constraints or design requirements?.

• It might not be possible to achieve your specifications. Try relaxing the
constraints or design requirements that the response signals violate the
most. After you find an acceptable solution to the relaxed problem, tighten
some constraints again and restart the optimization.

• The optimization might have converged to a local minimum that is not a
feasible solution. Restart the optimization from a different initial guess
and/or use one of the search-based methods to identify another local
minimum that satisfies the constraints.
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What to do if the optimization takes a long time to converge even
though it is close to a solution?.

• In a Design Optimization tool, click Stop to interrupt the optimization
when you think the current optimized response signals are acceptable.

When you use a SISO Design Task, click Stop Optimization in the
Optimization panel of the Response Optimization node in the Control
and Estimation Tools Manager, when you think the current optimized
response signals are acceptable.

• If you use the gradient descent method, try restarting the optimization.
Restarting resets the Hessian estimate and might speed up convergence.

• Increase the convergence tolerances in the Optimization Options dialog
to force earlier termination.

• Relax some of the constraints or design requirements to increase the size of
the feasibility region.

What to do if the response becomes unstable and does not recover?.
While the optimization formulation has explicit safeguards against unstable
or divergent response signals, the optimization can sometimes venture into
an unstable region where simulation results become erratic and gradient
methods fail to find a way back to the stable region. In these cases, you can
try one of the following solutions:

• Add or tighten the lower and upper bounds on compensator element and
parameter values. Instability often occurs when you allow some parameter
values to become too large.

• Use a search-based method to find parameter values that stabilize the
response signals and then start the gradient-based method using these
initial values.

• When optimizing responses in a SISO Design Task, you can try adding
additional design requirements that achieve the same or similar goal.
For example, in addition to a settling time design requirement on a step
response plot, you could add a settling time design requirement on a
root-locus plot that restricts the location of the real parts of the poles. By
adding overlapping design requirements in this way, you can force the
optimization to meet the requirements.
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Optimization Speed and Parallel Computing

• “How can I speed up the optimization?” on page 3-190

• “Why are the optimization results with and without using parallel
computing different?” on page 3-191

• “Why do I not see the optimization speedup I expected using parallel
computing?” on page 3-191

• “Why does the optimization using parallel computing not make any
progress?” on page 3-192

• “Why does the optimization using parallel computing not stop when I click
the Stop optimization button?” on page 3-192

How can I speed up the optimization?.

• The optimization time is dominated by the time it takes to simulate the
model. When optimizing a Simulink model, you can enable the Accelerator
mode using Simulation > Accelerator in the Simulink model window, to
dramatically reduce the optimization time.

Note The Rapid Accelerator mode in Simulink software is not supported
for speeding up the optimization. For more information, see “Accelerating
Model Simulations During Optimization” on page 3-171.

• The choice of ODE solver can also significantly affect the overall
optimization time. Use a stiff solver when the simulation takes many small
steps, and use a fixed-step solver when such solvers yield accurate enough
simulations for your model. (These solvers must be accurate in the entire
parameter search space.)

• Reduce the number of tuned compensator elements or parameters and
constrain their range to narrow the search space.

• When specifying parameter uncertainty (not available when optimizing
responses in a SISO Design Task), keep the number of sample values small
since the number of simulations grows exponentially with the number of
samples. For example, a grid of 3 parameters with 10 sample values for
each parameter requires 103=1000 simulations per iteration.
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Why are the optimization results with and without using parallel
computing different?.

• When you use parallel computing, different numerical precision on the
client and worker machines can produce marginally different simulation
results. Thus, the optimization method takes a completely different
solution path and produces a different result.

Note Numerical precision can differ because of different operating systems
or hardware on the client and worker machines.

• When you use parallel computing, the state of the model on the client and
the worker machines can differ, and thus lead to a different result. For
example, the state can become different if you change a parameter value
initialized by a callback function on the client machine after the workers
have loaded the model. The model parameter values on the workers and
the client are now out of sync, which can lead to a different result.

After you change the model parameter values initialized by a callback
function, verify that the parameters exist in the model workspace or
update the callback function so that the remote workers have access to the
changed parameter values.

• When you use parallel computing with the Pattern search method,
the Pattern search method searches for a candidate solution more
comprehensively than when you do not use parallel computing. This more
comprehensive search can result in a different solution. To learn more, see
“Parallel Computing with the Pattern search Method” on page 3-175.

Why do I not see the optimization speedup I expected using parallel
computing?.

• When you optimize a model that does not have a large number of
parameters or does not take long to simulate, the resulting optimization
time may not be any faster. In such cases, the overheads associated with
creating and distributing the parallel tasks outweighs the benefits of
running the simulations during optimization in parallel.
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• Using Pattern search method with parallel computing may not speed
up the optimization time. When you do not use parallel computing, the
method stops searching for a candidate solution at each iteration as soon as
it finds a solution better than the current solution. The candidate solution
search is more comprehensive when you use parallel computing. Although
the number of iterations may be larger, the optimization without using
parallel computing may be faster.

To learn more about the expected speedup, see “Parallel Computing with
the Pattern search Method” on page 3-175.

Why does the optimization using parallel computing not make
any progress?. In some cases, the gradient computations on the remote
worker machines may silently error out when you use parallel computing.
In such cases, the Optimization Progress window shows that the f(x) and
max constraint values do not change, and the optimization terminates
after two iterations with the message Unable to satisfy constraints.
To troubleshoot the problem:

1 Run the optimization for a few iterations without parallel computing to
see if the optimization progresses.

2 Check if the remote workers have access to all model dependencies.
To learn more, see “Making Model Dependencies Accessible to Remote
Workers” on page 3-180.

Why does the optimization using parallel computing not stop when I
click the Stop optimization button?. When you use parallel computing,
the software has to wait till the current iteration completes before it notifies
the workers to stop the optimization. The optimization does not terminate
immediately when you click Stop, and appears to continue to run.

Undesirable Parameter Values

• “What to do if the optimization drives the tuned compensator elements and
parameters to undesirable values?” on page 3-193

• “What to do if the optimization violates bounds on parameter values?” on
page 3-193
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What to do if the optimization drives the tuned compensator
elements and parameters to undesirable values?.

• When a tuned compensator element or parameter is positive, or when its
value is physically constrained to a given range, enter the lower and upper
bounds (Minimum and Maximum) in one of the following:

- Dialog box to select design variables (in Design optimization tool)

- Compensators pane (in a SISO Design Task)

This information helps guide the optimization method towards a reasonable
solution.

• Specify initial guesses that are within the range of desirable values.

• In the Compensators pane in a SISO Design Task, verify that no
integrators/differentiators are selected for optimization. Optimizing the
pole/zero location of integrators/differentiators can result in drastic changes
in the system gain and lead to undesirable values.

What to do if the optimization violates bounds on parameter
values?. The Gradient descent optimization method fmincon violates
the parameter bounds when it cannot simultaneously satisfy the signal
constraints and the bounds. When this happens, try one of the following:

• Specify a different value for the parameter bound and restart the
optimization. A guideline is to adjust the bound by 1% of the typical value.

For example, for a parameter with a typical value of 1 and lower bound of
0, change the lower bound to 0.01.

• Relax the signal constraints and restart the optimization. This approach
results in a different solution path for the Gradient descent method.

• Restart the optimization immediately after it terminates by clicking
Optimize in the Design Optimization tool. This approach uses the
previous optimization results as the starting point for the next optimization
cycle to refine the results.

• Use the following two-step approach to perform the optimization:

1 Run an initial optimization to satisfy the signal constraints.
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For example, run the optimization using the Simplex search method.
This method satisfies the signal constraints but does not support the
bounds on parameter values. The results obtained using this method
provide the starting point for the optimization performed in the next
step. To learn more about this method, see the fminsearch function
reference page in the Optimization Toolbox documentation.

2 Reconfigure the optimization by selecting a different optimization
method to satisfy both the signal constraints and the parameter bounds.

For example, change the optimization method to Gradient descent
and run the optimization again.

Tip If Global Optimization Toolbox software is installed, you can select the
Pattern search optimization method to optimize the model response.

Reverting to Initial Parameter Values

How do I quit an optimization and revert to my initial parameter
values?.

• Before running an optimization, do one of the following:

- In the Design Optimization tool, click Options. Uncheck Update
model at end of optimization in the General Options tab.

- In the Design Optimization tool, click Options. Select Save optimized
variable values as new design variable set in the General Options
tab.

- Make a copy of the design variable set in the Design Optimization
Workspace.

If you want to revert to the initial parameter values after the optimization
terminates or you stop the optimization by clicking Stop, select the design
variable that contains the initial values in the Design Variable Set

drop-down list and click adjacent to Design variables Set. Select
the design variables in the dialog box and click Update model variable
values to revert the model parameters to their original values.
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• When using a SISO Design Task, the Start Optimization button becomes
a Stop Optimization button after the optimization has begun. To quit
the optimization, click the Stop Optimization button. To revert to the
initial parameter values, select Edit > Undo Optimize compensators
from the menu in the SISO Design Tool window.
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Managing Design Optimization Tool Session

In this section...

“Saving a Session” on page 3-196

“Loading a Session” on page 3-196

Saving a Session
Saving a session lets you reuse your settings and optimization results later.
These settings include design requirements, design and uncertain variables,
plots and optimization settings. Each Design Optimization tool session is
associated with a Simulink model.

You can save the session as a MAT-file or workspace variable:

• To save the session as a MAT-file, click Save in the Design Optimization
tab. A window opens where you specify the MAT-file name.

• To save the session as a model or MATLAB workspace variable, select
Save to model workspace or Save to base workspace in the Save
drop-down list.

Loading a Session
You can load a saved MAT-file or workspace session:

1 Open a Design Optimization tool for the model.
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2 To load a MAT-file, click Open in the Design Optimization tab. A
window opens where you select the MAT-file to load.

To load a workspace variable, select Open from model workspace or
Open from base workspace in the Open drop-down list.
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Optimization-Based Control
Design

• “Overview of Optimization-Based Compensator Design” on page 4-2

• “Time Domain Design Requirements in Simulink” on page 4-4

• “Frequency-Domain Design Requirements in Simulink” on page 4-20

• “Time- and Frequency-Domain Requirements in SISO Design Tool” on
page 4-42

• “Time-Domain Simulations in SISO Design Tool” on page 4-47

• “Designing Optimization-Based Controllers for LTI Systems” on page 4-48

• “Designing Linear Controllers for Simulink Models” on page 4-70
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Overview of Optimization-Based Compensator Design
You can design optimization-based controllers for Simulink models to meet
time and frequency-domain design requirements, as described in Chapter
3, “Response Optimization”.

If you have Control System Toolbox software installed, you can also design
and optimize control systems by tuning controller elements or parameters
within a SISO Design Task in the Control and Estimation Tools Manager.
You can tune elements or parameters such as poles, zeros, and gains within
any controller in the system and optimize the open and closed loop responses
to meet time- and frequency-domain requirements.

Optimize the responses of systems in the SISO Design Task to meet both
time- and frequency-domain performance requirements by graphically
constraining signals:

• Add frequency-domain design requirements to plots such as root-locus,
Nichols, and Bode in the SISO Design Task graphical tuning editor called
SISO Design Tool.

• Add time-domain design requirements to plots such as step or impulse
response (when displayed within the LTI Viewer as part of a SISO Design
Task).

You can use optimization methods in a SISO Design Task in the Control and
Estimation Tools Manager to tune both command-line LTI models as well
as Simulink models:

• Create an LTI model using the Control System Toolbox command-line
functions and use the sisotool function to create a SISO Design Task
for the model. For an example, see “Example — Frequency-Domain
Optimization for LTI System” on page 4-49.

• Use a Simulink Compensator Design task (from Simulink Control Design
software) to automatically analyze the model and then create a SISO
Design Task for a linearized version of the model. You can then use the
optimization techniques in the SISO Design Task to tune the response
of the linearized Simulink model. For an example, see “Design an
Optimization-Based PID Controller for a Linearized Simulink Model”.
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Note When using response optimization within a SISO Design Task you
cannot add uncertainty to system parameters.

When using a SISO Design Task, Simulink Design Optimization software
automatically sets the model’s simulation start and stop time and you cannot
directly change them. By default, the simulation starts at 0 and continues
until the SISO Design Task determines that the dynamics of the model have
settled out. In addition, when the design requirements extend beyond this
point, the simulation continues to the extent of the design requirements.
Although you cannot directly adjust the start or stop time of the simulation,
you can adjust the design requirements to extend further in time and thus
force the simulation to continue to a certain point.
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Time Domain Design Requirements in Simulink

In this section...

“Specifying Piecewise-Linear Lower and Upper Bounds” on page 4-4

“Specifying Step Response Characteristics” on page 4-35

“Track Reference Signals” on page 4-13

“Specifying Custom Requirements” on page 4-38

“Editing Design Requirements” on page 4-17

Specifying Piecewise-Linear Lower and Upper
Bounds
To specify upper and lower bounds on a signal:

1 In the Design Optimization tool, select Signal Bound in the New
drop-down list. A window opens where you specify upper or lower bounds
on a signal.

2 Specify a requirement name in the Name box.

3 Select the requirement type using the Type list.

4 Specify the edge start and end times and corresponding amplitude in the
Time (s) and Amplitude columns.

5 Click to specify additional bound edges.

Select a row and click to delete a bound edge.

6 In the Select Signals to Bound area, select a logged signal to apply the
requirement to.

If you have already selected signals, as described in “Specify Signals to
Log (GUI)” on page 3-14, they appear in the list. Select the corresponding
check-box.

If you haven’t selected a signal to log:
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a Click . A window opens where you specify the logged signal.

b In the Simulink model window, click the signal where you want to add
a requirement.

The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool window.

7 Click OK.

A variable with the specified requirement name appears in the Design
Optimization Workspace. A graphical display of the requirement also
appears in the Design Optimization tool window.

8 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6
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• “Split and Join Constraints” on page 4-8

Alternatively, you can add a Check Custom Bounds block to your model to
specify piecewise-linear bounds.

Moving Constraints

• “Moving Constraints Graphically” on page 4-6

• “Positioning Constraints Exactly” on page 4-7

Constraint-bound edges define time-domain constraints you would like to
place on a particular signal in your model. You can position these edges,
which appear as a yellow shaded region bordered by a black line, graphically
or exactly.

Moving Constraints Graphically. Use the mouse to click and drag edges in
the amplitude versus time plot, as shown in the following figure.

• To move a constraint edge boundary or to change the slope of a constraint
edge, position the pointer over a constraint edge endpoint, and press and
hold down the left mouse button. The pointer should change to a hand
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symbol. While still holding the button down, drag the pointer to the target
location, and release the mouse button. Note that the edges on either side
of the boundary might not maintain their slopes.

• To move an entire constraint edge up, down, left, or right, position the
mouse pointer over the edge and press and hold down the left mouse
button. The pointer should change to a four-way arrow. While still holding
the button down, drag the pointer to the target location, and release the
mouse button. Note that the edges on either side of the boundary might
not maintain their slopes.

To move a constraint edge to a perfectly horizontal or vertical position, hold
down the Shift key while clicking and dragging the constraint edge. This
causes the constraint edge to snap to a horizontal or vertical position.

When moving constraint bound edges, it is sometimes helpful to display
gridlines on the axes for careful alignment of the constraint bound edges. To
turn the gridlines on or off, right-click within the axes and select Grid.

Note You can move a lower bound constraint edge above an upper bound
constraint edge, or vice versa, but this produces an error when you attempt to
run the optimization.

Positioning Constraints Exactly. To position a constraint edge exactly:

1 Position the pointer over the edge you want to move and right-click. Select
Edit to open the Edit Design Requirement dialog box.

4-7



4 Optimization-Based Control Design

2 Specify the position of each constraint edge in the Time and Amplitude
columns.

Split and Join Constraints
To split a constraint segment, position the pointer over the segment to be split,
and press the right mouse button. Select Split from the context menu. The
segment splits in half. You can now manipulate each segment individually.
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To join two neighboring constraint segments, position the pointer over one
constraint segment, and press the right mouse button. Select Join left or
Join right from the menu to join the segment to the segment too the left
or right respectively.

Specifying Step Response Characteristics
To specify step response characteristics:

1 You can apply this requirement to either a signal or a linearization of
your model.

In the Design Optimization Tool, click New. To apply this requirement to
a signal, select the Step Response Envelope entry in the New Time
Domain Requirement section of the New list. To apply this requirement
to a linearization of your model, select the Step Response Envelope
entry in the New Frequency Domain Requirement section of the New
list. The latter option requires Simulink Control Design software.

A window opens where you specify the step response requirements on
a signal, or system.

2 Specify a requirement name in the Name box.
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3 Specify the step response characteristics:
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• Initial value: Input level before the step occurs

• Step time: Time at which the step takes place

• Final value: Input level after the step occurs

• Rise time: The time taken for the response signal to reach a specified
percentage of the step’s range. The step’s range is the difference between
the final and initial values.

• % Rise: The percentage used in the rise time.

• Settling time: The time taken until the response signal settles within a
specified region around the final value. This settling region is defined
as the final step value plus or minus the specified percentage of the
final value.

• % Settling: The percentage used in the settling time.

• % Overshoot: The amount by which the response signal can exceed the
final value. This amount is specified as a percentage of the step’s range.
The step’s range is the difference between the final and initial values.
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• % Undershoot: The amount by which the response signal can
undershoot the initial value. This amount is specified as a percentage
of the step’s range. The step’s range is the difference between the final
and initial values.

4 Specify the signals or systems to be bound.

You can apply this requirement to a model signal or to a linearization of
your Simulink model (requires Simulink Control Design software).

• Apply this requirement to a model signal:

In the Select Signals to Bound area, select a logged signal to which
you will apply the requirement.

If you have already selected a signal to log, as described in “Specify
Signals to Log (GUI)” on page 3-14, it appears in the list. Select the
corresponding check-box.

If you haven’t selected a signal to log:

a Click . A window opens where you specify the logged signal.

b In the Simulink model window, click the signal where you want to
add a requirement.
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The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the
Design Optimization Workspace of the Design Optimization tool
window.

• Apply this requirement to a linear system.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using
the Snapshot Times box. For multiple simulation snapshot times,
specify a vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click
to open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A variable with the specified requirement name appears in the Design
Optimization Workspace. A graphical display of the requirement also
appears in the Design Optimization tool window.

Alternatively, you can use the Check Step Response Characteristics block to
specify step response bounds for a signal.
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See Also

“Optimize Controller Parameters to Meet Step Response Requirements (GUI)”

Track Reference Signals
Use reference tracking to force a model signal to match a desired signal.

To track a reference signal:

1 In the Design Optimization tool, select Signal Tracking in the New
drop-down list. A window opens where you specify the reference signal
to track.

2 Specify a requirement name in the Name box.

3 Define the reference signal by entering vectors, or variables from the
workspace, in the Time vector and Amplitude fields.

Click Update reference signal data to use the new amplitude and time
vector as the reference signal.

4 Specify how the optimization solver minimizes the error between the
reference and model signals using the Tracking Method list:

• SSE — Reduces the sum of squared errors

• SAE — Reduces the sum of absolute errors

5 In the Specify Signal to Track Reference Signal area, select a logged
signal to apply the requirement to.

If you already selected a signal to log, as described in “Specify Signals to
Log (GUI)” on page 3-14, they appear in the list. Select the corresponding
check-box.

If you haven’t selected a signal to log:

a Click . A window opens where you specify the logged signal.

b In the Simulink model window, click the signal where you want to add
a requirement.
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The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool window.

e Select the check-box corresponding to the signal and click OK.

A variable with the specified requirement name appears in the Design
Optimization Workspace. A graphical display of the signal bound also
appears in the Design Optimization tool window.

Note When tracking a reference signal, the software ignores the maximally
feasible solution option. For more information on this option, see “Selecting
Optimization Termination Options” on page 3-66.
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Alternatively, you can use the Check Against Reference block to specify
a reference signal to track.

See Also

“Optimize Controller Parameters to Track Reference Signal (GUI)”

Specifying Custom Requirements
To specify custom requirements such as minimizing system energy:

1 In the Design Optimization tool, select Custom Requirement in the New
drop-down list. A window opens where you specify the custom requirement.

2 Specify a requirement name in the Name box.

3 Specify the requirement type using the Type list.

4 Specify the name of the function that contains the custom requirement in
the Function box. The field must be specified as a function handle using

@. The function must be on the MATLAB path. Click to review
or edit the function.

If the function does not exist, clicking opens a template MATLAB
file. Use this file to implement the custom requirement. The default
function name is myCustomRequirement.

5 (Optional) Specify the signal or system, or both, to be bound.

You can apply this requirement to model signals, or a linearization of your
Simulink model (requires Simulink Control Design software), or both.

Click Select Signals and Systems to Bound (Optional) to view the
signal and linearization I/O selection area.

• Apply this requirement to a model signal:

In the Signal area, select a logged signal to which you will apply the
requirement.
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If you have already selected a signal to log, as described in “Specify
Signals to Log (GUI)” on page 3-14, it appears in the list. Select the
corresponding check-box.

If you haven’t selected a signal to log:

a Click . A window opens where you specify the logged signal.

b In the Simulink model window, click the signal where you want to
add a requirement.

The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the
Design Optimization Workspace of the Design Optimization tool
window.

• Apply this requirement to a linear system.
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Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using
the Snapshot Times box. For multiple simulation snapshot times,
specify a vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click
to open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

6 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.

See Also

• “Design Optimization to Meet a Custom Objective Using the GUI” on
page 3-103

• “Design Optimization to Meet Custom Signal Requirements (GUI)” on
page 3-133

Editing Design Requirements
The Edit Design Requirement dialog box allows you to exactly position
constraint segments and to edit other properties of these constraints. The
dialog box has two main components:
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• An upper panel to specify the constraint you are editing

• A lower panel to edit the constraint parameters

The upper panel of the Edit Design Requirement dialog box resembles the
image in the following figure.

In the context of the SISO Tool in Control System Toolbox software, Design
requirement refers to both the particular editor within the SISO Tool
that contains the requirement and the particular requirement within that
editor. To edit other constraints within the SISO Tool, select another design
requirement from the drop-down menu.

Edit Design Requirement Dialog Box Parameters
The particular parameters shown within the lower panel of the Edit Design
Requirement dialog box depend on the type of constraint/requirement. In
some cases, the lower panel contains a grid with one row for each segment and
one column for each constraint parameter. The following table summarizes
the various constraint parameters.

Edit Design Requirement Dialog Box Parameters

Parameter Found in Description

Time Upper and lower time
response bounds on step
and impulse response plots

Defines the time range of a segment
within a constraint/requirement.

Amplitude Upper and lower time
response bounds on step
and impulse response plots

Defines the beginning and ending
amplitude of a constraint segment.
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Edit Design Requirement Dialog Box Parameters (Continued)

Parameter Found in Description

Slope (1/s) Upper and lower time
response bounds

Defines the slope, in 1/s, of a
constraint segment. It is an
alternative method of specifying the
magnitude values. Entering a new
Slope value changes any previously
defined magnitude values.

Final value Step response bounds Defines the input level after the step
occurs.

Rise time Step response bounds Defines a constraint segment for a
particular rise time.

% Rise Step response bounds The percentage of the step’s range
used to describe the rise time.

Settling time Step response bounds Defines a constraint segment for a
particular settling time.

% Settling Step response bounds The percentage of the final value that
defines the settling region used to
describe the settling time.

% Overshoot Step response bounds

% Undershoot Step response bounds Defines the constraint segments for a
particular percent undershoot.
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Frequency-Domain Design Requirements in Simulink

In this section...

“Specifying Lower Bounds on Gain and Phase Margin” on page 4-20

“Specifying Piecewise-Linear Lower and Upper Bounds on Frequency
Response” on page 4-22

“Specifying Bound on Closed-Loop Peak Gain” on page 4-24

“Specifying Lower Bound on Damping Ratio” on page 4-26

“Specifying Upper and Lower Bounds on Natural Frequency” on page 4-28

“Specifying Upper Bound on Approximate Settling Time” on page 4-30

“Specifying Piecewise-Linear Upper and Lower Bounds on Singular Values”
on page 4-32

“Specifying Step Response Characteristics” on page 4-35

“Specifying Custom Requirements” on page 4-38

Specifying Lower Bounds on Gain and Phase Margin
To specify lower bounds on the gain and phase margin of a linear system:

1 In the Design Optimization tool, select Gain and Phase Margin in the
New list. A window opens where you specify lower bounds on the gain and
phase margin of your linear system.

2 Specify a requirement name in Name.

3 Specify bounds on the gain margin or phase margin, or both.
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• Gain margin— Amount of gain increase or decrease required to make
the loop gain unity at the frequency where the phase angle is –180°.

• Phase margin — Amount of phase increase or decrease required to
make the phase angle –180° when the loop gain is 1.0

To specify a lower bound on the gain margin or phase margin, or both,
select the corresponding check box and enter the lower bound value.

4 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.
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If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A variable with the specified requirement name appears in the Design
Optimization Workspace. A graphical display of the requirement also
appears in the Design Optimization tool window.

6 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Gain and Phase Margins block to specify
bounds on the gain and phase margin. (Requires Simulink Control Design.)

Specifying Piecewise-Linear Lower and Upper
Bounds on Frequency Response
To specify upper or lower bounds on the magnitude of a system response:

1 In the Design Optimization tool, select Bode Magnitude in the New
list. A window opens where you specify the lower or upper bounds on the
magnitude of the system response.

2 Specify a requirement name in the Name box.

3 Specify the requirement type using the Type list.

4 Specify the edge start and end frequencies and corresponding magnitude in
the Frequency and Magnitude columns.
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5 Insert or delete bound edges.

Click to specify additional bound edges.

Select a row and click to delete a bound edge.

6 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

7 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool window.
A graphical display of the requirement also appears in the Design
Optimization tool window.
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8 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Bode Characteristics block to specify
bounds on the magnitude of the system response. (Requires Simulink Control
Design.)

Specifying Bound on Closed-Loop Peak Gain
To specify an upper bound on the closed-loop peak response of a system:

1 In the Design Optimization tool, select Closed-Loop Peak Gain in the
New list. A window opens where you specify an upper bound on the
closed-loop peak gain of the system.

2 Specify a requirement name in the Name box.
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3 Specify the upper bound on the closed-loop peak gain in the Closed-Loop
peak gain box.

4 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool window.
A graphical display of the requirement also appears in the Design
Optimization tool window.
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6 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Nichols Characteristics block to specify
bounds on the magnitude of the system response. (Requires Simulink Control
Design.)

Specifying Lower Bound on Damping Ratio
To specify a lower bound on the damping ratio of the system:

1 In the Design Optimization tool, select Damping Ratio in the New list. A
window opens where you specify an upper bound on the damping ratio of
the system.
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2 Specify a requirement name in the Name box.

3 Specify the lower bound on the damping ratio in the Damping ratio box.

4 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.
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6 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Pole-Zero Characteristics block to specify
a bound on the damping ratio. (Requires Simulink Control Design.)

Specifying Upper and Lower Bounds on Natural
Frequency
To specify a bound on the natural frequency of the system:

1 In the Design Optimization tool, select Natural Frequency in the New
list. A window opens where you specify a bound on the natural frequency of
the system.
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2 Specify a requirement name in the Name box.

3 Specify a lower or upper bound on the natural frequency in the Natural
frequency box.

4 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.
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6 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Pole-Zero Characteristics block to specify
a bound on the natural frequency. (Requires Simulink Control Design.)

Specifying Upper Bound on Approximate Settling
Time
To specify an upper bound on the approximate settling time of the system:

1 In the Design Optimization tool, select Settling Time in the New list.
A window opens where you specify an upper bound on the approximate
settling time of the system.
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2 Specify a requirement name in the Name box.

3 Specify the upper bound on the approximate settling time in the Settling
time box.

4 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.
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6 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Pole-Zero Characteristics block to specify
the approximate settling time. (Requires Simulink Control Design.)

Specifying Piecewise-Linear Upper and Lower
Bounds on Singular Values
To specify piecewise-linear upper and lower bounds on the singular values
of a system:
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1 In the Design Optimization tool, select Singular Values in the New
list. A window opens where you specify the lower or upper bounds on the
singular values of the system.

2 Specify a requirement name in the Name box.

3 Specify the requirement type using the Type list.

4 Specify the edge start and end frequencies and corresponding magnitude in
the Frequency and Magnitude columns, respectively.

5 Insert or delete bound edges.

Click to specify additional bound edges.

Select a row and click to delete a bound edge.

6 In the Select Systems to Bound section, select the linear systems to
which this requirement applies.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using the
Snapshot Times box. For multiple simulation snapshot times, specify a
vector.

b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click to
open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.
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7 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.

8 (Optional) In the graphical display, you can:

• “Moving Constraints” on page 4-6

• “Split and Join Constraints” on page 4-8

Alternatively, you can use the Check Singular Value Characteristics block to
specify bounds on the singular value. (Requires Simulink Control Design.)
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Specifying Step Response Characteristics
To specify step response characteristics:

1 You can apply this requirement to either a signal or a linearization of
your model.

In the Design Optimization Tool, click New. To apply this requirement to
a signal, select the Step Response Envelope entry in the New Time
Domain Requirement section of the New list. To apply this requirement
to a linearization of your model, select the Step Response Envelope
entry in the New Frequency Domain Requirement section of the New
list. The latter option requires Simulink Control Design software.

A window opens where you specify the step response requirements on
a signal, or system.

2 Specify a requirement name in the Name box.

3 Specify the step response characteristics:

(
�
��

��

	�

)
��

*
����"����

+
���)
��

,�+
��

,�-.�������
,������
��

�����
���)
��

,�'�	�������
/�
�
���"����

4-35



4 Optimization-Based Control Design

• Initial value: Input level before the step occurs

• Step time: Time at which the step takes place

• Final value: Input level after the step occurs

• Rise time: The time taken for the response signal to reach a specified
percentage of the step’s range. The step’s range is the difference between
the final and initial values.

• % Rise: The percentage used in the rise time.

• Settling time: The time taken until the response signal settles within a
specified region around the final value. This settling region is defined
as the final step value plus or minus the specified percentage of the
final value.

• % Settling: The percentage used in the settling time.

• % Overshoot: The amount by which the response signal can exceed the
final value. This amount is specified as a percentage of the step’s range.
The step’s range is the difference between the final and initial values.

• % Undershoot: The amount by which the response signal can
undershoot the initial value. This amount is specified as a percentage
of the step’s range. The step’s range is the difference between the final
and initial values.

4 Specify the signals or systems to be bound.

You can apply this requirement to a model signal or to a linearization of
your Simulink model (requires Simulink Control Design software).

• Apply this requirement to a model signal:

In the Select Signals to Bound area, select a logged signal to which
you will apply the requirement.

If you have already selected a signal to log, as described in “Specify
Signals to Log (GUI)” on page 3-14, it appears in the list. Select the
corresponding check-box.

If you haven’t selected a signal to log:

a Click . A window opens where you specify the logged signal.
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b In the Simulink model window, click the signal where you want to
add a requirement.

The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the
Design Optimization Workspace of the Design Optimization tool
window.

• Apply this requirement to a linear system.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using
the Snapshot Times box. For multiple simulation snapshot times,
specify a vector.
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b Select the linearization input/output set from the Linearization I/O
area.

If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click
to open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

5 Click OK.

A variable with the specified requirement name appears in the Design
Optimization Workspace. A graphical display of the requirement also
appears in the Design Optimization tool window.

Alternatively, you can use the Check Step Response Characteristics block to
specify step response bounds for a signal.

See Also

“Optimize Controller Parameters to Meet Step Response Requirements (GUI)”

Specifying Custom Requirements
To specify custom requirements such as minimizing system energy:

1 In the Design Optimization tool, select Custom Requirement in the New
drop-down list. A window opens where you specify the custom requirement.

2 Specify a requirement name in the Name box.

3 Specify the requirement type using the Type list.

4 Specify the name of the function that contains the custom requirement in
the Function box. The field must be specified as a function handle using
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@. The function must be on the MATLAB path. Click to review
or edit the function.

If the function does not exist, clicking opens a template MATLAB
file. Use this file to implement the custom requirement. The default
function name is myCustomRequirement.

5 (Optional) Specify the signal or system, or both, to be bound.

You can apply this requirement to model signals, or a linearization of your
Simulink model (requires Simulink Control Design software), or both.

Click Select Signals and Systems to Bound (Optional) to view the
signal and linearization I/O selection area.

• Apply this requirement to a model signal:

In the Signal area, select a logged signal to which you will apply the
requirement.

If you have already selected a signal to log, as described in “Specify
Signals to Log (GUI)” on page 3-14, it appears in the list. Select the
corresponding check-box.

If you haven’t selected a signal to log:

a Click . A window opens where you specify the logged signal.

b In the Simulink model window, click the signal where you want to
add a requirement.
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The window updates and displays the name of the block and the port
number where the selected signal is located.

c Select the signal and click to add it to the signal set.

d In Signal set box, enter a name for the selected signal set.

Click OK. A new variable with the specified name appears in the
Design Optimization Workspace of the Design Optimization tool
window.

• Apply this requirement to a linear system.

Linear systems are defined by snapshot times at which the model is
linearized and sets of linearization I/O points defining the system inputs
and outputs.

a Specify the simulation time at which the model is linearized using
the Snapshot Times box. For multiple simulation snapshot times,
specify a vector.

b Select the linearization input/output set from the Linearization I/O
area.
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If you have already created a linearization input/output set, it will
appear in the list. Select the corresponding check box.

If you have not created a linearization input/output set, click
to open the Create linearization I/O set dialog box.

For more information on using this dialog box, see “Creating
Linearization I/O Sets (GUI)” on page 3-69.

For more information on linearization, see “What Is Linearization?”.

6 Click OK.

A new variable with the specified name appears in the Design
Optimization Workspace of the Design Optimization tool. A graphical
display of the requirement also appears in the Design Optimization tool
window.

See Also

• “Design Optimization to Meet a Custom Objective Using the GUI” on
page 3-103

• “Design Optimization to Meet Custom Signal Requirements (GUI)” on
page 3-133
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Time- and Frequency-Domain Requirements in SISO
Design Tool

In this section...

“Root Locus Diagrams” on page 4-42

“Open-Loop and Prefilter Bode Diagrams” on page 4-44

“Open-Loop Nichols Plots” on page 4-45

“Step/Impulse Response Plots” on page 4-46

This topic lists the time- and frequency-domain requirements that you can
specify for optimization-based control design using the SISO Design Tool.

Examples and How To

• “Designing Optimization-Based Controllers for LTI Systems” on page 4-48

• “Design an Optimization-Based PID Controller for a Linearized Simulink
Model”

Root Locus Diagrams

• “Settling Time” on page 4-42

• “Percent Overshoot” on page 4-43

• “Damping Ratio” on page 4-43

• “Natural Frequency” on page 4-44

• “Region Constraint” on page 4-44

Settling Time
If you specify a settling time in the continuous-time root locus, a vertical line
appears on the root locus plot at the pole locations associated with the value
provided (using a first-order approximation). In the discrete-time case, the
constraint is a curved line.
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It is required that Re{ } . /pole Tsettling< −4 6 for continuous systems and

log( ( )) / . /abs pole T Tdiscrete settling< −4 6 for discrete systems. This is an
approximation of the settling time based on second-order dominant systems.

Percent Overshoot
Specifying percent overshoot in the continuous-time root locus causes two
rays, starting at the root locus origin, to appear. These rays are the locus of
poles associated with the percent value (using a second-order approximation).
In the discrete-time case, the constraint appears as two curves originating at
(1,0) and meeting on the real axis in the left-hand plane.

The percent overshoot p.o constraint can be expressed in terms of the damping
ratio, as in this equation:

p o e. . /= − −100 1 2πζ ζ

where ζ is the damping ratio.

Damping Ratio
Specifying a damping ratio in the continuous-time root locus causes two rays,
starting at the root locus origin, to appear. These rays are the locus of poles
associated with the damping ratio. In the discrete-time case, the constraint
appears as curved lines originating at (1,0) and meeting on the real axis in
the left-hand plane.

The damping ratio defines a requirement on −Re{ } / ( )pole poleabs for
continuous systems and on

r pSys
t pSys

c r r t

=
=

= − +

abs
angle

( )
( )

log( ) / (log( ))2 2

for discrete systems.
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Natural Frequency
If you specify a natural frequency, a semicircle centered around the root locus
origin appears. The radius equals the natural frequency.

The natural frequency defines a requirement on abs(pole) for continuous
systems and on

r pSys
t pSys

c r t Tsmodel

=
=

= +

abs
angle

( )
( )

(log( )) /2 2

for discrete systems.

Region Constraint
Specifies an exclusion region in the complex plane, causing a line to appear
between the two specified points with a shaded region below the line. The
poles must not lie in the shaded region.

Open-Loop and Prefilter Bode Diagrams

• “Gain and Phase Margins” on page 4-44

• “Upper Gain Limit” on page 4-44

• “Lower Gain Limit” on page 4-44

Gain and Phase Margins
Specify a minimum phase and or a minimum gain margin.

Upper Gain Limit
You can specify an upper gain limit, which appears as a straight line on the
Bode magnitude curve. You must select frequency limits, the upper gain limit
in decibels, and the slope in dB/decade.

Lower Gain Limit
Specify the lower gain limit in the same fashion as the upper gain limit.
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Open-Loop Nichols Plots

• “Phase Margin” on page 4-45

• “Gain Margin” on page 4-45

• “Closed-Loop Peak Gain” on page 4-45

• “Gain-Phase Requirement” on page 4-45

Phase Margin
Specify a minimum phase amount.

While displayed graphically at only one location around a multiple of -180
degrees, this requirement applies to phase margin regardless of actual phase
(i.e., it is interpreted for all multiples of -180).

Gain Margin
Specify a minimum gain margin.

While displayed graphically at only one location around a multiple of -180
degrees, this requirement applies to gain margin regardless of actual phase
(i.e., it is interpreted for all multiples of -180).

Closed-Loop Peak Gain
Specify a peak closed-loop gain at a given location. The specified value can be
positive or negative in dB. The constraint follows the curves of the Nichols plot
grid, so it is recommended that you have the grid on when using this feature.

While displayed graphically at only one location around a multiple of -180
degrees, this requirement applies to gain margin regardless of actual phase
(i.e., it is interpreted for all multiples of -180).

Gain-Phase Requirement
Specifies an exclusion region for the response on the Nichols plot. The
response must not pass through the shaded region.

This only applies to the region (phase and gain) drawn.
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Step/Impulse Response Plots

• “Upper Time Response Bound” on page 4-46

• “Lower Time Response Bound” on page 4-46

Upper Time Response Bound
You can specify an upper time response bound.

Lower Time Response Bound
You can specify a lower time response bound.
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Time-Domain Simulations in SISO Design Tool
When using a SISO Design Task, Simulink Design Optimization software
automatically sets the model’s simulation start and stop time and you cannot
directly change them. By default, the simulation starts at 0 and continues
until the SISO Design Task determines that the dynamics of the model have
settled out. In addition, when the design requirements extend beyond this
point, the simulation continues to the extent of the design requirements.
Although you cannot directly adjust the start or stop time of the simulation,
you can adjust the design requirements to extend further in time and thus
force the simulation to continue to a certain point.
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Designing Optimization-Based Controllers for LTI Systems

In this section...

“How to Design Optimization-Based Controllers for LTI Systems” on page
4-48

“Example — Frequency-Domain Optimization for LTI System” on page 4-49

How to Design Optimization-Based Controllers for
LTI Systems
To design optimization-based linear controller for an LTI model:

1 Create and import a linear model into a SISO Design Task. You can create
an LTI model at the MATLAB command line, as described in “Creating
an LTI Plant Model” on page 4-50.

2 Create a SISO Design Task with design and analysis plots, as described in
“Creating Design and Analysis Plots” on page 4-51.

To learn more about SISO Design Tool, see “Using the SISO Design Task in
the Controls & Estimation Tools Manager” in the Control System Toolbox
documentation.

3 Under Automated Tuning select Optimization based tuning as the
Design Method and then click the Optimize Compensators button to
create a Response Optimization task within the Control and Estimation
Tools Manager. See “Creating a Response Optimization Task” on page
4-54 for more information.

4 Within the Response Optimization node, select the Compensators
pane to select and configure the compensator elements you want to tune
during the response optimization. See “Selecting Tunable Compensator
Elements” on page 4-56 for more information.

Note Compensator elements or parameters cannot have uncertainty when
used with frequency-domain based response optimization.
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5 Under Design requirements in the Response Optimization node,
select the design requirements you want the system to satisfy. See “Adding
Design Requirements” on page 4-57 for more information.

6 Click the Start Optimization button within the Response Optimization
node. The optimization progress results appear under Optimization. The
Compensators pane contains the new, optimized compensator element
values. See “Optimizing the System’s Response” on page 4-65 for more
information.

Example — Frequency-Domain Optimization for LTI
System

• “Introduction” on page 4-49

• “Design Requirements” on page 4-50

• “Creating an LTI Plant Model” on page 4-50

• “Creating Design and Analysis Plots” on page 4-51

• “Creating a Response Optimization Task” on page 4-54

• “Selecting Tunable Compensator Elements” on page 4-56

• “Adding Design Requirements” on page 4-57

• “Optimizing the System’s Response” on page 4-65

• “Creating and Displaying the Closed-Loop System” on page 4-68

Introduction
When you have Control System Toolbox software, you can place Simulink
Design Optimization design requirements or constraints on plots in the SISO
Design Tool graphical tuning editor and analysis plots that are part of a SISO
Design Task. This allows you to include design requirements for response
optimization in the frequency-domain in addition to the time-domain.
This topic guides you through an example using frequency-domain design
requirements to optimize the response of a system in the SISO Design Task.

You can specify frequency-domain design requirements to optimize response
signals for any model that you can design within a SISO Design Task:
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• Command-line LTI models created with the Control System Toolbox
commands

• Simulink models that have been linearized using Simulink Control Design
software

Design Requirements
In this example, you use a linearized version of the following Simulink model.

You use optimization methods to design a compensator so that the closed loop
system meets the following design specifications when you excite the system
with a unit step input:

• A maximum 30-second settling time

• A maximum 10% overshoot

• A maximum 10-second rise time

• A limit of ±0.7 on the actuator signal

Creating an LTI Plant Model
In the srotut1 model, the plant model is composed of a gain, a limited
integrator, a transfer function, and a transport delay.

You want to design the compensator for the open loop transfer function of the
linearized srotut1 model. The linearized srotut1 plant model is composed
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of the gain, an unlimited integrator, the transfer function, and a Padé
approximation to the transport delay.

To create an open loop transfer function based on the linearized srotut1
model, enter the following commands:

w0 = 1;
zeta = 1;
Kint = 0.5;
Tdelay = 1;
[delayNum,delayDen] = pade(Tdelay,1);
integrator = tf(Kint,[1 0]);
transfer_fcn = tf(w0^2,[1 2*w0*zeta w0^2]);
delay_block = tf(delayNum,delayDen);
open_loopTF = integrator*transfer_fcn*delay_block;

If the plant model is an array of LTI models, the controller is designed for a
nominal model only but you can analyze the control design for the remaining
models in the array. For more information, see “Control Design Analysis of
Multiple Models” in the Control System Toolbox documentation.

Tip You can directly linearize the Simulink model using Simulink Control
Design software.

Creating Design and Analysis Plots
This example uses a root locus diagram to design the response of the open loop
transfer function, open_loopTF. To create a SISO Design Task, containing a
root-locus plot for the open loop transfer function, use the following command:

sisotool('rlocus',open_loopTF)

A SISO Design Task is created within the Control and Estimation Tools
Manager, as shown in the following figure.
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The Control and Estimation Tools Manager is a graphical environment
for managing and performing tasks such as designing SISO systems. The
SISO Design Task node contains five panels that perform actions related to
designing SISO control systems. For more information, see “Using the SISO
Design Task in the Controls & Estimation Tools Manager” in “Control System
Toolbox” documentation.

The Architecture pane, within the SISO Design Task node, lets you choose
the architecture for the control system you are designing. This example uses
the default architecture. In this system, the plant model, G, is the open loop
transfer function open_loopTF, the prefilter, F, and the sensor, H, are set to
1, and the compensator, C, is the compensator that will be designed using
response optimization methods.

The SISO Design Task also contains a root locus diagram in the SISO Design
Tool graphical tuning editor.
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In addition to the root-locus diagram, it is helpful to visualize the response of
the system with a step response plot. To add a step response:

1 Select the Analysis Plots pane with the SISO Design Task node of the
Control and Estimation Tool Manager.

2 Select Step for the Plot Type of Plot 1.

3 Under Contents of Plots, select the check box in column 1 for the response
Closed Loop r to y.
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A step response plot appears in an LTI Viewer. The plot shows the response
of the closed loop system from r (input to the prefilter, F) to y (output of the
plant model, G):

Creating a Response Optimization Task
There are several possible methods for designing a SISO system; this example
uses an automated approach involving response optimization methods. After
creating the design and analysis plots as discussed in “Creating Design and
Analysis Plots” on page 4-51, you are ready to start a response optimization
task to design the compensator.

To create a response optimization task:

1 Select the Automated Tuning pane within the SISO Design Task node
in the Control and Estimation Tools Manager.
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2 In the Automated Tuning pane, select Optimization based tuning as
the Design Method.

3 Click the Optimize Compensators button to create the Response
Optimization node under the SISO Design Task node in the tree
browser in the left pane of the Control and Estimation Tools Manager.

The Response Optimization node contains four panes as shown in the
next figure.

With the exception of the first pane, each corresponds to a step in the response
optimization process:

• Overview: A schematic diagram of the response optimization process.
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• Compensators: Select and configure the compensator elements that you
want to tune. See “Selecting Tunable Compensator Elements” on page 4-56.

• Design requirements: Select the design requirements that you want
the system to meet after tuning the compensator elements. See “Adding
Design Requirements” on page 4-57.

• Optimization: Configure optimization options and view the progress of
the response optimization. See “Optimizing the System’s Response” on
page 4-65.

Note When optimizing responses in a SISO Design Task, you cannot add
uncertainty to parameters or compensator elements.

Selecting Tunable Compensator Elements
You can tune elements or parameters within compensators in your system so
that the response of the system meets the design requirements you specify.
To specify the compensator elements to tune:

1 Select the Compensators pane within the Response Optimization node.

2 Within the Compensators pane, select the check boxes in the Optimize
column that correspond to the compensator elements you want to tune.

In this example, to tune the Gain in the compensator C, select the check
box next to this element, as shown in the following figure.
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Note Compensator elements or parameters cannot have uncertainty when
used with frequency-domain based response optimization.

Adding Design Requirements
You can use both frequency-domain and time-domain design requirements
to tune parameters in a control system. The Design requirements pane
within the Response Optimization node of the Control and Estimation
Tools Manager provides an interface to create new design requirements and
select those you want to use for a response optimization.
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This example uses the design specifications described in “Design
Requirements” on page 4-50. The following sections each create a new design
requirement to meet these specifications:

• “Settling Time Design Requirement” on page 4-58

• “Overshoot Design Requirement” on page 4-59

• “Rise Time Design Requirement” on page 4-61

• “Actuator Limit Design Requirement” on page 4-62

After you add the design requirements, you can select a subset of requirements
for controller design, as described in “Selecting the Design Requirements to
Use During Response Optimization” on page 4-65.

Settling Time Design Requirement. The first design specification for this
example is to have a settling time of 30 seconds or less. This specification
can be represented on a root-locus diagram as a constraint on the real parts
of the poles of the open loop system.

To add this design requirement:

1 Select the Design requirements pane within the Response
Optimization node of the Control and Estimation Tools Manager.

2 Click the Add new design requirement button. This opens the New
Design Requirement dialog box.

Within this dialog box you can specify new design requirements and add
them to a new or existing design or analysis plot.

3 Add a design requirement to the existing root-locus diagram:

a Select Pole/zero settling time from the Design requirement type
menu.

b Select Open-Loop L from the Requirement for response menu.

c Enter 30 seconds for the Settling time.

d Click OK.
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A vertical line should appear on the root-locus diagram, as shown in the
following figure.

Overshoot Design Requirement. The second design specification for this
example is to have a percentage overshoot of 10% or less. This specification is
related to the damping ratio on a root-locus diagram. In addition to adding a
design requirement with the Add new design requirement button, you can
also right-click directly on the design or analysis plots to add the requirement,
as shown next.

To add this design requirement:
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1 Right-click anywhere within the white space of the root-locus diagram in
the SISO Design Tool window. Select Design Requirements > New to
open the New Design Requirement dialog box.

2 Select Percent overshoot as the Design requirement type and enter 10
as the Percent overshoot.

3 Click OK to add the design requirement to the root-locus diagram. The
design requirement appears as two lines radiating at an angle from the
origin, as shown in the following figure.
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Rise Time Design Requirement. The third design specification for this
example is to have a rise time of 10 seconds or less. This specification is
related to a lower limit on a Bode Magnitude diagram.

To add this design requirement:

1 Select the Graphical Tuning pane in the SISO Design Task node of the
Control and Estimation Tools Manager.

2 For Plot 2, set Plot Type to Open-Loop Bode.

3 Right-click anywhere within the white space of the open-loop bode diagram
in the SISO Design Tool window. Select Design Requirements > New to
open the New Design Requirement dialog box.

4 Create a design requirement to represent the rise time and add it to the
new Bode plot:

a Select Lower gain limit from the Design requirement type menu.

b Enter 1e-2 to 0.17 for the Frequency range.

c Enter 0 to 0 for the Magnitude range.

d Click OK.

A Bode diagram appears within the SISO Design Tool window. The
magnitude plot of the Bode diagram includes a horizontal line representing
the design requirement, as shown in the following figure.
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Actuator Limit Design Requirement. The fourth design specification for
this example is to limit the actuator signal to within ±0.7. To add this design
requirement:

1 Select the Design requirements pane in the Response Optimization
node of the Control and Estimation Tools Manager.

2 Click the Add new design requirement button to open the New Design
Requirement dialog box.

3 Create a time-domain design requirement to represent the upper limit
on the actuator signal, and add it to a new step response plot in the LTI
Viewer:
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a Select Step response upper amplitude limit from the Design
requirement type menu.

b Select Closed Loop r to u from the Requirement for response
menu.

c Enter 0 to 10 for the Time range.

d Enter 0.7 to 0.7 for the Amplitude range.

e Click OK. A second step response plot for the closed loop response from
r to u appears in the LTI Viewer. The plot contains a horizontal line
representing the upper limit on the actuator signal.

f To extend this limit for all times (to t=∞), right click on the black edge of
the design requirement, somewhere toward the right edge, and select
Extend to inf. The diagram should now appear as shown next.
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To add the corresponding design requirement for the lower limit on the
actuator signal:

1 Select the Design requirements pane in the Response Optimization
node of the Control and Estimation Tools Manager.

2 Click the Add new design requirement button to open the New Design
Requirement dialog box.

3 Create a time-domain design requirement to represent the lower limit on
the actuator signal, and add it to the step response plot in the LTI Viewer:

a Select Step response lower amplitude limit from the Design
requirement type menu.

b Select Closed Loop r to u from the Requirement for response
menu.

c Enter 0 to 10 for the Time range.

d Enter -0.7 to -0.7 for the Amplitude range.

e Click OK. The step response plot now contains a second horizontal line
representing the lower limit on the actuator signal.

f To extend this limit for all times (to t=∞), right-click in the yellow shaded
area and select Extend to inf. The diagram should now appear as
shown in the following figure.
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Selecting the Design Requirements to Use During Response
Optimization. The design requirements give constraints on the dynamics
of the system and the values of response signals. The table in the Design
requirements tab lists all design requirements in the design and analysis
plots. Select the check boxes next to the design requirements you want to
use in the response optimization. This example uses all the current design
requirements.

Optimizing the System’s Response
After selecting the compensator elements to tune and adding design
requirements for the response signals to satisfy, you are ready to being the
response optimization.

The Optimization pane within the Response Optimization node of the
Control and Estimation Tools Manager displays the progress of the response
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optimization. The pane also contains options to configure the types of progress
information displayed during the optimization and options to configure the
optimization methods and algorithms.

To optimize the response of the system in this example, click the Start
Optimization button.

The Optimization pane displays the progress of the optimization, iteration
by iteration, as shown next. Termination messages from the optimization
method and suggestions for improving convergence also appear here.

The optimized signals in the design and analysis plots appear as follows:
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Creating and Displaying the Closed-Loop System
After designing a compensator by optimizing the response of the system, you
can export the compensator to the MATLAB workspace, and create a model of
the full closed-loop system.

1 Within the SISO Design Tool window, select File > Export to open the
SISO Tool Export dialog box.

2 Select the compensator you designed, Compensator C, and then click
the Export to Workspace button.

At the command line, enter the following command to create the closed-loop
system, CL, from the open-loop transfer function, open_loopTF, and the
compensator, C:
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CL=feedback(C*open_loopTF,1)

This returns the following model:

Zero/pole/gain from input to output "Output":
-0.19414 (s-2)

----------------------------------------------
(s^2 + 0.409s + 0.1136) (s^2 + 3.591s + 3.418)

To create a step response plot of the closed loop system, enter the following
command:

step(CL);

This produces the following figure:
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Designing Linear Controllers for Simulink Models
When you have Control System Toolbox and Simulink Control Design
software, you can perform frequency-domain optimization of Simulink models.

You can use Simulink Control Design software to configure SISO Design Tool
with compensators, inputs, outputs, and loops computed from a Simulink
model. For more information, see “Creating a SISO Design Task” in Simulink
Control Design documentation.

After you configure the SISO Design Tool, use Simulink Design Optimization
software to optimize the controller parameters of the linearized Simulink
model. For an example of optimization-based control design for a model
linearized using Simulink Control Design software, see “Design an
Optimization-Based PID Controller for a Linearized Simulink Model” in the
Simulink Design Optimization getting Started Guide..

There is only one difference when tuning compensators derived from Simulink
Control Design software: The tuning of compensators from a Simulink
model is done through the masks of the Simulink blocks representing each
compensator. When selecting parameters to optimize, users can tune the
compensator in the pole, zero, or gain format, or in a format consistent with
the Simulink block mask as shown in the following figure. Changing the
compensator format is not possible when optimizing pure SISO Tool models
(those not derived using Simulink Control Design software).
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Mask of a Simulink® compensator block

Response optimization compensators pane
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What Are Lookup Tables?

In this section...

“Static Lookup Tables” on page 5-2

“Adaptive Lookup Tables” on page 5-3

Static Lookup Tables
Lookup tables are tables that store numeric data in a multidimensional
array format. In the simpler two-dimensional case, lookup tables can be
represented by matrices. Each element of a matrix is a numerical quantity,
which can be precisely located in terms of two indexing variables. At higher
dimensions, lookup tables can be represented by multidimensional matrices,
whose elements are described in terms of a corresponding number of indexing
variables.

Lookup tables provide a means to capture the dynamic behavior of a physical
(mechanical, electronic, software) system. The behavior of a system with
M inputs and N outputs can be approximately described by using N lookup
tables, each consisting of an array with M dimensions.

You usually generate lookup tables by experimentally collecting or artificially
creating the input and output data of a system. In general, you need as
many indexing parameters as the number of input variables. Each indexing
parameter may take a value within a predetermined set of data points, which
are called the breakpoints. The set of all breakpoints corresponding to an
indexing variable is called a grid. Thus, a system with M inputs is gridded by
M sets of breakpoints. The software uses the breakpoints to locate the array
elements, where the output data of the system are stored. For a system with
N outputs, the software locates the N array elements and then stores the
corresponding data at these locations.

After you create a lookup table using the input and output measurements as
described previously, you can use the corresponding multidimensional array
of values in applications without having to remeasure the system outputs. In
fact, you need only the input data to locate the appropriate array elements in
the lookup table because the software reads the approximate system output
from the data stored at these locations. Therefore, a lookup table provides a
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suitable means of capturing the input-output mapping of a static system in
the form of numeric data stored at predetermined array locations. For more
information, see “About Lookup Table Blocks” in the Simulink documentation.

You can use Simulink Design Optimization software to estimate lookup table
values, as described in “Estimating Values of Lookup Tables” on page 5-5.

Adaptive Lookup Tables
Statically defined lookup tables, as described in “Static Lookup Tables” on
page 5-2, cannot accommodate the time-varying behavior (characteristics) of a
physical plant. Static lookup tables establish a permanent and static mapping
of input-output behavior of a physical system. Conversely, the behavior of
actual physical systems often varies with time due to wear, environmental
conditions, and manufacturing tolerances. With such variations, the static
mapping of input-output behavior of a plant described by the lookup table
may no longer provide a valid representation of the plant characteristics.

Adaptive lookup tables incorporate the time-varying behavior of physical
plants into the lookup table generation and maintenance process while
providing all of the functionality of a regular lookup table.

The adaptive lookup table receives the input and output measurements of a
plant’s behavior, which are then used to dynamically create and update the
content of the underlying lookup table. In addition to requiring the input data
to create the lookup table, the adaptive lookup table also uses the output
data of the plant to recalculate the table values. For example, you can collect
the output data of the plant by placing sensors at appropriate locations in a
physical system.

The software uses the input measurements to locate the array elements by
comparing these input values with the breakpoints defined for each indexing
variable. Next, it uses the output measurements to recalculate the numeric
value stored at these array locations. However, unlike a regular table, which
only stores the array data before the actual use of the lookup table, the
adaptive table continuously improves the content of the lookup table. This
continuous improvement of the table data is referred to as the adaptation
process or learning process.
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The adaptation process involves statistical and signal processing algorithms
to recapture the input-output behavior of the plant. The adaptive lookup
table always tries to provide a valid representation of the plant dynamics
even though the plant behavior may be time varying. The underlying signal
processing algorithms are also robust against reasonable measurement noise
and they provide appropriate filtering of noisy output measurements. To
learn more about how to model systems using adaptive lookup tables, see
“Capturing Time-Varying System Behavior Using Adaptive Lookup Tables”
on page 5-37.
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Estimating Values of Lookup Tables

In this section...

“How to Estimate Values of a Lookup Table” on page 5-5

“Example — Estimating Lookup Table Values from Data” on page 5-6

“Example — Estimating Constrained Values of a Lookup Table” on page
5-20

How to Estimate Values of a Lookup Table
You can use lookup table Simulink blocks to approximate a system’s behavior,
as described in “Working with Lookup Tables” in the Simulink documentation.
After you build your system using lookup tables, you can use Simulink Design
Optimization software to estimate the table values from measured I/O data.

Estimating lookup table values is an example of estimating parameters
which are matrices or multi-dimensional arrays. The workflow for estimating
parameters of a lookup table consist of the following tasks:

1 Creating a Simulink model using lookup table blocks.

2 Importing the measured input and output (I/O) data from which you want
to estimate the table values.

3 Analyzing and preparing the I/O data for estimation.

4 Estimating the lookup table values.

5 Validating the estimated table values using a validation data set.

The following examples illustrate how to estimate the lookup table values:

• “Example — Estimating Lookup Table Values from Data” on page 5-6

• “Example — Estimating Constrained Values of a Lookup Table” on page
5-20
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Example — Estimating Lookup Table Values from
Data

• “Objectives” on page 5-6

• “About the Data” on page 5-6

• “Configuring a Project for Parameter Estimation” on page 5-6

• “Estimating the Table Values Using Default Settings” on page 5-8

• “Validating the Estimation Results” on page 5-15

Objectives
This example shows how to estimate lookup table values from time-domain
input-output (I/O) data.

About the Data
In this example, you use the I/O data in lookup_regular.mat to estimate the
values of a lookup table. The MAT-file includes the following variables:

• xdata1— Consists of 63 uniformly-sampled input data points in the range
[0,6.5].

• ydata1— Consists of output data corresponding to the input data samples.

• time1 — Time vector.

You use the I/O data to estimate the lookup table values in the
lookup_regular Simulink model. The lookup table in the model contains ten
values, which are stored in the MATLAB variable table. The initial table
values comprise a vector of 0s. To learn more about how to model a system
using lookup tables, see “Working with Lookup Tables” in the Simulink
documentation.

Configuring a Project for Parameter Estimation
To estimate the lookup table values, you must first configure a Control and
Estimation Tools Manager project.
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1 Open the lookup table model by typing the following command at the
MATLAB prompt:

lookup_regular

This command opens the Simulink model, and loads the estimation data
into the MATLAB workspace.
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2 In the Simulink model, select Tools > Parameter Estimation to open a
new project named lookup_regular in the Control and Estimation Tools
Manager GUI.

Estimating the Table Values Using Default Settings
After you configure a project for parameter estimation, as described in
“Configuring a Project for Parameter Estimation” on page 5-6, use the
following steps to estimate the lookup table values.

1 Import the I/O data, xdata1 and ydata1, and the time vector, time1, into
the Control and Estimation Tools Manager GUI. For more information, see
“Import Data (GUI)” on page 1-4.

You can also load a preconfigured project that already contains the imported
data. To do so, type the following command at the MATLAB prompt:

lookup_regular;
explorer.loadProject('lookup_regular_import',...
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'Project - lookup_regular', 'Estimation Data');
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2 Run an initial simulation to view the I/O data, simulated output, and the
initial table values. To do so, type the following commands at the MATLAB
prompt:

sim('lookup_regular')
figure(1); plot(xdata1,ydata1, 'm*', xout, yout,'b^')
hold on; plot(linspace(0,6.5,10), table, 'k', 'LineWidth', 2)

The x- and y-axes of the figure represent the input and output data,
respectively. The figure shows the following plots:

• Measured data — Represented by the magenta stars (*).

• Initial table values — Represented by the black line.

• Initial simulation data — Represented by the blue deltas (Δ).

3 Select the table values to estimate.
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a In the Control and Estimation Tools Manager GUI, select the Variables
node under the Estimation Task node.

b Click Add to open the Select Parameters dialog box, which shows the
Simulink model parameters.

c Select table, and click OK to add the table values to the Estimated
Parameters tab.

The Default settings area of the GUI displays the default settings
for the table values. The Value field displays the initial table values,
which comprise a vector of ten 0s.

d Select the Estimation node, and click New to add a New Estimation
node.
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e Select the New Estimation node. In the Parameters tab, select
the Estimate check box to specify the lookup table values, table, for
estimation.
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4 In the Data Sets tab of the New Estimation node, select the Selected
check box to specify the estimation data set.

5 Estimate the table values using the default settings.
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a In the Estimation tab of the New Estimation node, click Start to
start the estimation.

The Control and Tools Manager GUI updates at each iteration, and
provides information about the estimation progress. After the estimation
completes, the Control and Estimation Tools Manager GUI looks similar
to the following figure.
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b Select the Parameters tab in the New Estimation node to view the
estimated table values, which appear in the Value field.

Validating the Estimation Results
After you estimate the table values, as described in “Estimating the Table
Values Using Default Settings” on page 5-8, you must use another data set to
validate that you have not overfitted the model. You plot and examine the
following plots to validate the estimation results:

• Residuals plot

• Measured and simulated data plots

To validate the estimation results:
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1 Import the validation I/O data, xdata2 and ydata2, and time vector, time2,
in the Control and Estimation Tools Manager GUI.

You can also load a project that already contains the estimated parameters,
and the validation data set. To do so, type the following commands at the
MATLAB prompt:

lookup_regular;
explorer.loadProject('lookup_regular_val',...
'Project - lookup_regular', 'Validation Data');

This project also contains the Residuals plot already configured in the
Select plot types area of the GUI, as shown in the next figure. For more
information on how to configure this plot, see “Compare Measured and
Simulated Responses (GUI)” on page 2-46.
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2 Plot and examine the residuals:

a Select the New Validation node under the Validation node.
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b In the Options area, select Validation Data from the Validation data
set drop-down list.
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c Click Show Plots to open the residuals plot.

The residuals, which show the difference between the simulated
and measured data, lie in the range [-0.15,0.15]— within 15% of the
maximum output variation. This indicates a good match between the
measured and the simulated table data values.

5-19



5 Lookup Tables

d Plot and examine the estimated table values against the validation data
set and the simulated table values by typing the following commands
at the MATLAB prompt.

sim('lookup_regular')
figure(2); plot(xdata2,ydata2, 'm*', xout, yout,'b^')
hold on; plot(linspace(0,6.5,10), table, 'k', 'LineWidth', 2)

The plot shows that the table values, displayed as the black line, match
both the validation data and the simulated table values. The table data
values cover the entire range of input values, which indicates that all
the lookup table values have been estimated.

Example — Estimating Constrained Values of a
Lookup Table

• “Objectives” on page 5-21
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• “About the Data” on page 5-21

• “Configuring a Project for Parameter Estimation” on page 5-21

• “Estimating the Monotonically Increasing Table Values Using Default
Settings” on page 5-24

• “Validating the Estimation Results” on page 5-31

Objectives
This example shows how to estimate constrained values of a lookup table. You
apply monotonically increasing constraints to the lookup table values, and
use the GUI to estimate the table values.

About the Data
In this example, you use lookup_increasing.mat, which contains the
measured I/O data for estimating the lookup table values. The MAT-file
includes the following variables:

• xdata1 — Consists of 602 uniformly-sampled input data points in the
range [-5,5].

• ydata1— Output data corresponding to the input data samples.

Note The output data is a monotonically increasing function of the input
data.

• time1 — Time vector.

You use the I/O data to estimate the values of the lookup table in the
lookup_increasing Simulink model. The table contains eleven values, which
are stored in the MATLAB variable table. To learn more about how to
specify the table’s values, see “Entering Breakpoints and Table Data” in the
Simulink documentation.

Configuring a Project for Parameter Estimation
To estimate the monotonically increasing lookup table values, you must first
configure a Control and Estimation Tools Manager project.
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1 Open the lookup table model by typing the following command at the
MATLAB prompt:

lookup_increasing

This command opens the Simulink model, and loads the estimation data
in the MATLAB workspace.
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2 Double-click the Lookup Table block to view the monotonically increasing
constraint applied to the table output values.

The Table data field of the Function Block Parameters dialog box
shows the constraint. The cumulative sum function, cumsum, applies a
monotonically increasing constraint on the table output values. This
function computes the cumulative sum of the table values based on
estimation of the individual table elements from the I/O data.
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3 In the Simulink model, select Tools > Parameter Estimation to open a
new project named lookup_increasing in the Control and Estimation
Tools Manager GUI.

Estimating the Monotonically Increasing Table Values Using
Default Settings
After you configure a project for parameter estimation, as described in
“Configuring a Project for Parameter Estimation” on page 5-21, use the
following steps to estimate the constrained lookup table values:

1 Import the estimation I/O data, as described in the “Importing Data into the
GUI” section of “Prepare Data for Parameter Estimation Using the GUI”.
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You can also load a preconfigured project that already contains the imported
data. To do so, type the following commands at the MATLAB prompt:

lookup_increasing;
explorer.loadProject('lookup_increasing_import',...
'Project - lookup_increasing','Estimation Data')
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2 Run an initial simulation to view the measured data, simulated table
values and the initial table values by typing the following commands at
the MATLAB prompt:

sim('lookup_increasing')
figure(1); plot(xdata1,ydata1, 'm*', xout, yout,'b^')
hold on; plot(-5:5, cumsum(table), 'k', 'LineWidth', 2)

The x- and y-axes represents the input and output data, respectively. The
figure shows the following plots:

• Measured data — Represented by the magenta stars (*).

Note As described in “About the Data” on page 5-21, the output data is
a monotonically increasing function of the input data.

• Initial table values — Represented by the black line.

• Initial simulation data — Represented by the blue deltas (Δ).
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3 Select the table output values to estimate.

a In the Control and Estimation Tools Manager GUI, select the Variables
node under the Estimation Task node.

b Click Add to open the Select Parameters dialog box, where you see the
Simulink model parameters.

c Select table, and click OK to add the table values to the Estimated
Parameters tab.

The Default settings area of the GUI displays the default settings for
the table values. The Value field displays the initial table values.

d Select the Estimation node, and click New to add a New Estimation
node.
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e Select the New Estimation node. In the Parameters tab, select
the Estimate check box to specify the lookup table values, table, for
estimation.
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4 In the Data Sets tab of the New Estimation node, select the Selected
check-box to specify the estimation data set.

5 Estimate the parameters using the default settings.
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a In the Estimation tab of the New Estimation node, click Start to
start the estimation.

The Control and Tools Manager GUI updates at each iteration, and
provides information about the estimation progress. After the estimation
completes, the Control and Estimation Tools Manager GUI looks similar
to the following figure.
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b Select the Parameters tab of the New Estimation node to view the
estimated table values. The Value field displays the estimated table
values.

Validating the Estimation Results
After you estimate the table values, as described in “Estimating the
Monotonically Increasing Table Values Using Default Settings” on page 5-24,
you must use another data set to validate that you have not overfitted the
model. You plot and examine the following plots to validate the estimation
results:

• Residuals plot

• Measured and simulated data plots

To validate the estimation results:
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1 Import the validation I/O data, xdata2 and ydata2, and time vector, time2,
in the Control and Estimation Tools Manager GUI.

You can load a project that already contains the estimated parameters,
validation data set, and residuals plot. To do so, type the following
commands at the MATLAB prompt:

lookup_increasing;
explorer.loadProject('lookup_increasing_val',...
'Project - lookup_increasing', 'Validation Data')

This project also contains the Residuals plot already configured in the
Select plot types area of the GUI, as shown in the next figure. For more
information on how to configure this plot, see “Compare Measured and
Simulated Responses (GUI)” on page 2-46.
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2 Plot and examine the residuals.

a Select the New Validation node under the Validation node.
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b In the Options area, select Validation Data from the Validation data
set drop-down list.
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c Click Show Plots to open the residuals plot.

The residuals, which show the difference between the simulated and
measured data, lie the range [-15,15]— within 20% of the maximum
output variation. This indicates a good match between the measured
and the simulated table data values.
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3 Plot and examine the validation data, simulated data and estimated table
values.

sim('lookup_increasing')
figure(2); plot(xdata2,ydata2, 'm*', xout, yout,'b^')
hold on; plot(-5:5, cumsum(table), 'k', 'LineWidth', 2)

The plot shows that the table values, shown as the black line, match both
the measured data and the simulated table values. The table data values
cover the entire range of input values, which indicates that all the lookup
table values have been estimated.
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Capturing Time-Varying System Behavior Using Adaptive
Lookup Tables

In this section...

“Building Models Using Adaptive Lookup Table Blocks” on page 5-37

“Configuring Adaptive Lookup Table Blocks” on page 5-41

“Example — Modeling an Engine Using n-D Adaptive Lookup Table” on
page 5-44

“Using Adaptive Lookup Tables in Real-Time Environment” on page 5-59

Building Models Using Adaptive Lookup Table Blocks
Simulink Design Optimization software provides blocks for modeling systems
as adaptive lookup tables. You can use the adaptive lookup table blocks to
create lookup tables from measured or simulated data. You build a model
using the adaptive lookup table blocks, and then simulate the model to adapt
the lookup table values to the time-varying I/O data. During simulation,
the software uses the input data to locate the table values, and then uses
the output data to recalculate the table values. The updated table values
are stored in the adaptive lookup table block. For more information, see
“Adaptive Lookup Tables” on page 5-3.

The Adaptive Lookup Table library has the following three blocks:

• Adaptive Lookup Table (1D Stair-Fit) — One-dimensional adaptive lookup
table

• Adaptive Lookup Table (2D Stair-Fit) — Two-dimensional adaptive lookup
table

• Adaptive Lookup Table (2D Stair-Fit) — Multidimensional adaptive lookup
table

Note Use the Adaptive Lookup Table (2D Stair-Fit) block to create lookup
tables of three or more dimensions.
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To access the Adaptive Lookup Tables library:

1 Type the following command at the MATLAB prompt:

sdolib

The Simulink Design Optimization library opens as shown in the next
figure.

2 Double-click the Adaptive Lookup Tables block to open the Adaptive
Lookup Tables library, as shown in the next figure.
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By default, the Adaptive Lookup Table blocks have two inputs and outputs
as shown in the next figure.

You can display additional inputs and outputs in a block by selecting the
corresponding options in the Function Block Parameters dialog box. To learn
more about the options, see Block Reference.
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Adaptive Lookup Table Block Showing Inputs and Outputs

The 2-D Adaptive Lookup Table block has the following inputs and outputs:

• u and y— Input and output data of the system being modeled, respectively

For example, to model an engine’s efficiency as a function of engine rpm
and manifold pressure, specify u as the rpm, y as the pressure, and y as
the efficiency signals.

• Tin — The initial table data

• Enable— Signal to enable, disable, or reset the adaptation process

• Lock— Signal to update only specified cells in the table

• y — Value of the cell currently being adapted

• N — Number of the cell currently being adapted

• Tout — Values of the adapted table data

For more information on how to use adaptive lookup tables, see “Example —
Modeling an Engine Using n-D Adaptive Lookup Table” on page 5-44.

A typical Simulink diagram using an adaptive lookup table block is shown in
the next figure.
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Simulink® Diagram Using an Adaptive Lookup Table

In this figure, the Experiment Data block imports a set of experimental data
into Simulink through MATLAB workspace variables. The initial table is
specified in the block mask parameters. When the simulation runs, the initial
table begins to adapt to new data inputs and the resulting table is copied
to the block’s output.

Configuring Adaptive Lookup Table Blocks

• “Setting Adaptive Lookup Table Parameters” on page 5-41

• “Selecting an Adaptation Method” on page 5-42

Setting Adaptive Lookup Table Parameters
You can configure the Adaptive Lookup Table parameters in the Function
Block Parameters dialog box. Double-click the block to open the dialog box
shown in the next figure.
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n-D Adaptive Lookup Table Dialog Box

For details on how to set these parameters, see the individual reference pages.

Selecting an Adaptation Method
You can select an adaptation algorithm from the Adaptation Method
drop-down list in the Function Block Parameters dialog box. This section
discusses the details of these algorithms.

Sample Mean. Sample mean provides the average value of n output data
samples and is defined as:
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where y(n) is the nth data sample.

Defining a priori estimation error as e n y n y n( ) ( ) ( )= − − 1 , the recursive
relation can be written as:

y n y n
n

e n ( ) ( ) ( )= − +1
1

where n ≥ 1 and the initial estimate y( )0 is arbitrary.

In this expression, only the number of samples, n, for each cell— rather than
n data samples—is stored in memory.

Sample Mean with Forgetting. The adaptation method “Sample Mean”
on page 5-42 has an infinite memory. The past data samples have the same
weight as the final sample in calculating the sample mean. Sample mean
(with forgetting) uses an algorithm with a forgetting factor or Adaptation
gain that puts more weight on the more recent samples. This algorithm
provides robustness against initial response transients of the plant and an
adjustable speed of adaptation. Sample mean (with forgetting) is defined
as:
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A small value of λ results in faster adaptation. A value of 0 indicates short
memory (last data becomes the table value), and a value of 1 indicates long
memory (average all data received in a cell).

Example — Modeling an Engine Using n-D Adaptive
Lookup Table

• “Objectives” on page 5-44

• “About the Data” on page 5-45

• “Building a Model Using Adaptive Lookup Table Blocks” on page 5-45

• “Adapting the Lookup Table Values Using Time-Varying I/O Data” on page
5-56

Objectives
In this example, you learn how to capture the time-varying behavior of an
engine using an n-D adaptive lookup table. You accomplish the following
tasks using the Simulink software:
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• Configure an adaptive lookup table block to model your system.

• Simulate the model to update the lookup table values dynamically.

• Export the adapted lookup table values to the MATLAB workspace.

• Lock a specific cell in the table during adaptation.

• Disable the adaptation process and use the adaptive lookup table as a
static lookup table.

About the Data
In this example, you use the data in vedata.mat which contains the following
variables measured from an engine:

• X— 10 input breakpoints for intake manifold pressure in the range [10,100]

• Y— 36 input breakpoints for engine speed in the range [0,7000]

• Z— 10x36 matrix of table data for engine volumetric efficiency

To learn more about breakpoints and table data, see “Anatomy of a Lookup
Table” in the Simulink documentation.

The output volumetric efficiency of the engine is time varying, and a function
of two inputs—intake manifold pressure and engine speed. The data in the
MAT-file is used to generate the time-varying input and output (I/O) data for
the engine.

Building a Model Using Adaptive Lookup Table Blocks
In this portion of the tutorial, you learn how to build a model of an engine
using an Adaptive Lookup Table block.

1 Open a preconfigured Simulink model by typing the model name at the
MATLAB prompt:

enginetable1_data

The Experimental Data subsystem in the Simulink model generates
time-varying I/O data during simulation.
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This command also loads the variables X, Y and Z into the MATLAB
workspace. To learn more about this data, see “About the Data” on page
5-45.

2 Add an Adaptive Lookup Table block to the Simulink model.

a Open the Simulink Design Optimization library by typing the following
command at the MATLAB prompt:

sdolib
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b Double-click the Adaptive Lookup Tables block to open the Adaptive
Lookup Tables library.

Simulink Design Optimization software provides three Adaptive Lookup
Table blocks. In this example, you use the Adaptive Lookup Table (nD
Stair-Fit) block to model your system. To learn more about the blocks,
see Block Reference.
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c Drag and drop the Adaptive Lookup Table (nD Stair-Fit) block from the
Simulink Design Optimization library to the Simulink model window.

3 Double-click the Adaptive Lookup Table (nD Stair-Fit) block to open the
Function Block Parameters: Adaptive Lookup Table (nD Stair-Fit) dialog
box.
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4 In the Function Block Parameters dialog box:

a Specify the following block parameters:

• Table breakpoints (cell array)— Enter {[X; 110], [Y; 7200]}
to specify the range of input breakpoints.

• Table data (initial) — Enter rand(10,36) to specify random
numbers as the initial table values for the volumetric efficiency.

5-49



5 Lookup Tables

• Table numbering data— Enter reshape(1:360,10,36) to specify
a numbering scheme for the table cells.

b Verify that Sample mean (with forgetting) is selected in the
Adaptation method drop-down list.

c Enter 0.98 in the Adaptation gain (0 to 1) field to specify the forgetting
factor for the Sample mean (with forgetting) adaptation algorithm.

An adaptation gain close to 1 indicates high robustness of the lookup
table values to input noise. To learn more about the adaptation gain, see
“Sample Mean with Forgetting” on page 5-43 in “Selecting an Adaptation
Method” on page 5-42.

d Select the Make adapted table an output check box.

This action adds a new port named Tout to the Adaptive Lookup Table
block. You use this port to plot the table values as they are being
adapted.

e Select the Add adaptation enable/disable/reset port check box.

This action adds a new port named Enable to the Adaptive Lookup Table
block. You use this port to enable or disable the adaptation process.

f Select the Add cell lock enable/disable port check box.

This action adds a new port named Lock to the Adaptive Lookup Table
block. You use this port to lock a cell during the adaptation process.

g Verify that Ignore is selected in the Action for out-of-range drop-down
list.

This selection specifies that the software ignores any time-varying
inputs outside the range of input breakpoints during adaptation.

Tip To learn more, see Adaptive Lookup Table (nD Stair-Fit) block
reference page.

After you configure the parameters, the block parameters dialog box
looks like the following figure.
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h Click OK to close the Function Block Parameters dialog box.

The Simulink model now looks similar to the following figure.
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5 Assign the input and output data to the engine model by connecting the
U and Y ports of the Experimental Data block to the u and y ports of the
Adaptive Lookup Table block, respectively.

Tip To learn how to connect blocks in the Simulink model window, see
“Connecting Blocks” in the Simulink documentation.

6 Design a logic using Simulink blocks to enable or disable the adaptation
process. Connect the logic to the Adaptive Lookup Table block, as shown in
the following figure.
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This logic outputs an initial value of 1 which enables the adaptation process.

7 Design a logic to lock a cell during adaptation. Connect the logic to the
Adaptive Lookup Table block, as shown in the following figure.

8 In the Simulink Library Browser, select the Simulink > Sinks library,
and drag Display blocks to the model window. Connect the blocks, as
shown in the following figure.
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During simulation, the Display blocks show the following:

• Display block — Shows the value of the current cell being adapted.

• Display1 block — Shows the number of the current cell being adapted.

9 Write a MATLAB function to plot the lookup table values as they adapt
during simulation.

Alternatively, type enginetable at the MATLAB prompt to open a
preconfigured Simulink model. The Efficiency Surface subsystem
contains a function to plot the lookup table values, as shown in the next
figure.

10 Connect a To Workspace block to export the adapted table values:

a In the Simulink Library Browser, select the Simulink > Sinks library,
and drag the To Workspace block to the model window.
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To learn more about this block, see the To Workspace block reference
page in the Simulink documentation.

b Double-click the To Workspace block to open the Sink Block Parameters
dialog box, and type Tout in the Variable name field.

c Click OK.

d Connect the To Workspace block to the adaptive lookup table output
signal Tout, as shown in the next figure.
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You have now built the model for updating and viewing the adaptive lookup
table values. You must now simulate the model to start the adaptation, as
described in “Adapting the Lookup Table Values Using Time-Varying I/O
Data” on page 5-56.

Adapting the Lookup Table Values Using Time-Varying I/O
Data
In this portion of the tutorial, you learn how to update the lookup table values
to adapt to the time-varying input and output values.

You must have already built the Simulink model, as described “Building a
Model Using Adaptive Lookup Table Blocks” on page 5-45.

To perform the adaptation:

1 In the Simulink model window, enter inf as the simulation time.

The simulation time of infinity specifies that the adaptation process
continues as long as the input and output values of the engine change.

2 In the Simulink model window, select Simulation > Start to start the
adaptation process.
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A figure window opens that shows the volumetric efficiency of the engine as
a function of the intake manifold pressure and engine speed:

• The left plot shows the measured volumetric efficiency as a function of
intake manifold pressure and engine speed.

• The right plot shows the volumetric efficiency as it adapts with the
time-varying intake manifold pressure and engine speed.

During simulation, the lookup table values displayed on the right plot
adapt to the variations in the I/O data. The left and the right plots resemble
each other after a few seconds, as shown in the next figure.
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Tip During simulation, the Cell Number and Adaptive Table Outputs
blocks in the Simulink model display the cell number, and the adapted
lookup table value in the cell, respectively.

3 Pause the simulation by selecting Simulation > Pause.

This action also exports the adapted table values Tout to the MATLAB
workspace.

Note After you pause the simulation, the adapted table values are stored
in the Adaptive Lookup Table block.

4 Examine that the left and the right plots match. This resemblance
indicates that the table values have adapted to the time-varying I/O data.

5 Lock a table cell so that only one cell adapts. You may find this feature
useful if a portion of the data is highly erratic or otherwise difficult for the
algorithm to handle.

a Select Simulation > Start to restart the simulation.
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b Double-click the Lock block. This action toggles the switch to .

You can view the number of the locked cell in the Cell Number block in
the Simulink model.

6 After the table values adapt to the time-varying I/O data, you can continue
to use the Adaptive Lookup Table block as a static lookup table:

a In the Simulink model window, double-click the Enable block. This
action toggles the switch, and disables the adaptation.

b Select Simulation > Start to restart the simulation, if it is not already
running.

During simulation, the Adaptive Lookup Table block works like a
static lookup table, and continues to estimate the output values as the
input values change. You can see the current lookup table value in the
Adaptive Table Outputs block in the Simulink model window.

Note After you disable the adaptation, the Adaptive Lookup Table block
does not update the stored table values, and the figure that displays the
table values does not update.

Using Adaptive Lookup Tables in Real-Time
Environment
You can use experimental data from sensor measurements collected by
running various tests on a system in real time. The measured data is then
sent to the adaptive table block to generate a lookup table describing the
relation between the system inputs and output.

You can also use the Adaptive Lookup Table block in a real-time environment,
where some time-varying properties of a system need to be captured. To do so,
generate C code using Simulink Coder™ code generation software that can
then be run in an xPC Target™ or dSPACE® software. Because you can start,
stop, or reset the adaptation if you want, use logic to enable the adaptation
of the table data only when it is desired. The cell number output N, and the
Enable and Lock inputs facilitate this process. Use the Enable input to
start and stop the adaptation and the Lock input to update only one of the
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table cells. The Lock input combined with some logic using the cell number
output N provide the means for updating only the desired table cells during a
simulation run.
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Use this list to find examples in the documentation.



A Examples

Parameter Estimation
“Estimate Initial States of a Mass-Spring-Damper System (GUI)” on page
2-71
“F14 Parameters and Initial State Estimation (Code)” on page 2-89
“RC Circuit Parameters and Initial State Estimation (Code)” on page 2-100
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Parameter Optimization

Parameter Optimization
“Optimize Parameters for Robustness (GUI)” on page 3-162
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Optimization-Based Linear Control Design
“Example — Frequency-Domain Optimization for LTI System” on page 4-49
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Lookup Tables

Lookup Tables
“Example — Estimating Lookup Table Values from Data” on page 5-6
“Example — Estimating Constrained Values of a Lookup Table” on page
5-20
“Example — Modeling an Engine Using n-D Adaptive Lookup Table” on
page 5-44
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